
Anleitung GSVmulti

Hinweise zu dieser Anleitung
- Farbig hinterlegte Texte bezeichnen Schaltflächen des Programms
- Andernfalls bedeutet kursiver Text allgemein Bezeichnungen im Programm
- Weiterführende Informationen sind z.T. kleingedruckt
- Der erste Teil „Kurzanleitung“ ist eine Einführung. Im zweiten Teil "Planen und Verwalten von 
Messaufgaben" werden Empfehlungen und wichtige Hinweise gegeben, im dritten Teil 
„Weiterführende Funktionen“ werden umfangreiche Möglichkeiten dargestellt; deren Kenntnis ist zur 
grundlegenden Verwendung des Programms aber nicht unbedingt erforderlich.
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Kurzanleitung GSVmulti
GSVmulti (Langform: GSVmultichannel) ist ein Anwendungsprogramm zur Anzeige und 
Aufzeichnung von Messdaten und zur Konfiguration von digitalen Messverstärkern. 
Unterstützt werden die Modelle GSV-8, GSV-6, GSV-4, GSV-3, GSV-2 und GSV-1A8USB. Es 
können einer oder mehrere GSV-Messverstärker zugleich verwendet werden, so dass bis zu 
127 Messkanäle angezeigt und verarbeitet werden können.

Verbinden des Messverstärkers

Nach dem Start der Software GSVmulti stehen die Funktionen

Add Channel, Open Session und File Monitor zur Verfügung.

Durch Add Channel öffnet sich der Dialog zum Eintragen der Verbindungsdaten, um einen 
GSV-Messverstärker oder zusätzliche Kanäle eines Gerätes zu öffnen.

Bitte wählen Sie das Gerätemodell mit Devicetype, die COMport-Number1 und den oder die 
gewünschten Eingangskanäle.

Wiederholen Sie Add Channel, bis Sie alle gewünschten Kanäle und Geräte geöffnet haben.

Tipps: Bei Geräten mit mehreren Eingangskanälen können Sie mit Open all input channels alle 
verfügbaren Eingänge dieses Messverstärkers öffnen. Die Default-Einstellung der Kommunikations-
Bitrate (Bits/s) wird anhand des Gerätemodells automatisch vor-ausgewählt. Falls diese davon 
abweichend ist, muss sie richtig eingestellt werden.

1 Beim GSV1A8 und beim GSV-6CAN ist es eine Gerätenummer; hier ist das Communication Interface 
dementsprechend gesetzt, bzw. einzustellen.
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Karteikarte Configuration

In dieser Karteikarte navigieren Sie mit der Auswahl Actual Channel oben rechts zu den 
gewünschten Kanälen. Die Namen der Kanäle, z.B. "Chan. 3_1" können Sie im Textfeld 
Channel name mit einem eigenen Namen überschreiben und die Eingabe mit Enter 
abschließen. Alternativ können Sie das über die Menüleiste mit Channel->Name tun.

Mit den vier Buttons im Zentrum definieren Sie die wesentlichen Eigenschaften des Sensors 
am aktuell gewählten Kanal:

Set Zero: Führt einen Nullabgleich des Sensors durch. Der Button in gelb-oranger Farbe 
weist darauf hin, dass diese Einstellung im Speicher des Messverstärkers/Sensors 
gespeichert wird.
Hinweis für Temperatur- und Spannungseingänge: Per Defaulteinstellung verbietet die Software das 
Nullen von Temperatur- und Spannungseingängen. In Menüleiste→Options kann das geändert 
werden, s.S.90.

User Scaling: Hier öffnet sich ein Fenster zur Eingabe der Skalierung oder von Kalibrierdaten 
für den Sensor. Diese Einstellung muss in der Regel bei der Inbetriebnahme einmalig 
vorgenommen werden, siehe S. 8. Vor einer Änderung der Skalierung sollte der Eingangstyp 
Input Type gesetzt werden, sofern er noch nicht richtig eingestellt ist.

Data Frequency: Hier wird die Anzahl der Messwerte eingetragen, die pro Sekunde über die 
Schnittstelle gesendet werden. Wählen Sie hier bitte die für die Messaufgabe benötigte 
Frequenz. Sie ist bei Mehrkanalgeräten automatisch für alle Eingangskanäle gleich.
Bei Mehrkanalgeräten bedeutet es die Anzahl ganzer Datenframes mit Eingangskanälen, d.h. 
Gesamtzahl aller Messwerte aller Kanäle = Data Frequency x Eingangskanäle. Je niedriger die 
Frequenz, desto geringer das Rauschen, d.h. desto besser die effektive Messauflösung, s.S. 17.

Input Type: Hier wird der Eingangstyp und der elektrische Messbereich ausgewählt, siehe S.
7. Dieser Schritt wird meist zuerst ausgeführt, um einen neuen Sensor zu konfigurieren.
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Durch Load Settings können Werkseinstellungen (Default) des Messverstärkers 
wiederhergestellt werden oder solche, die vom Benutzer vorher mit Save Settings im 
Speicher des Gerätes abgelegt worden sind (User 1-6, sofern für Gerätemodell verfügbar).

Eingangstyp

Mit den Button Input Type öffnet sich der Dialog zur Einstellung des elektrischen 
Eingangsbereichs für den ausgewählten Kanal; ggf. können auch verschiedene 
physikalische Eingangsarten gewählt werden. Die Einstellmöglichkeiten hängen vom Modell 
des angeschlossenen Messverstärkers ab; im folgenden sind sie beispielhaft für den GSV-8 
gezeigt.

Für Sensoren mit Dehnungsmessstreifen stehen drei Messbereiche 2,0 mV/V, 3,5 mV/V und 
7,0 mV/V zur Verfügung. Mit den drei Messbereichen sind beim GSV-8 drei fest zugeordnete
Brückenspeisespannungen verbunden.

• 2 mV/V: 8,75 V (Achtung: Diese Speisespannung ist bei einigen Sensoren nicht 
empfehlenswert; das Sensordatenblatt gibt darüber Auskunft).

• 3,5 mV/V: 5,0 V

• 7 mV/V: 2,5 V

Der gewählte Messbereich sollte größer oder gleich dem elektrischen Ausgangsbereich des 
Sensors sein, d.h. größer als dessen Kennwert bei seinem Nennwert.

Tipp: Bei einigen Messverstärkern, z.B. GSV-4 und GSV-8, können auch Temperatursensoren oder 
Single-ended Spannungseingänge ausgewählt werden. Andere Sensortypen müssen fast immer an 
anderen Anschlüssen des Gerätes angeschlossen werden, ggf. sind andere Kabel zu verwenden. Die 
Bedienungsanleitungen der Geräte geben hierüber Auskunft.
Auch die Festlegung zum Brückentyp (Voll- Halb- oder Viertelbrücke) bei Dehnungsmessstreifen 
erfolgt über die Hardware des GSVs, etwa über andere Anschlüsse oder Schalter/Jumper. Siehe 
dessen Bedienungsanleitung und S.45

Hinweis: Bei einer Änderung des Eingangstyps wird i.d.R. die Skalierung (User Scaling) automatisch 
neu gesetzt, so dass eine vorherige Sensorkonfiguration u.U. überschrieben wird! Das geschieht, 
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damit der GSV die neue elektrische Eingangsgröße (bzw. Temperatur) gleich richtig anzeigt. Die 
Skalierung muss dann ggf. für einen bestimmten Sensor neu angepasst werden.

Skalierung

Der Button User Scaling öffnet den Dialog zur Eingabe bzw. zur Berechnung des 
Skalierungsfaktors, mit dem Sensoren justiert werden.

Der Skalierungsfaktor berechnet sich aus:

• Dem Messbereich des Sensors (Physical Full Scale)

• Der Ausgangssignaländerung des Sensors bei dieser 100% Last (Electrical Full Scale 
output). Dieser entspricht meist dem Kennwert, der im Prüfprotokoll des Sensors 
angegeben ist.

• Dem physikalischen Messbereich des Messverstärkers (Input Range). Dieser wird in 
der Regel automatisch von der Software ausgelesen.

Die Wahl der Einheit beeinflusst das Ergebnis nicht, verändern Sie stattdessen ggf. Physical 
full scale des Sensors dementsprechend.

Geben Sie die Werte ein und betätigen Sie dann Calculate und anschließend OK / Set, um die
Skalierung im Messverstärker zu speichern. Der Wert erscheint dann in der Configuration 
Karteikarte neben User Scaling unter Range. Er entspricht dem elektrischen 
Aussteuerungsbereich, jedoch in der Regel nicht dem des Sensors, dieser ist meist kleiner.

Tipp: Wenn Sie Sensoren mit TEDS anschließen, ist die Eingabe der Skalierung unnötig, weil sie 
automatisch gesetzt wird. Siehe S. 49
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Rekorder Yt

In der Karteikarte Recorder Yt werden die Messwerte in Echtzeit grafisch über der aktuellen 
Zeit dargestellt.

Mit „Start Measuring“ oder „Stop Measuring“ starten bzw. stoppen Sie die grafische 
Darstellung. Mit „Start Recording“ „Stop Recording“ beginnen oder beenden Sie eine 
Aufzeichnung von Messdaten auf eine Datei.

Die angezeigte Karteikarte darf jederzeit gewechselt werden, auch während einer Messung 
oder einer Aufnahme, die dadurch nicht beeinträchtigt wird.

Set All Zero führt den Nullabgleich für alle Kanäle durch. Beachten Sie, dass der Button Set 
Zero für einzelne Kanäle deaktiviert sein kann, z.B. bei Kraft-/Momenten Sensoren oder für 
andere berechnete Kanäle. Dann sollte Set All Zero verwendet werden.

Bei Klick mit der rechten Maustaste in die Grafik öffnet sich das Kontextmenü für diverse 
Einstellungen, wie z.B. Autoscale.

Wenn Autoscale Y deaktiviert ist, können Sie den Minimal- und den Maximalwert der y-Achse
anklicken und durch Ändern der Skalenendwerte und abschließendes Enter verändern.

Den zeitlich sichtbaren Bereich stellen Sie mit Time Visible ein.

Unter Display befindet sich eine Auswahl von Möglichkeiten für die Anzeige der türkisfarbig 
hinterlegten numerischen Messwerte, des sog. Single Value Display: So ist z.B. durch Max-
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Min die Rauschamplitude oder durch Resol Parts PP eine Qualitätszahl „Messbereich / 
Rauschamplitude“ anzeigbar, s. S.18.

Mit dem Button Configure Recording lassen sich die Eigenschaften für die 
Messwertaufnahme, z.B. Start- und Stopbedingungen als Software-Trigger, definieren. Siehe 
S. 58.

Mit dem Button Add Graph Window können weitere Grafik Fenster geöffnet werden, z.B. um 
Kräfte und Momente in unterschiedlichen Fenstern mit eigener grafischer Skalierung 
darzustellen oder um eine Spektralanalyse (FFT) durchzuführen.

Messjob laden und speichern

Alle Einstellungen bezüglich Grafik-Fenster und Benennung von Kanälen, sowie 
Schnittstellennummern etc. können beim Verlassen des Programms oder mit Hilfe des 
Buttons Save Session in einer Session-Datei vom Typ *.ucf gespeichert werden, und durch 
Open Session oder durch Doppelklick auf die ucf-Datei vor dem Programmstart 
wiederhergestellt werden. In dieser Datei werden keine Einstellungen der Messverstärker 
gespeichert.

Bei der Wiederherstellung der Kanäle werden alle gespeicherten Kanäle aller Geräte geöffnet
und auch weitere Einstellungen geladen, s. S. 14.
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Grafische Anzeige Graph Display

Die Karteikarte Graph Display bietet Grafikanzeigen über die Zeit für jeden Kanal.

Das Rechte-Maustasten Menü bietet ähnliche Möglichkeiten wie im Yt Recorder. Es können hier bis 
zu 16 Kanäle angezeigt werden.

Großanzeige Value Display

Unter dieser Karteikarte steht eine numerische Großanzeige aller Kanäle zur Verfügung.
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Anzeige aufgenommener Messdaten

Mit File Monitor in der Karteikarte Configuration öffnet sich zunächst ein 
Dateiauswahlfenster, in dem die zuletzt mit Start Recording aufgenommene Datei vor-
ausgewählt ist. Nach Bestätigen mit OK öffnet sich das Anzeigefenster für 
Messdatendateien. Sie können grafisch oder als Wertetabelle angezeigt und mit Export auch
in andere Formate wie Excel oder CSV, konvertiert werden. Mit dem Maus-Scrollrad oder den
Zoomoptionen der Grafik-Palette kann die Anzeige vergrößert, verkleinert oder verschoben 
werden, auch Cursor für verschiedene Funktionen können eingeblendet werden; siehe S.67

Weitere Hilfen und Informationsquellen

• Unter Menüleiste  → Help  → Show Context Help kann die Kontexthilfe geöffnet 
werden. Das ist ein kleines Hilfefenster, welches für jedes Bedienelement 
Informationen anzeigt, wenn man mit der Maustaste darüberfährt.

• Im Internet, auf der Website me-systeme.de gibt es weitere Informationen

• Für einige Sonderfunktion, z.B. MathSkript/MathChannel (nur für PRO Variante) gibt 
es eine eigene Anleitung

• Die Bedienungsanleitungen der verwendeten Messverstärker sollten bei 
Erstinbetriebnahme zur Kenntnis genommen werden

Allgemeine Hinweise zur Software

• Schaltflächen oder andere Steuerelemente, die Speichern von Einstellungen im
Gerät bewirken, sind gelb hinterlegt.

• Bei Bedienung von Funktionen, die innerhalb eines Dialogfensters mehrere 
Eingaben erfordern, ist die Bedienreihenfolge meistens von oben nach unten 
und / oder von links nach rechts.

• Alle Schaltflächen und andere Eingabeelemente des Hauptfensters sind auch 
über die Menüleiste oben erreichbar. Umgekehrt gilt das nicht, d.h. es gibt auch
Funktionen oder Dialogfenster, die nur über die Menüleiste erreicht werden 
können.

• Die Menüleiste nennt bei vielen Funktionen auch Tastaturkombinationen (sog. 
Hotkeys), die diese Funktion ebenfalls auslösen. Wenn hier vermerkt ist: 
Ctrl+<Taste>, so ist zuerst die Strg-Taste (Steuerung) zu drücken und zu halten, 
während dann <Taste> gedrückt wird, z.B. Ctrl+PageUp: Erst Strg gedrückt halten, 
dann Bildlauftaste hoch: Angezeigten Kanal in Configuration vergrößern. 

Planen und Verwalten von Messaufgaben
Vor der Durchführung einer Messung ist es sinnvoll, folgende Fragen zu klären:

• Welche Sensoren und Messkanäle werden benötigt?

• Welche Messdatenrate sollte gewählt werden?
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• Soll die Auswertung nur zur Messlaufzeit, d.h. als Live-Ansicht in Echtzeit erfolgen 
oder soll die Messung erst aufgezeichnet und später ausgewertet werden?

Insbesondere bei Messungen mit wichtigem Ergebnis oder solchen, deren Durchführung 
aufwändig ist, wird empfohlen, nach Planung und Konfiguration des Messsystems eine oder
mehrere Testmessungen durchzuführen. Wenn möglich, sollte dies mit den gleichen Geräte- 
und Sensorexemplaren an dem gleichen Ort und auf demselben PC, auf dem die eigentliche 
Messung stattfinden soll, erfolgen.

Messkanäle

Ein Messkanal repräsentiert eine physikalische Größe, die in der Regel von Sensoren in 
elektrische Größen umgeformt werden, die der Messverstärker erfasst und digitalisiert. 
Dabei werden die analogen Werte in Zahlen umgewandelt, und zwar mit einer festgelegten 
Anzahl von Messwerten pro Sekunde, der Messdatenrate (Data frequency). Die 
Messverstärker GSV-2 und GSV-3 haben nur einen Messkanal; bei allen anderen wird der 
Eingang, zu dem der Messkanal gehört, wie auch der Gerätename neben Input rechts oben 
im Configuration Tab angezeigt. Die Geräteseriennummer erscheint neben Device Serial No.

Die Kanalnummer, die man neben Actual Channel sieht, wird durch 
die Reihenfolge festgelegt, mit der die Kanäle durch Add Channel 
hinzugefügt worden sind und sie ist i.d.R. frei wählbar. Eine Ausnahme
bilden hierbei MathChannels, die berechnete Software-Kanäle darstellen 
und nach den Hardware Kanälen hinzugefügt werden, bzw. 
dementsprechend automatisch sortiert werden2 sowie Zählerkanäle, s.u.

Es ist praktisch, den Messkanälen aussagekräftige Namen zu 
geben. Das können Sie tun, indem Sie den Namen im 
Anzeigefeld Channel Name direkt ändern und dann die Enter-
Taste drücken oder auf Menüleiste  → Channel  Name→ ... 
klicken.

Beim Hinzufügen der Kanäle werden automatisch bis zu 32 
verschiedene Farben zugeordnet. Sie können diese bereits im 
Add Channel Dialog links unten ändern oder nachträglich mit 
Menüleiste  → Channel  → Color…

Mit dieser Farbe wird auch die Anzeige des Kanalnamens unter 
Channel Name in der Configuration Karteikarte hinterlegt und 

auch Graphen aufgenommener Messdatendateien werden im File Monitor mit dieser Farbe 
angezeigt.

Typen von Geräten und Messkanälen

In der kostenlosen Variante von GSVmulti gibt es z.Zt. zwei Grundtypen von Kanälen: 
Analoge Kanäle und Zählerkanäle (Counter Input). Die Messverstärker GSV1A8USB, GSV-
6BT und GSV-8 bieten Zählereingänge, mit denen digitale Pulse gezählt oder mit denen 

2 Berechnete Kanäle (MathChannels) sind nur mit GSVmulti PRO verfügbar. Diese Funktion ist in einer 
gesonderten Anleitung beschrieben.
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Frequenz gemessen werden kann. Ein Zählerkanal kann hinzugefügt werden, nachdem 
schon mindestens ein Analogkanal des gleichen Gerätes hinzugefügt wurde. Um das zu tun,
wählt man im Add Channel Dialog rechts Function = Digital Counter. 

Beim GSV-8 und beim GSV-6BT muss der 
Zähler einmalig aktiviert und konfiguriert 
werden, s. S. 131. Auch bei 
Zählereingängen kann die Skalierung mit 
User Scaling geändert werden (allerdings 
nicht mit jeder Methode berechnet werden).

Der Kanaltyp bestimmt neben Geräte- oder 
COMportnummer und Eingangskanal auch 
den voreingestellten Kanalnamen.

GSVmulti PRO bietet weitere Sonderkanäle, die durch Öffnen folgender Geräte (Devicetype) erzeugt 
werden:

• GPS / GNSS für satellitengestützte Positionsbestimmung: Latitude (Breitengrad), Longitude 
(Längengrad), Altitude (Höhe über NN), Speed (Geschwindigkeit) und UTC time (Weltzeit)

• Math Script: Durch benutzerdefiniertes Skript berechnete Kanäle (Math Channels)

• User Device: Geräte anderer Hersteller, die Messwerte als Textstring über eine serielle 
Schnittstelle senden, s.S.115.

Diese Sonderkanäle haben nur eingeschränkte Konfigurationsmöglichkeiten; lediglich der 
Kanalname, die Einheit (Unit) und die Farbe können geändert werden.

Messsitzung laden und speichern

Die Kanalliste kann mit Save Session gespeichert werden. Man sie dann jederzeit, auch nach
einem Neustart von GSVmulti, mit Open Session wieder herstellen. Diese Datei enthält auch 
Informationen darüber, wie die eingebundenen Geräte geöffnet werden (COMport Nummer, 
Baudrate, Eingangskanal) und wie sie dargestellt werden (Kanalname, Farbe) und bei 
Sonderkanälen auch die Einheit sowie ggf. Einstellungen über Sonderfunktionen. Mit Open 
Session werden die eingebundenen Kanäle geöffnet und die Darstellungseigenschaften 
wiederhergestellt.

Durch Doppelklick auf die Session-Datei (z.B. im Windows-Explorer) kann GSVmulti gestartet
werden und dann wird diese Session automatisch geöffnet.

Die Session-Datei enthält nicht die Konfigurationsdaten der Messverstärker (das sind solche,
die mit gelben Buttons im Gerät gespeichert werden). Einstellungen der Messverstärker 
können stattdessen mit Save Settings → Save to file in einer Datei gespeichert und mit Load 
Settings → Load from File wiederhergestellt werden.

Ein Backup mit allen Einstellungsdateien aller eingebundenen Messverstärker einschließlich 
Session-Datei kann mit Menüleiste  → Help  Create → Settings Archive erstellt werden. Es ist 
ein ZIP-Archiv, dass diese Dateien enthält.

Master-Slave Synchronisation mit mehreren Messverstärkern

Wenn mehr als ein GSV-Gerät eingebunden ist und die Messdatenraten relativ hoch sind 
oder die Aufzeichnungsdauer eher lang, ist es sinnvoll, dass die Messverstärker 
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synchronisiert werden. Andernfalls können sich aufgrund der asynchronen 
Datenübertragung zeitliche Fehler akkumulieren (d.h. vergrößern), so dass nach einer 
gewissen Zeit nach Start der Messung die Messwerte der verschiedenen Geräte zeitlich 
nicht mehr übereinstimmen.

Bei der Master-Slave Synchronisation wird der Zeitpunkt der Übertragung eines 
Messdatenframes über die seriellen Schnittstellen aller Geräte angeglichen (d.h. auch über 
USB- Bluetooth, Ethernet).

Sie ist ein Hardware-Feature, das bei den Geräten GSV-4, GSV-6BT/CPU und GSV-8 aktiviert 
werden kann (bei GSV-3USBx2 als Bestelloption erhältlich). Dabei muss eine Leitung bestimmte 
digitale I/O Anschlüsse der Geräte miteinander verbinden, d.h. jeweils ein digitaler I/O 
Anschluss und (D)GND müssen an den Geräten per Kabel verbunden werden. Genau eines 
der Geräte wird dabei als Master konfiguriert und dieses erzeugt ein digitales 
Synchronisationssignal, und zwar einen Rechteck mit der Frequenz der eingestellten 
Datenrate. An einer der Flanken (i.d.R. steigende, d.h. low high) überträgt der Master auch →
seinen Messdatenframe und die Slaves erkennen diese Flanke und senden ebenfalls ihre 
Messdatenframes.

Wenn bei allen eingebundenen GSVs die Master-Slave Funktion aktiviert ist, so wird 
GSVmulti beim Klick auf Start Measuring eine Sync-Sequenz anwenden; bei der temporär die
Übertragung gestoppt, die Datenpuffer gelöscht und der Master dann gestartet wird, so 
dass alle Geräte gleichzeitig anfangen, Messdaten zu senden.

Voraussetzung ist, dass die Synchronisation in den Programmoptionen aktiviert ist und dass
alle angeschlossenen Geräte Master-Slave unterstützen, richtig verdrahtet (s.o.) und 

konfiguriert sind (s.u.). In den Software-Einstellungen muss unter 
Menüleiste  → Options  Hardware ->→  Master / Slave  synchronization, 
if available auf Synchronization gesetzt sein, was in den 
Defaulteinstellungen der Fall ist.

Die Master-Slave Synchronisation wird auf folgende Weisein den GSVs konfiguriert und 
überprüft: Wählen Sie in der Karteikarte Configuration mit Actual Channel einen Kanal, der zu 
dem Gerät gehört, das konfiguriert oder überprüft werden soll. Klicken Sie dann in der 
Menüleiste auf Device und wählen Sie Advanced Settings… In diesem Dialog wird der Master-
Slave Modus in der Karteikarte Value Mode angezeigt:

Diese Anzeige ist nur bei GSV-3, -6 und -8 vorhanden.
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Der Master- oder Slave Modus wird in der Karteikarte Digital I/O in den Advanced device 
Settings aktiviert. Dazu wählt man mit I/O number zunächst den digitalen I/O Port aus, an 
dem die Synchronisationsleitung angeschlossen werden soll. Üblicherweise (und wenn 
dieses Kabel fertig konfektioniert bei ME erworben wurde) sind das folgende:

• GSV-8: I/O number 16 für Master und für Slave

• GSV-6: I/O number 1, 2 oder 3 für Master und 4 (TRIG) für Slave

• GSV-4: beliebige von 1 bis 8 für Master und für Slave

Dann versetzt man am besten zuerst den 
Slave in dessen Modus, um zu vermeiden, 
dass durch das angeschlossene Sync.--
Kabel versehentlich zwei Ausgänge 
(Master) verbunden sind, weil das einem 
Kurzschluss gleichkäme. Dazu wählt man 
Sync. Slave mit I / O type aus. Anschließend 
Store to device.

Dann konfiguriert man den Master, indem 
man diesen I/O type auf Sync. Master stellt.

Beim GSV-8 erhält man u.U. eine 
Zwischenmeldung, die warnt, dass alle I/Os 13-
16 (d.h. die der Vierergruppe, zu der der 
gewählte I/O gehört) als Input bzw. Output 
umgestellt werden. Diese ist zu bestätigen; falls

diese drei anderen I/Os für eine inkompatible Funktion vorgesehen sind, müssten u.U. andere I/Os 
verwendet werden.

Wenn ein Slave-Gerät kein Synchronisationssignal bekommt, z.B. weil das Kabel nicht 
angeschlossen oder der Master ausgeschaltet ist, sendet es keine Messwerte, so dass dann
timeout in der Messwertanzeige der Configuration Karteikarte erscheint.

Kanäle oder Geräte entfernen

Der in der Configuration Karteikarte angezeigte Kanal kann mit Remove Channel entfernt 
werden. Möchte man einen oder mehrere versteckte Kanäle entfernen, müssten alle 
versteckten Kanäle erst mit Menüleiste -> Channel -> Unhide All hervorgeholt werden. 
Versteckte Kanäle wurden vorher mit Channel->Hide verborgen, z.B., weil sie nur als 
Eingangswert einer Berechnung benötigt werden, aber nicht angezeigt werden sollen, siehe 
z.B. S. 42

Um alle Kanäle, die zu einem bestimmten Gerät 
gehören zu entfernen, kann man auf Menüleiste-
>Device->Close klicken. Wenn mehrere Geräte 
offen sind, erscheint ein Dialog, in dem man das zu
entfernende Gerät rechts mit Remove auswählt 
und dann mit OK bestätigt. Dann werden alle 
Kanäle dieses Gerätes, dessen Name (Model), 
Comport- und Seriennummer (Serial No) links 
angezeigt werden entfernt, auch versteckte Kanäle.
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Wahl der Messdatenrate

Die Messdatenrate Data Frequency ist die Anzahl der Messwerte (Samples), die die 
Messverstärker pro Sekunde und pro Kanal nehmen und übertragen. Sie sollte bei 
Verwendung mehrerer Messverstärker bei allen Geräten möglichst gleich eingestellt werden;
andernfalls erhält man bei Klick auf Start Measuring ggf. eine Warnmeldung. Die 
Messdatenrate ist bei Mehrkanal-Messverstärkern stets für alle Messkanäle gleich und sie 
ist als Einzelabtastrate, also pro Kanal zu verstehen (d.h. multipliziert mit der Zahl der 
Eingangskanäle ergibt sich die Summenabtastrate).
Um sie zu ändern, aktiviert man mit Actual Channel einen zum Messverstärker gehörenden 
Kanal und klickt Data Frequency, wodurch sich der Change Data Rate Dialog öffnet. Nach 
erfolgreicher Änderung wird bei allen dessen Kanälen die gleiche Messdatenrate angezeigt.

Der Wertebereich der Messdatenrate hängt vom 
Messverstärkermodell ab und wird im Change Data Rate 
Dialog unter Minimum und Maximum angezeigt:

Das Maximum hängt bei vielen Gerätemodellen zusätzlich 
von anderen Einstellungen und Konfigurationen ab. Bei 
eingeschalteter serieller UART oder RS232 Schnittstelle ist

dieses Maximum z.B. stark von der Kommunikations-Bitrate abhängig, s. S.109

Es sind nicht alle beliebigen Messdatenraten kontinuierlich einstellbar. Es kann also sein, 
dass die dem gewünschten Wert an nächsten liegende Datenrate gesetzt wird; das gilt 
insbesondere für die Modelle GSV-4, GSV-6 und GSV-8, speziell bei hohen Werten. Die 
Bedienungsanleitungen der Geräte geben hierüber nähere Auskunft.

Welche Messdatenrate man wählt, hängt von der Messaufgabe ab. Sie sollte grundsätzlich 
so niedrig wie möglich, aber hinreichend groß gewählt werden, wenn auch kurze 
Änderungen wie z.B. Peaks oder Vibrationen erfasst werden sollen.

Hohe Messdatenraten (also solche etwa oberhalb 50/s, abhängig vom Anwendungsfall) und
niedrige haben folgende Vor- und Nachteile:

Hohe Datenrate Niedrige Datenrate

Vorteile Schnelle Änderungen werden erfasst, 
z.B. Peaks, Schwingungen

Geringeres Rauschen, d.h. bessere effektive
Amplitudenauflösung

Gute Frequenzdarstellung mit FFT 
möglich

Kleinere Dateien bei Datenaufzeichnung

Hohe zeitliche Auflösung Geringere Auslastung des PCs

Zum Teil geringere zeitliche Verzögerung
(Latenzzeit) zwischen Signaländerung 
und Messwertänderung3

Bessere Unterdrückung von Störungen, z.B. 
elektromagnetischer Art

Nachteile Höheres Rauschen, d.h. schlechtere 
Amplitudenauflösung

Schnelle Änderungen des Messsignals 
werden nicht erfasst

3 Es gibt einen konstanten Anteil tk dieser Verzögerungszeit und einen von der Datenrate abhängigen, so 
dass die gesamte Latenzzeit= tk + t(Fdata) ist.
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Hohe Datenrate Niedrige Datenrate

Große Dateien bei Datenaufzeichnung, 
daher langsamere Dateiverarbeitung und
aufwändigere Auswertung

Frequenzdarstellung (FFT) nicht sehr 
aussagekräftig

Höhere Auslastung des PCs Der von der Datenrate abhängige Anteil der 
Latenzzeit ist länger

Jeder Messverstärker hat eine maximale Frequenz der messbaren Signale, d.h. eine 
begrenzte Bandbreite, er wirkt also stets als Tiefpassfilter. Bei digitalen Messverstärkern 
wird diese Bandbreite u.a. durch die Messdatenrate bestimmt; sie ist typischerweise ca. 0,3 
bis 0,4 x Messdatenrate. Die Bandbreite kann aber noch niedriger sein, z.B. aufgrund 
analoger Vorfilter. Je größer die Bandbreite, desto höher ist prinzipbedingt auch das 
Rauschen, d.h. der dynamische, normalverteilte Anteil an der Messunsicherheit steigt mit 
der Bandbreite.

Um wie viel größer das Rauschen bei höherer Datenrate ist, hängt auch vom Messverstärker
und von der Stärke externer Störquellen ab.  Die meisten Messverstärker arbeiten intern mit 
einer höheren Samplingfrequenz, die sie dann durch Mittelwertbildung oder dezimierende 
Digitalfilter verringern. Zum Vergleich der Rauschabstandsänderung beim Vergleich zweier 
Datenfrequenzen f1 und f2, mit f1>f2, gilt als grobe Faustformel: 

R(f1) ≈ R(f2) x √(f1/f2)

Beispiel: Bei der Messdatenrate f1= 1000/s ist das Eigenrauschen R(f1) etwa 10 x größer als
bei f2= 10/s, denn √(1000/10) =10. Das Eigenrauschen umfasst nur das durch den 
Messverstärker prinzipbedingt selbst erzeugte Rauschen ohne externe Störquellen.

Analyse von Rauschen und Störabstand

Bei vielen Anwendungen ist es möglich, durch Testmessungen die am besten geeignete 
Messdatenrate herauszufinden. Dabei ist es zweckmäßig, mit einer eher hohen Datenrate zu
beginnen. Dadurch können auch externe Störquellen erkannt werden, insbesondere wenn 
die Testmessung an dem gleichen Ort stattfindet, in der gleichen Umgebung, etwa mit 
eingeschalteten Maschinen in der Nähe wie bei der eigentlichen Messung.

Man kann z.B. mit der Hälfte (oder mehr) der maximal einstellbaren Datenrate beginnen.

Dann lässt man den Sensor zunächst in Ruhe, d.h. vermeidet, dass sich das Nutzsignal 
ändert. Nun kann man den Rauschabstand bestimmen und ggf. Störfrequenzen finden.
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Dazu startet man eine Messung und wählt mit dem Pull-Down Auswahlelement Display eine 
der folgenden Einstellungen:

Auswahl Beschreibung Einheit Interne Berechnung

SNR [dB] Signal-to-noise ratio: Signal-Rauschabstand 
Dabei werden kurze Peaks geglättet! Es wird 
auf den Eingangs-Messbereich bezogen, der 
Mittelwert abgezogen und das Ergebnis in 
Dezibel umgerechnet.

dB
20⋅log( Range

√ 1N⋅∑ (x i− x̄) ²
)

Resol. Parts
pp

Resolution in Parts pp: Relative 
Spitzenwertauflösung bezogen auf  den 
Eingangs-Messbereich

keine Range
Max−Min

Max-Min Absolute Spitzenwertauflösung in der Einheit 
der physikalischen Größe.

wie
Messgröße

Maximum - Minimum

RMS/StDev Root-Mean-Square / Standardabweichung in 
der Einheit der physikalischen Größe.
Dabei werden kurze Peaks geglättet! 

wie
Messgröße √ 1N⋅∑ (xi− x̄) ²

Range ist der Messbereich des Messverstärkereingangs, so wie er i.d.R. in der Karteikarte 
Configuration angezeigt wird. xi sind alle Messwerte der Stichprobe, Max der Maximalwert und Min 
der Minimalwert der Stichprobe. Die Erfassung der Stichprobe erfolgt über N=100 Werte oder über 
eine Sekunde, d.h. bei Messdatenrate > 100/s ist N= Messdatenrate.

Das Ergebnis wird rechts im türkisgrün hinterlegten Feld angezeigt. Mit der Auswahl SNR 
[dB] oder Resol. Parts pp kann das Rauschen unabhängig vom Messbereich beurteilt 
werden. ME Messsysteme gibt für Messverstärker meistens die Spitzenwertauflösung an (Resol. 
Parts pp), andere Hersteller oft nur den Signal-Rauschabstand SNR.
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Wenn bereits ein Sensor angeschlossen und justiert ist, kann mit Max-Min das 
Spitzenwertrauschen und mit RMS/StDev die Standardabweichung geprüft werden, beides 
in physikalischen Einheiten.

Die folgende Tabelle zeigt typische Rauschwerte eines GSV-8. Externe Störungen wurden 
hier beseitigt.

Fdata [Hz] Input SNR[dB] RMS [nV/V] NoisePP [parts] NoisePP [nV/V]

10 2 mV/V 119 2,24 100000 20

10 3,5 mV/V 113 7,84 100000 35

10 7 mV/V 115 12,45 100000 70

1000 2 mV/V 103 14,16 24000 83,33

1000 3,5 mV/V 103 24,78 24000 145,83

1000 7 mV/V 103 49,56 24000 291,67

12000 2 mV/V 94 39,91 6500 307,69

12000 3,5 mV/V 94 69,83 6500 538,46

12000 7 mV/V 94 139,67 6500 1076,92

In der Angabe SNR und RMS erhält man bei der gleichen Testmessung bessere Werte, weil 
kurze Spitzen weggemittelt werden.

Die Abbildung des Recorder Yt oben zeigt eine Testaufnahme mit einem GSV-8 bei einer 
Messdatenrate von 6000/s eines Sensors mit einem Messbereich von 2500 N. Die absolute 
Spitzenwertauflösung Max-Min ist also 0,89 N. Die Grafik zeigt schon im Zeitbereich ein 
deutliches Störsignal. Um die Ursache herauszufinden, ist oft eine Spektralanalyse sehr 
hilfreich. Dazu klickt man auf Add Graph Window und zunächst öffnet sich der 
Konfigurationsdialog für diese grafische Zusatzanzeige.

Hierin stellt 
man 
Diagram 
Type auf FFT,
klickt Add 
Plot und 
wählt dann 
mit Select 
Channel for 
actual plot 
den Kanal 
aus. Ein FFT 
Fenster kann
jeweils nur 
einen Kanal 
anzeigen, 
man kann 

jedoch nacheinander bis zu 6 Graph Windows öffnen, indem man Add Graph Windows 
mehrmals ausführt.
Die FFT-Spektralanzeige öffnet sich:
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Der anzeigbare Frequenzbereich beträgt stets Messdatenrate / 2, hier also 3000Hz. Deutlich 
erkennt man Störpeaks. Um die Frequenz des ersten zu identifizieren, kann man Autoscale X
deaktivieren (mit rechter Maustaste in die Graphik klicken) und den Frequenzbereich rechts 
unten editieren:

Hier erkennt man Störungen bei 50 Hz und ungeradzahlige Vielfache davon. Dies ist ein 
typischen Verhalten bei schlechter Kabelverlegung, fehlender Schirmung oder, wie in diesem
Fall, der Verwendung einer wenig geeigneten Stromversorgung des Messverstärkers: Die 
Stromnetzfrequenz von 50 Hz streut stark ein (die Vielfachen davon werden vermutlich von dem 
ungeeigneten Netzgerät erzeugt, das eine Art Rechteckschwingung induziert).

Zum Vergleich wird nun das Original-Netzgerät des GSV-8 verwendet:

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de
16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de 21



Die Spitzenwertauflösung ist nun mit 8000 Teilen deutlich besser, es entspräche mit o.g. 
Sensor einer absoluten Auflösung von 0,32 N. Die 50Hz Netzfrequenz streut immer noch etwas 
ein, aber um ca. 20 dB weniger (entsprechend einer Dämpfung von 10). Es ist vermutlich darauf 
zurückzuführen, dass zwar ein kurzes Sensorkabel verwendet wurde, aber ohne Schirmung.

Oft hilft auch das Erden des Gehäuses des Messverstärkers (wenn es aus Metall ist); beim 
GSV-8 wird dazu ein grünes Erdungskabel mitgeliefert. Es verbessert die Störunterdrückung 
allerdings nicht immer. Auch eine Erdung des Sensors ist oft hilfreich, insbesondere, wenn 
dessen Metallkörper vom Kabelschirm isoliert ist, wie meistens bei ME-Sensoren.

Es ist empfehlenswert, Störungen an der Ursache zu beseitigen oder zumindest zu 
dämpfen; beispielsweise sollten Messverstärker und Sensor möglichst weit weg von starken
Störquellen (wie etwa Frequenzumrichter für Motoren) platziert werden.

Falls dies nichts hilft, kann die Messdatenrate verringert werden oder - mit dem GSV-6 und 
GSV-8 - ein digitales Filter als Bandsperre konfiguriert werden, s.S. 101.

Mit der o.g. Vorgehensweise kann der Erfolg einer Maßnahme gegen Störungen direkt 
beobachtet werden.

Ausblenden des Rauschens um Null herum (Noise Cut)

Die Geräte GSV-2 und GSV-8 können so konfiguriert werden, dass sie die Messwerte auf 
exakt =0 setzen, wenn sie sich innerhalb eines konfigurierbaren Amplitudenbereichs um Null
herum befinden. Der Rauschboden nahe Null wird also abgeschnitten. Wenn diese Funktion 
nicht aktiviert ist und Messwerte dauernd exakt =0 sind, obwohl genug Nachkommastellen 
angezeigt werden, deutet dies auf eine Fehlfunktion hin. Bei Verwendung des Noise-Cut Modus kann 
diese bei Messwert =0 jedoch nicht mehr erkannt werden, was nachteilig sein kann.

Noise-Cut wird unter Menüleiste -> Device -> Advanced Settings... -> Value Mode -> Noise 
suppression konfiguriert:
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Beim GSV-8 muss dazu unter Input Channel die Nummer des Eingangskanals eingegeben 
werden, für die der Schwellwert gelten soll; mit 0 wird der angegebene Schwellwert für alle 
Kanäle so gesetzt. Mit Noise-cut enabled wird die Funktion für alle Kanäle aktiviert. Wenn 
gewünscht ist, dass sie nur für bestimmte Kanäle gelten soll, setzte man bei Kanälen, bei denen sie 
deaktiviert sein soll, den Schwellwert auf 0. Unter Noise-cut threshold wird der obere, positive 
Schwellwert für den Amplitudenbereich der Noise-Cut Funktion eingegeben. Der Bereich 
geht dann von -Schwelle bis Schwelle, z.B. wie gezeigt von -0,175 bis 0,175. Am Ende unten 
auf Store to device klicken.

Aufgrund der dezimierenden Mittelwertbildung bei numerischer live-Anzeige kann es vorkommen, 
dass ein angezeigter Messwert kurzzeitig innerhalb des Noise-Cut Intervalls liegt; dies ist jedoch nur 
ein Anzeigeeffekt, der die Original-Messdaten nicht betrifft, s. S. 31.

Geräteeinstellungsdaten verwalten

In den meisten Messverstärkermodellen4 kann man Datensätze mit Konfigurationen 
zusätzlich ablegen. Alle Messverstärker stellen ja stets beim 
Einschalten die zuletzt gültigen Einstellungen wieder her. 
Zusätzlich existieren Benutzerdatensätze für alternative 
Einstellungen oder Backups. Das ist beispielsweise nützlich, 
wenn man unterschiedliche Sensoren an den gleichen 
Kanälen eines Gerätes anschließen möchte oder 
verschiedene Messdatenfrequenzen oder Filter testen 

möchte u.v.m. Man braucht dann nicht immer die einzelnen Konfigurationsprozeduren zu 
wiederholen.

Zum Speichern dieser Einstellungsdatensätze klickt man auf Save Settings in der Karteikarte
Configuration und wählt dann den Datensatz aus, in den man speichern möchte. Er ist 
standardmäßig mit User 1 bis User 2 bzw. bis User 6 bezeichnet; wie viele Datensätze zur 

4 Mit Ausnahme des GSV-6 (bisher, aber auch mit diesem f. kommende Versionen geplant)

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de
16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de 23



Verfügung stehen, hängt vom Modell ab. Es sind zwei beim GSV-3 und GSV-4, sechs bei 
allen anderen (außer GSV-6).

Alternativ kann man mit Save to File die Geräteeinstellungen auch in einer Datei speichern. 
Das ist beispielsweise nützlich, wenn man mit gleichem Sensor(en) ein anderes 
Messverstärkerexemplar desselben Modells verwenden will, dann kann man hiermit die 
Einstellungen in einer Datei speichern und diese dann in das andere Gerät laden.

Zum Laden der Einstellungen klickt man auf Load Settings.

Mit Load from File kann man die Einstellungen aus einer Datei
wiederherstellen und mit User 1 bis User 6 (2) die aus den o.g.
Datensätzen im Gerät.

Zusätzlich gibt es hier die Möglichkeit, mit Last Session die 
Daten wieder herzustellen, die zum Zeitpunkt des 
Einschaltens galten. Das kann nützlich sein, wenn man 
versehentlich ungünstige Einstellungen gewählt hat (z.B. 

Load User 1 bis 6 oder Default) oder etwas testweise probieren wollte, was nicht dauerhaft 
gespeichert werden soll. Last Session laden steht nur beim GSV-2 und GSV-8 zur Verfügung 
(weil diese Modelle die aktuellen Einstellungen erst kurz nach dem Ausschalten nichtflüchtig 
speichern, mithin die Einschaltdaten noch im nichtflüchtigen Speicher vorhanden sind).

Außerdem kann man mit Default hier die Herstellereinstellungen wieder laden. Das sind die 
Werkseinstellungen, die der Messverstärker standardmäßig hat. Bei normalen Seriengeräten
entspricht dies der Konfiguration des Auslieferungszustandes (das gilt jedoch nicht, wenn der 
Hersteller das Gerät auf Kundenwunsch abweichend konfiguriert hat, um es z.B. für einen 
bestimmten Sensor zu kalibrieren). 

Das Laden der  Werkseinstellungen steht bei allen Messverstärkermodellen zur Verfügung. 
Die Bedienungsanleitungen oder Protokolldokumentationen geben oft über die konkreten 
Werkseinstellungen Auskunft, oft auch das Typenschild. Die Default-Messdatenrate ist meist 10/s.

Grundsätzlich werden mit Load Settings die aktuellen Einstellungen überschrieben, d.h. sie 
gehen verloren (Nur beim GSV-2 und GSV-8, kann man es mit Last Session ggf. rückgängig 
machen).

Geräteeinstellungsdaten zuordnen und benennen beim GSV-2

Mit dem GSV-2 hat man die Möglichkeit, 
den Benutzerdatensätzen eigene Namen 
zu geben und diese Konfiguration als 
zugeordnet zu einem bestimmten Sensor
oder einer bestimmten Messkampagne 
festzulegen. Dies tut man, indem man in 
der Menüleiste auf Device -> Advanced 
Device Settings... klickt und darin die 
Karteikarte Administration wählt:

Vorher sollten die aktuellen 
Geräteeinstellungen wie gewünscht 
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konfiguriert werden, z.B. Eingangstyp, Nullpunkt, User Scaling, User Offset, Messdatenrate 
etc.

Dann wählt man zuerst mit Data record No die Datensatznummer, wobei 1 dem 
Defaultnamen "User 1" entspricht, bis Nr. 6 für "User 6". Dann trägt man einen geeigneten 
Namen in Displayed name ein (maximal 13 Zeichen lang). 

Anschließend weist man mit Klick auf Assign die aktuellen Einstellungen diesem Datensatz 
zu. 

Dadurch verändert sich die Ausgabe wie links gezeigt.

Zuletzt klickt auf Store Record name to device:

Diese Zuordnung hebt sich automatisch auf, wenn Geräteeinstellungen anschließend 
verändert werden. Dies kann man durch Setzen des Schreibschutzes verhindern, s.S. 27

Der neue Name des Datensatzes wird nun auch im Load Settings und im Save Settings 
Dialog angezeigt und auch im Display bei GSV-2 Modellen mit Tastaturmenü bei Eintritt in 
den dementsprechenden Menüpunkt.

Solange die Zuordnung der Einstellungen (zum Sensor o. Messung) bestehen bleibt, weil 
keine relevanten Einstellungen verändert wurden, wird bei Einschalten nach dem 
Herstellernamen der Name des Datensatzes im Display eingeblendet, z.B.:  3: 
Waage>g
In Administration (s.o.) kann mit Reset to Default die Namensbenennung und Zuordnung rückgängig 
gemacht werden.

Wiederherstellen von Geräteeinstellungsdateien aus einem Settings Archive

Wenn man in der Menüleiste auf Help -> Create Settings Archive klickt, wird eine ZIP-Datei 
erstellt, die alle relevanten Dateien mit Einstellungen enthält. Die Einstellungen aller 
Messverstärker, die währenddessen geöffnet sind, werden in Dateien dieses Archivs 
abgelegt und auch die zuletzt geöffnete oder gespeicherte Session Datei (s. S. 14) ist mit 
dem Original-Dateinamen im Stammverzeichnis des Archivs enthalten.

Die Geräteeinstellungsdateien sind im Stammverzeichnis des Archivs und haben das 
Dateinamensmuster <Gerätemodell><Seriennummer>.ucf. 
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Bei dem gezeigten Beispiel war ein GSV-8 und ein GSV-2 geöffnet. Die 
Geräteeinstellungsdatei des GSV-8 ist hier GSV-8_16256044.ucf und die des GSV-2 GSV-
2_rev1_15454833.ucf. Die Session-Datei hat hier den Default-Namen session.ucf.

Das Archiv enthält auch die *.dat und *.matrix Dateien aller Mehrachsensensoren, sowohl Software-
berechnete als auch die in den Geräten GSV-6 und GSV-8 enthaltenen, s. S.39. Bei GSV-8 wird auch 
eine Datei gespeichert, die den Inhalt des Fehlerspeichers enthält, hier GSV-8_16256044Faults.txt. 
info.txt enthält allgemeine Informationen zur Softwareversion.

Mit dem GSV-8 kann man das Settings Archive auch direkt öffnen, um alle Sechsachsensensordaten 
wieder in das Gerät zu laden. Das kann u.U. nach einem Firmwareupdate sinnvoll sein. Dazu klickt 
man den Button Recover All Six-Axis Sensors from Settings Archive in Menüleiste  → Device  →
Advanced Settings  Administration→  und wählt dann die *.zip Datei aus.

Portieren der Geräteeinstellungen beim GSV-1A8 USB

Die Messverstärker GSV-1A8 USB und GSV-1A16 USB können in Wahrheit ihre Geräteeinstellungen 
nicht im Gerät speichern (im Gegensatz zu allen anderen GSVs). Stattdessen werden die 
Geräteeinstellungen in Dateien emuliert, die sich auf dem PC im Verzeichnis C:\ProgramData\
MEsystemeGSVmulti befinden und im Settings Archive im Unterverzeichnis MEsystemeGSVmulti. 
Sie haben darin den Dateinamen <Seriennummer>.ucf.

Um einen GSV-1A8/16 USB mit den gleichen Einstellungen mit einen anderen Computer zu 
betreiben, kann man diese Einstellungen umkopieren. Dazu ist erstellt man zunächst das Settings 
Archive und entpackt es auf dem Ziel-PC. Auf diesem muss man das Systemverzeichnis C:\
ProgramData mit dem Windows-Explorer sichtbar machen, weil es normalerweise versteckt ist. Hat 
man das getan, kopiert man diese Einstellungsdatei in das Verzeichnis  C:\ProgramData\
MEsystemeGSVmulti ohne den Namen zu verändern. GSVmulti sollte dabei nicht geöffnet sein. 
Anschließend startet man GSVmulti und öffnet den GSV-1A8/16 mit Add Channel und speichert die 
Kanalliste in einer Session Datei, wenn gewünscht.
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Portieren der Session-Datei auf einen anderen PC

Die Session Datei enthält eine Liste aller eingebundenen Kanäle und weitere Software-Einstellungen 
wie z.B. zusätzliche Graph-Windows mit ihren Fensterskalierungen und Trigger-Paste und Copy-Paste
Einstellungen (s. S.78).

Es ist eine Konfigurationsdatei im Textformat, die in Abschnitte unterteilt ist, deren Einträge die Form
<Schlüsselname> = <Wert> haben. Abschnittsnamen sind in eckigen Klammern [Name] 
eingeschlossen.

Jeder Kanal hat einen eigenen Abschnitt mit dem Namen [ch<Nr>]. Auf einem anderen PC können 
alle Einstellungen ebenso gültig sein, außer den COMport-Nummern der eingebundenen Geräte und 
ggf. die Fensterskalierungen der Graph Windows.

Zum Portieren der Session Datei müssen also die COMport Nummern, die die Messverstärker auf 
dem Ziel-PC haben, bekannt sein. Dazu müssten sie dort einmal angeschlossen werden und man 
kann dann im Windows-Gerätemanager nachsehen oder sie testweise mit Add Channel öffnen.

Die Session Datei kann mit einem beliebigen Texteditor, z.B. notepad.exe geöffnet werden.

In allen Abschnitten [ch<Nr>], die zu einem Eingangskanal eines Gerätes gehören, müssen dann die 
Werte der Einträge ComNr verändert werden. Beispiel:
[ch1]
device = "GSV-8"
ComNr = 17
Input = 1
BaudRate = 115200
OpenFlags = 0
Name = "Chan. 17_1"
SerNr = 16256044
Color = 16777215
IsHidden = FALSE

[ch2]
device = "GSV-8"
ComNr = 17
Input = 2
BaudRate = 115200
OpenFlags = 0
Name = "Chan. 17_2"
SerNr = 16256044
Color = 16711680
IsHidden = FALSE

Wie man z.B. im Abschnitt [ch1] mit ComNr = 17 sieht, hat dieser GSV-8 auf dem alten PC die 
COMport-Nummer 17. Um die Session Datei auf den neuen PC zu portieren, ändert man alle Werte 
von ComNr (z.B. ComNr = 5) in allen Abschnitten, die zu diesem Geräteexemplar gehören. Gleiche 
Geräteexemplare haben gleiche Seriennummern, d.h. die Einträge SerNr haben den selben Wert.

Beim GSV1A8/16-USB entspricht die ComNr einem Eintrag DevNo = <no>, wobei die Nummer vom 
Treiber zugeordnet wird. In der Auswahlliste des Add Channel Dialogs wird sie aufgelistet.

Schützen der Geräteeinstellungen vor Veränderung

Bei den Modellen GSV-2, GSV-3, GSV-6 und GSV-8 kann man die Geräteeinstellungen per 
Hardware-Schreibschutz vor unbefugten oder versehentlichen Änderungen schützen. Wenn 

der Schreibschutz gesetzt ist, wird der Versuch, 
Einstellungen im Gerät zu verändern, abgewiesen, 
beim GSV-6 und GSV-8 erscheint dann eine 
Fehlermeldung.
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Um den Schreibschutz zu setzen, klickt man in der Menüleiste auf Device -> Advanced 
Device Settings... klickt und wählt dann die Karteikarte Administration:

Unter Inhibit parameter changing kann man mit Wahl von Device is write-protected den 
Schreibschutz setzen und ihn mit Writes are allowed wieder aufheben.

Dabei öffnet sich ggf. ein Unterdialog zur Passworteingabe. Das einzugebende Passwort ist 
abhängig vom Modell, beim GSV-6 und GSV-8 ist es im Passwortdialog schon vorab 
ausgewählt, so dass man nur mit OK bestätigen muss:

• GSV-2 und GSV-3: Unveränderliches Passwort: berlin

• GSV-6: Unveränderliches Gerätepasswort: USC1

• GSV-8: Veränderbares Gerätepasswort, Default: Beln5

Wenn der Schreibschutz nicht gesetzt, das Ändern von Einstellungen also erlaubt ist, 
leuchtet die Soft-LED Connected Interface has write-access hellgrün. Wenn sie nicht leuchtet,
d.h. dunkelgrün ist, kann das neben dem gesetzten Schreibschutz auch eine andere Ursache
haben: Bei Geräten mit mehreren Interfaces (GSV-8 und GSV-2 CANopen) kann das 
Kommunikationsinterface, mit dem das Gerät geöffnet wurde, kein Schreibrecht haben, weil 
das andere Interface Schreibrecht hat. Hierbei gilt: Bei den Feldbussystemen CANopen und 
EtherCAT hat dieses i.d.R. stets Schreibrecht, wenn es an und sich nicht im STOP-state 
befindet.
Bei den seriellen Interfaces USB / UART / RS422 / RS232 hat dasjenige Interface 
Schreibrecht, mit dem das Gerät zuerst mit einem Anwendungsprogramm wie GSVmulti 
geöffnet wurde.

Beobachten und Auswerten von Live-Daten zur Messlaufzeit

Die Messdaten können während der Messung auf verschiedene Weise beobachtet werden:

Numerisch: Als Großanzeige in der Karteikarte Value Display, s. S.11. Hier werden die 
Messwerte stets aktualisiert, auch dann, wenn Start Recording (Recorder Yt) noch 
nicht geklickt wurde. Weitere numerische Anzeigen sind das Value display im  
Recorder Yt und im Recorder XY und die Einzelwertanzeige in Configuration. 
Grundsätzlich werden numerischen Anzeigen alle 0,2 s aktualisiert (d.h. 5x pro Sekunde) oder
seltener, wenn seltener neue Messdaten vorliegen. Letzteres hängt von der Messdatenrate 
(Hardwareeinstellung), vom Software-Erfassungsintervall und ggf. vom Value display-Typ ab, 
s.u.

Grafisch: In der Karteikarte Graph Display stehen einzelne Graphen für jeden 
Messkanal zur Verfügung, jedoch nur für die ersten 16 Kanäle, s. S. 11. Diese Graphen
stellen die Messwerte im zeitlichen Verlauf dar. Die Skalierung der Y-Achse kann für 
jeden einzelnen Grafen geändert werden, ebenso der Autoscale Zustand (s.u.). Die 
zeitliche Breite entspricht der des Recorder Yt unter Time Visible. Auch im Graph 
Display werden die Messwerte stets aktualisiert, auch dann, wenn Start Recording 
(Recorder Yt) noch nicht geklickt wurde. 

5 Der GSV-8 ermöglicht zwar das Ändern des Gerätepasswortes, es wird aber von GSVmulti z.Zt. nicht 
unterstützt, daher ist es unwahrscheinlich, dass das Gerätepasswort anders lautet. Ist dies aber doch der 
Fall, darf es nicht vergessen werden, denn andernfalls müsste der GSV-8 zur Reparatur beim Hersteller 
eingesendet werden.
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Im Recorder Yt werden alle Kanäle in einem Graphen im zeitlichen Verlauf dargestellt, 
nachdem die Messung mit Start Recording begonnen wurde, s. S. 9

Im Recorder XY werden einer oder mehrere Kanäle über einem anderen dargestellt, 
d.h. nicht im zeitlichen Verlauf, s. S. 56.

Mit dem Button Add Graph Window können bis zu sechs zusätzliche Fenster geöffnet 
werden, die Live-Daten anzeigen, wahlweise als Yt- oder XY-Diagramm oder als FFT-
Spektrum, s.S. 18. Die Graph Window Fenster werden mit Namen, Position, Typ etc. 
auch in der Session-Datei gespeichert, s.S. 14. Man kann sie mit Menüleiste  → View 

 Sort Graph Windows→  gleichmäßig auf dem Bildschirm verteilen lassen.

Bei jeder grafischen Anzeige kann die Skalierung der Achsen automatisch 
erfolgen, wenn die Autoscale Funktion aktiviert ist. Das kann mit dem rechte-
Maustasten Kontextmenü geändert werden, indem man mit der rechten 
Maustaste in den Graphen klickt.

Mit Autoscale X wird im Recorder Yt der gesamte Verlauf der Messung ab dem
Startzeitpunkt im Graphen dargestellt. Der Startzeitpunkt bleibt dann am linken
Rand der (horizontalen) Zeitachse konstant. Hierbei ist jedoch folgendes zu 

beachten:

• Die Gesamtzeit, mit der dies möglich ist, ist limitiert. Sobald diese überschritten 
wurde, läuft auch die Zeit am linken Skalenendwert der Zeit weiter und Messwerte, 
die älter sind, gingen verloren. Diese Zeit beträgt mindestens etwa 7 Minuten. Sie 
kann mit GSVmulti PRO ab Version 2.01 ggf. vergrößert werden, s. S. 31.

• Bei hoher Messdatenrate (und/oder hoher Systemauslastung durch andere Programme) 
benötigt GSVmulti relativ viel Arbeitsspeicher und die Verarbeitung wird dadurch 
langsamer. Das hat zur Folge, dass die Gesamtzeit bei Autoscale X oft größer wird6, 
aber es kann passieren, dass das Programm dann nur noch sehr träge reagiert.

Mit Autoscale Y werden die Skalenendwerte der Y-Achse den sichtbaren Messwerten 
angepasst. Wenn gerade kein Nutzsignal, sondern nur Rauschen vorliegt, kann man zu 
falschen Schlüssen hinsichtlich der Rauschamplitude kommen, weil diese optisch 
vergrößert dargestellt wird.

Es kann praktisch sein, die Autoscale Y Funktion bei einer Testmessung zu verwenden und 
die Sensoren auf einen Bereich auszulenken, in dem man messen will und dann diesen 
Bereich etwas vergrößert als Skalenendwerte festzulegen:

Bei jeder grafischen Anzeige kann die Skalierung der Messwertachse (meist die 
Y-Achse) geändert werden, sofern diese nicht per Autoscale automatisch gesetzt 
wird. Diese Achsenskalierung betrifft nur die Sichtbarkeit des Grafen, sie hat keine
Wirkung auf die Skalierung der Messwerte durch den Messverstärker.

Man klickt mit der linken Maustaste auf einen der beiden Skalenendwerte, gibt 
den neuen Wert ein und schließt die Eingabe mit der Enter-Taste ab. Sie wird beim nächsten 
Programmstart wieder hergestellt.

6 Der Grund ist, dass das Yt Signaldiagramm bis zu 5120 Datenpakete fassen kann (v. 2.01) und bei hohen 
Messdatenraten werden die einzelnen Pakete größer. Je langsamer das Programm wird, desto größer 
werden sie, d.h. die Pakete enthalten immer mehr Messwerte.
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Numerische Anzeige im Recorder Yt und XY

Im Recorder Yt und Recorder XY werden die Messwerte aller Kanäle neben der grafischen 
Ansicht auch als Zahlen dargestellt. Die Darstellungsart ist dabei mit dem Auswahlmenü 
Display konfigurierbar und es kann aus folgenden Möglichkeiten gewählt werden:

• Actual Val: Aktueller Messwert, wie er ist

• Maximum: Maximalwert der aktuellen Messung. 

• Minimum: Minimalwert der aktuellen Messung.

• MAX(abs): Maximalwert des Betrages der aktuellen Messung, dadurch werden 
negative Minima mitberücksichtigt. 

• SNR [dB]: Standardabweichung, bezogen auf den Messbereich in dB, s. S. 18

• Resol. Parts pp: Spitzenwertrauschen bezogen auf den Messbereich in dB, s. S. 18ff.

• Max-Min: Spanne zwischen Maximal- und Minimalwert, s. S. 18ff. 

• Mean: Mittelwert, in der Ausgangskonfiguration über 100 Werte gemittelt und 
dezimiert. Alternativ kann die Zeit, über die gemittelt werden soll, unter Menüleiste-
>Options->Single Value Display -> Mean konfiguriert werden. Dieses Intervall bestimmt
auch die Aktualisierungsrate des Mittelwertes (es ist also kein gleitender Mittelwert).

• Integral: Der Messwert wird integriert, gemäß den Einstellungen unter Options (s.u.)

• RMS/StDev: Standardabweichung, s. S. 18ff.

Alle diese Werte werden beim Starten der Messung (Start Measuring), beim Nullsetzen und 
bei Änderung des Typs zurückgesetzt. In der Anzeige erscheint dann ggf. kurz Wait...

Die Ermittlung der Ergebnisse erfolgt bei SNR [dB], Resol. Parts pp, Max-Min und RMS/StDev
über  100 Werte  oder  über  eine  Sekunde,  wenn die  Messdatenrate  größer  als  100/s  ist.
Dieses Intervall bestimmt also auch die Aktualisierungsrate der Werteanzeige.

Die Anzeige Integral muss ausnahmsweise vor Start der Messung ausgewählt werden. Sie 
kann u.a. hinsichtlich der Integralgrenzen unter Menüleiste -> Options -> Single value Display 
konfiguriert werden. Man wählt Configure Value Type = Integral.

Mit Starting Type kann festgelegt werden, welches Kriterium für 
die linke Integralgrenze gelten soll:

• None: Consecutive Intervals bedeutet, dass nach 
Erreichen der rechten Integralgrenze Interval End 
automatisch ein neues Integral gebildet wird. Um das 
unbestimmte, immer weiter laufende Integral zu bilden, 
kombiniert man diese Einstellung mit Interval End = 
Infinite.

• Above Threshold: Bei Überschreiten der Starting 
Threshold wird ein neues Integral gebildet (Y-Bedingung 

der linken Integralgrenze).

• Below Threshold: Bei Unterschreiten der Starting Threshold wird ein neues Integral gebildet 
(Y-Bedingung der linken Integralgrenze).

Mit Interval End / Acquisition Type kann das Kriterium für die rechte Integralgrenze festgelegt 
werden:
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• Infinite: Die Integralberechnung läuft für die ganze Messung weiter (unbestimmtes Integral)

• Above Threshold: Bei Überschreiten der Interval End Threshold wird das Integral beendet (Y-
Bedingung der rechten Integralgrenze).

• Below Threshold: Bei Unterschreiten der Interval End Threshold wird das Integral beendet (Y-
Bedingung der rechten Integralgrenze).

• Number of values: Das Integral wird über die in Number of Values festgelegte Anzahl von 
Messwerten berechnet (Zeitbedingung der rechten Integralgrenze: Zeit= Anzahl / 
Messdatenrate).

Mit Processing kann  festgelegt werden, ob nur ein Integral gebildet werden soll (First Event only) und
alle folgenden Startbedingungen ignoriert werden, oder mehrere (All Events), so dass nach Erreichen 
der rechten Integralgrenze wieder auf Erfüllung des Startkriteriums für die linke Integralgrenze 
gewartet wird. Nach Beendigung eines Integrals wird der letzte Ergebniswert bei beiden 
Einstellungen im Single Value Display festgehalten, so dass er leicht abzulesen ist. Beim 
unbestimmten Integral (s.o.) hat diese Einstellung keine Wirkung. Mit Interpolate wird zwischen zwei 
aufeinanderfolgenden Eingangswerten ein zusätzlicher Eingangswert erzeugt (interpoliert), was bei 
manchen Anwendungen zu genauerem Ergebnis führen kann.

Die angezeigten Werte im Single Value Display können zur Messlaufzeit in die 
Zwischenablage kopiert oder per Tastendruck direkt in andere Programme eingefügt 
werden. Dazu konfiguriert man Menüleiste -> Options -> Copy & Paste -> Value Type to Copy/
Paste zu As Shown in Single value Display, s. S. 78.

Das Speicherverhalten des Single Value Display Typs kann unter Menüleiste->Options -
>Preferences konfiguriert werden. Im Ausgangszustand wird dieser nicht gespeichert und 
bei Programmstart auf Actual Val gesetzt. Wenn die Checkbox Save and restore Single Value
Display gesetzt ist, wird der eingestellte Typ beim nächsten Programmstart wieder 
hergestellt.

Konfigurieren der Zeitdauer des Erfassungsintervalls

Die Zeitdauer des Erfassungsintervalls ist die Zeit, die die Software wartet und Messwerte 
sammelt, bis sie diese anzeigt, es ist also zugleich das Aktualisierungsintervall. Nach Ablauf 
eines Intervalls wird ein Datenpaket zur Verarbeitung und zur grafischen Anzeige 
weitergegeben, seine zeitliche Länge bestimmt also die Paketgröße. Diese wiederum hängt 
mit der Speichertiefe des Graphen im Recorder Yt zusammen. Sie ist relevant, wenn man 
Autoscale X verwendet (s.S. 28ff.) oder wenn man mit Configure Recording -> Save Memory 
Data die im Yt-Graphen gespeicherten Werte in eine Messdatendatei kopieren möchte (s. 
S.62). Die Speichertiefe ist im Recorder Yt auf 5120 Pakete festgelegt, in den Grafen der 

Karteikarte Graph Display sind es jeweils
768 Pakete. Mit GSVmulti PRO ab v. 2.01
ist es u.U. möglich, dieses Intervall zu 
ändern, unter Menüleiste -> Options -> 
Preferences -> Measured data 
acquisition Interval. Diese Einstellung gilt
nur bei Verwendung nur eines 
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Messverstärkers oder mehrerer, die alle per Master-Slave miteinander synchronisiert sind. 
Sie gilt auch nicht für den GSV1A8/16.7

Im Auslieferungszustand und bei der Standardvariante wird das Erfassungsintervall 
automatisch ermittelt, dann ist Set Automatically gewählt und das Erfassungsintervall 
beträgt zwischen 0,1 s und 0,2 s, d.h. es wird zwischen 5x und 10x pro Sekunde aktualisiert.

Wenn Set Automatically nicht gesetzt ist, kann man unter Data Acquisition Interval das 
Erfassungsintervall festlegen oder es durch Eingabe der zeitlichen Speichertiefe des 
Recorders Yt in Recorder Yt time length (in Stunden) berechnen lassen.

Wenn man das Erfassungsintervall groß wählt, kann das Programm bei hoher 
Messdatenrate und vielen Kanälen langsam und träge werden. Wenn das Produkt

Erfassungsintervall x Messdatenrate² x Kanalanzahl 

größer als 20 Millionen ist, wird beim Start der Messung eine Warnung ausgegeben.

Ungeachtet der Einstellung dieses Erfassungsintervalls ist das Anzeigeintervall bei 
numerischen Anzeigen stets 0,25 s, d.h. 4 mal pro Sekunde wird eine neue Zahl angezeigt. 
Ist die Messdatenrate größer, wird per Mittelwertbildung auf diese 4/s dezimiert, ist sie 
niedriger, entspricht das Anzeigeintervall der Messdatenperiode.

Nachkommastellen numerischer Messwertanzeigen

Grundsätzlich hängt die Anzahl der Nachkommastellen von der Anzeigenormierung User 
Scaling und der maximalen Stellenanzahl ab. Letztere ist konfigurierbar und beträgt im 
Auslieferungszustand 6 Dezimalstellen. Wenn die Anzahl der Nachkommastellen die 
numerische Auflösung der Messdaten vom Messverstärker übersteigt, werden 
niederwertigere Nachkommastellen auf 0 gesetzt. Das kann beim GSV-2 und GSV-3 
beispielsweise der Fall sein, wenn die ASCII-Messwertausgabe aktiviert und 
dementsprechend konfiguriert ist,  s.S. 110. Bei 16-Bit Messverstärkern wie GSV-3, GSV-4 
und GSV-6 (Version 1.x) kann das auch bei binärem Messdatenformat zutreffend sein. Das 
natürliche Maximum signifikanter Dezimalstellen ist bei 16-Bit Geräten 5 Stellen, bei 24-Bit 
Geräten (GSV-2, GSV-8 und  GSV-6 v.2.x) sind es 8 Stellen.

Die Anzahl maximal angezeigter Dezimalstellen kann unter Menüleiste -> Options -> 
Preferences -> Measured data numeric display konfiguriert werden; der Wertebereich ist 4 bis
8.

Die Anzahl der Nachkommastellen ergibt sich daraus i.d.R. folgendermaßen:

Anzahl der Nachkommastellen =  Dezimalstellenanzahl - Aufrunden(log10(User Scaling))

Beispiele:  Dezimalstellenanzahl=5, User Scaling = 3,5: 4 Nachkommastellen

Dezimalstellenanzahl=5, User Scaling = 10.000: Eine Nachkommastelle

Dezimalstellenanzahl=4, User Scaling = 150.000: Keine Nachkommastelle

Dezimalstellenanzahl=4, User Scaling = 2: 3 Nachkommastellen

Dezimalstellenanzahl=4, User Scaling = 1: 4 Nachkommastellen

7 Diese beiden Einschränkungen werden bei Programmversionen > 2.01 eventuell aufgehoben sein; die 
Revisionshistorie wird darüber Auskunft geben.
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Aufnahme von Messdaten und nachträgliche Auswertung

GSVmulti stellt umfangreiche Möglichkeiten zum Speichern von Messdaten zur Verfügung. 
Die Konfiguration der Datenaufzeichnung ist ab S. 58 beschrieben und die Auswertung mit 
dem File Monitor ab S. 67. Es können u.a. Messdaten in CSV- oder Excel-Dateien konvertiert 
werden, die Aufzeichnung kann u.U. automatisiert gestartet und gestoppt werden u.v.m.

Es ist sogar möglich, während einer Datenaufnahme (d.h. wenn Start Recording aktiv ist) 
gleichzeitig ein Vorab-Ergebnis der *.tdms Messdatendatei mit dem File Monitor zu 
betrachten. Man sieht dann den zeitlichen Dateianfang ohne den Teil, in den aktuell gerade 
geschrieben wird. Allerdings können so keine Notizen (Annotations) gemäß der 
Beschreibung auf S. 88 gesetzt oder verändert werden, weil die Datei dann nicht durch den 
File Monitor gespeichert werden darf. Notizen werden während der Messlaufzeit gesetzt wie
auf S. 86 beschrieben.

Konfiguration von Datenlogger-Geräten

Die Messverstärkermodelle GSV-6BT und GSV-2MSD-DI bieten die Möglichkeit, Messdaten 
im Gerät auf einer SD-Speicherkarte aufzuzeichnen, d.h. Messwerte können PC-unabhängig 
gespeichert werden. Diese Funktionen sind in den Bedienungsanleitungen beschrieben 
(beim GSV-6BT eine gesonderte). Die geloggten Messdatendateien liegen in einem lesbaren 
Textformat vor, können aber auch mit dem File Monitor geöffnet werden, s. S. 67, wobei sie 
in das tdms-Dateiformat konvertiert werden. Bei beiden Messverstärkermodellen können die
Messdatendateien von der SD Karte umkopiert werden, ohne dass diese aus dem Gerät 
genommen werden muss, s.S. 37. Beim GSV-6BT ist es oft zweckmäßig, dafür zu sorgen, 
dass die Messapplikation zur Aufzeichnung nach Schließen der Kommunikationsverbindung
ab bleibt, was ab S. 113 beschrieben wird.

Zunächst ist es wichtig, dass die eingebaute Echtzeituhr richtig gestellt ist. Nach einem 
Wechsel oder Leerwerden der Batterie oder nach langer Zeit kann die Uhr verstellt sein. Zum
Ablesen der Uhr und zum Stellen klickt man in der Menüleiste auf Device -> Advanced 
Settings und wählt die Karteikarte Administration:

Mit Klick auf Sync wird die Uhr so genau wie möglich auf die Uhrzeit 
des PCs gestellt. Vorher kann man beim GSV-6BT angeben, ob man 
die Uhr auf die lokale Zeitzone stellen möchte (Set local time) oder 
zur UTC Weltzeit (Set UTC). In der Ansicht wird die Uhrzeit alle 3 
Sekunden aus dem Gerät ausgelesen.

Um die Logger-Funktion zu konfigurieren, wählt man bei mehreren geöffneten 
Messverstärken zunächst mit Actual Channel einen Kanal aus, der zu dem Gerät gehört, das 
konfiguriert werden soll. Dann klickt man in der Menüleiste auf Device und wählt Advanced 
Settings. Darin die Karteikarte Administration auswählen und auf Settings unter Measuring 
values Logger klicken.
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Hier ist der Dialog bei einem GSV-6BT 
mit eingelegter SD-Karte abgebildet. 
Die Radio-Buttons unter Data 
Recording haben folgende Bedeutung:

• Disabled: Die Aufzeichnung ist 
abgeschaltet

• Log permanently (if device on): 
Die Messdaten werden ständig 
aufgezeichnet, solange das 
Gerät an und eine SD-Karte 
eingelegt ist.

• Single Log by Command (nur 
GSV-6BT): Eine Messwertzeile 
wird durch ein 
Gerätekommando, gegeben 

per Software, aufgezeichnet. Das kann dann z.B. durch Klick auf den Button Log One 
Row geschehen.

• Single log by OK Key (nur GSV-2 MSD-DI): Eine Messwertzeile wird durch Druck auf 
die OK Taste geschrieben.

• Single Log periodically (nur GSV-6BT): Der langsame Aufzeichnungsmodus wird 
aktiviert. Das Zeitintervall zwischen zwei Messwertzeilen ist von 2s bis zu mehreren 
Stunden unter Logging Period konfigurierbar. Da der GSV-6 hier zwischenzeitlich in 
den Standby-Zustand versetzt wird, ist dieser Modus insbesondere bei Perioden ab 
einer Minute stromsparend, so dass die Batterie lange hält.

• Log while Trigger Input = active (nur GSV-6BT): Es wird aufgezeichnet, wenn der 
TRIGGER Digitaleingang einen aktiven Pegel hat und der GSV-6 an ist (grüne LED 
leuchtet). Dazu muss ein Digitaleingang dementsprechend konfiguriert sein, s. S.119

Die Einstellungen unter Logging Period betreffen das Aufzeichnungsintervall und sie gelten 
nur für den GSV-6BT. Ihr Erscheinungsbild und die Bedeutung hängen vom Data Recording 
Modus ab.

Mit Data Recording =  Log permanently und Log while Trigger Input = active bedeuten sie 
folgendes:

• Multiply TX freq by: Hiermit kann die Aufzeichnungsrate größer als die Messdatenrate,
die via Bluetooth übertragen wird, gewählt werden. Das ist nützlich, wenn man eine 
hohe Aufzeichnungsrate auf der SD-Karte wünscht und zugleich 
Verbindungsprobleme mit Bluetooth vermeiden möchte, die bei hohen 
Datenübertragungsraten auftreten können. Unter Factor kann der Faktor zwischen 
SD-Aufzeichnungsrate und Übertragungsrate eingegeben werden oder man gibt 
direkt die gewünschte Aufzeichnungsrate unter Logging Frequency ein. Der 
Zusammenhang ist:  Logging Frequency =  Übertragungsrate x Faktor.

• Divide frequency by: Hiermit kann die Aufzeichnungsrate kleiner als die 
Messdatenrate, die via Bluetooth übertragen wird, gewählt werden. Unter Decimator 
kann der Divisor zwischen Übertragungsrate und SD-Aufzeichnungsrate eingegeben 
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werden oder man gibt direkt die gewünschte Aufzeichnungsrate unter Logging 
Frequency ein. Der Zusammenhang ist:  Logging Frequency =  Übertragungsrate / 
Decimator.

Mit Data Recording =  Single Log periodically bedeuten sie folgendes:

• 3..59 Seconds: Das Messdaten-Aufzeichnungsintervall liegt im Bereich zwischen 3 
und 59 Sekunden. Es kann unter Seconds eingegeben werden. Diese Einstellung ist 
nur geringfügig stromsparend, weil der Messverstärker die ganze Zeit über an bleibt.

• Minutes / Hours / Days:  Das Messdaten-Aufzeichnungsintervall liegt im Bereich 
zwischen einer Minute und mehreren Tagen. Die Anzahl Tage wird unter Days 
eingetragen (darf =0 sein), die Stunden unter Hours (0 bis 23) und die Minuten unter 
Minutes (1 bis 59). Da der GSV-6 hier zwischenzeitlich in den Standby-Zustand 
versetzt wird, ist dieser Modus besonders stromsparend, so dass die Batterie lange 
hält, je größer das Aufzeichnungsintervall, desto länger.

Unter File Format kann die Formatierung der Messdatendateien beeinflusst werden. 
Beispiele für Dateiinhalte unten.

• Print File Header: Ein Header wird am Anfang jeder Datei geschrieben. Er enthält 
Informationen über die Bedeutung der Spalten, die Kanalanzahl, Normierung, Modi, 
ggf. Einheit und Aufzeichnungsrate. Diese Checkbox ist standardmäßig gesetzt. Den 
Header wegzulassen, ist nicht sehr empfehlenswert, weil der Import der Textdatei mit
dem File Monitor dann u.U. kein gutes Ergebnis hat.

• Print Unit: Ist diese Checkbox gesetzt, schreibt der GSV-6BT die Einheiten aller 
konfigurierten Kanäle in eine Zeile im Header; der GSV-2MSD-DI schreibt sie hinter 
jeden Messwert in eine Spalte (beim GSV-6BT z.Zt. nicht deaktivierbar).

• Log Max-, Min- and Mean (nur GSV-2MSD-DI): Wenn diese Checkbox gesetzt ist, 
ermittelt der GSV-2 zusätzlich zum aktuellen Messwert den Maximal-, Minimal- und 
der Mittelwert, so dass 4 Messwertspalten geschrieben werden. Beispiel GSV-2 MSD-
DI, Sprache = Deutsch:
Normierung: +100.000 Datenrate: 10.000 Hz                                        ← Print File Header aktiviert
Datum    Zeit          Wert Max Min MitW Einheit      ← Max-, Min- and Mean aktiviert
23/11/23,19:43:38.25886 +5.913 +5.914 +5.913 +5.914 g  ← Print Unit aktiviert

Unter Time Stamp können die Zeitstempelspalten formatiert werden. Sie werden in der 
Messdatendatei in die erste Spalte geschrieben.

• None (nur GSV-2MSD-DI): Ganz ohne Zeit und Datum. Diese Einstellung ist nicht 
empfehlenswert, weil weil der Import der Textdatei mit dem File Monitor dann u.U. 
kein gutes Ergebnis hat hinsichtlich der Zeitstempel der tdms Datei. Das ist 
insbesondere der Fall, wenn zugleich auch Print File Header deaktiviert ist.

• Time only: Der Zeitstempel enthält nur die Uhrzeit mit Sekundenbruchteilen, kein 
Datum. Beispiel GSV-2 MSD-DI, Sprache = Deutsch:
Normierung: +100.000 Datenrate: 10.000 Hz  ← Print File Header aktiviert
Zeit          Wert Einheit                ← Print Unit aktiviert
19:20:13.61203 +6.328 g

• Date only (nur GSV-2MSD-DI): Der Zeitstempel enthält nur das Datum, keine Uhrzeit. 
Auch diese Einstellung ist u.U. nicht empfehlenswert, siehe None. Beispiel GSV-2 MSD-
DI, Sprache = Deutsch:
Normierung: +100.000 Datenrate: 10.000 Hz ← Print File Header aktiviert
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Datum    Wert Einheit                              ← Print Unit aktiviert
23/11/23 +6.256 g

• Both Date & Time: Der Zeitstempel enthält sowohl das Datum als auch die Uhrzeit. 
Beispiel GSV-2 MSD-DI, Sprache = Deutsch:
Normierung: +100.000 Datenrate: 10.000 Hz← Print File Header aktiviert
Datum    Zeit          Wert Einheit              ← Print Unit aktiviert
23/11/23,19:21:59.04858 +6.166 g

Unter File Size kann festgelegt werden, wie groß die Datei werden soll. Das ist sinnvoll, damit
die Dateien nicht zu groß werden, was insbesondere bei permanenter Datenaufzeichnung 
relevant ist. Die Eingabe erfolgt dabei als Angabe der maximalen Zeilenanzahl unter Max. 
Number of Rows oder als Angabe der maximalen Zeit, über die eine Datei Messdaten 
enthält, wobei die Eingabe unter Hour (Stunden), Min (Minuten) und Sec (Sekunden) erfolgt. 
Die Zeit- und Zeilenangabe wird bei Eingabe ineinander umgerechnet, anhand der aktuell 
eingestellten Messdatenrate. Im Gerät wird nur die Zeilenanzahl gespeichert. Ist diese bei 
der Aufzeichnung erreicht, wird eine neue Datei angelegt.
Hinweis: Die minimale zeitliche Länge sollte eine Sekunde niemals unterschreiten, weil 
andernfalls keine individuell unterschiedlichen Dateinamen gebildet werden können, d.h. die 
Mindestzeilenanzahl ist gleich der Messdatenrate.
Der Grund dafür ist, dass die Dateinamen aus Datum und Uhrzeit bestehen, einschließlich 
der Sekunde.

Beim GSV-2MSD-DI kann unter New Directory angegeben werden, ob für die 
Messdatendateien jeden Tag ein neues Verzeichnis angelegt werden soll (Every Day) oder 
jeden Monat (Every Month), siehe Bedienungsanleitung.

Wenn beim GSV-6BT Data Recording auf Single Log by Command gestellt ist, kann unter Single Log 
File Creation angegeben werden, ob die Messwertzeilen immer an die zuletzt geschriebene Datei 
angehängt werden sollen (Append to previous) oder ob jeden Tag eine neue Datei erstellt werden soll 
(New File Every Day), in die die Messwertzeilen geschrieben werden sollen. Wenn  Data Recording auf
Log while Trigger Input = active gestellt ist, kann zwischen an vorherigen Datei anhängen (Append to 
previous) und New File Every Trigger Event gewählt werden. Bei letzterem wird jedes mal, wenn durch
aktivierten Trigger-Pegel eine Aufzeichnung gestartet wird, eine neue Datei erstellt und das hat den 
Vorteil, dass die Zeitstempel auch beim Import der Datei in eine tdms Datei korrekt sein werden. Bei 
angehängten Daten stimmen die Zeitstempel nicht in der konvertierten tdms Datei.

Im unteren Bereich des Fensters sind einige Soft-LEDs und Schaltflächen, die beim GSV-6BT
sofort im Gerät ausgeführt werden und folgende Bedeutung haben:

• Card Inserted: Wenn diese Soft-LED leuchtet, ist eine SD-Karte eingelegt und 
eingebunden (gemounted).

• Logging File Open: Wenn diese Soft-LED leuchtet, ist eine Datei zum Schreiben 
geöffnet. Achtung: Die SD-Karte darf dann nicht herausgenommen werden!

• Currently Logging: Es werden Daten aufgezeichnet.

• Open File: Bei Klick auf diese Schaltfläche wird eine Datei zum Schreiben geöffnet
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• Close File: Eine Datenaufzeichnung wird beendet und die Datei geschlossen

• Mount SD: Eine gerade eingelegte SD-Karte wird eingebunden. Hinweis: Wenn beim 
Einschalten des GSV-6BT eine SD-Karte eingelegt ist, bindet er diese automatisch ein.

• Eject SD: Die eingelegte SD-Karte wird deaktiviert, so dass sie anschließend 
herausgenommen werden kann

• Log One Row: Wenn der Data Recording Typ auf Single Log by Command gestellt ist, 
wird bei Klick auf diese Schaltfläche eine Messwertzeile geschrieben

• Start Logging: Wenn der Data Recording Typ auf Single Log Permanently gestellt ist, 
wird bei Klick auf diese Schaltfläche die Datenaufzeichnung gestartet

Beim GSV-2MSD-DI haben die Elemente im unteren Bereich folgende Bedeutung:

• Logging enabled: Diese Soft-LED leuchtet, wenn die Datenaufzeichnung aktiviert ist.

• Charge by USB Power, if possible: Wenn diese Checkbox aktiv ist, versucht das Gerät 
über die USB-Schnittstelle Strom zu beziehen. Wenn es eingeschaltet ist, reichen diese 
500mA nicht, um den eingebauten Akkumulator zu laden, im ausgeschalteten Zustand ist 
dies hingegen möglich. In diesem Zustand wirkt er an USB als Massenspeichergerät.

• MSD-DI Firmware Version: Version der Embedded-Software des (zweiten) Controllers für die 
Verwaltung von USB, SD-Karte, Datenaufzeichnung, Power-Management und Logger-Menü.

Zugreifen auf die aufgenommenen Messdaten der Datenlogger

Beim GSV-2MSD kann über das Benutzermenü der USB-Modus umgeschaltet werden, um 
ihn als Kartenleser verwenden zu können. Dazu kann das Gerät stattdessen auch 
ausgeschaltet werden; in beiden Fällen ist die Verwendung von GSVmulti nicht zugleich 
möglich. Im USB-Kartenleser-Betrieb wird auf die SD-Karte z.B. mit dem Windows-Explorer 
zugegriffen, siehe Bedienungsanleitung.

Für den GSV-6BT stellt 
GSVmulti einen Dateibrowser 
zum Umkopieren von Dateien 
zur Verfügung; er wird über 
Menüleiste -> File -> Device 
File Browser geöffnet oder  
Menüleiste -> Device -> 
Advanced Settings -> 
Administration -> File Browser.

Oben links wird neben Last file
logged der Pfad zur zuletzt 
aufgenommenen Datei 
genannt. Wenn rechts oben 
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unter Which file? Recently logged gewählt ist, so kann diese mit Klick auf Download File 
direkt heruntergeladen werden.

Wenn dort Selected File gewählt ist, sucht man in der Dateiansicht unter Directory / File 
Names das Verzeichnis aus; es wird aus M<Jahr>_Monat> gebildet. Durch Doppelklick 
darauf wird es aufgefaltet, wie hier für M2023_06 gezeigt. Nun kann man die Datei 
markieren. Fett gedruckte Einträge in der Dateiansicht sind Messdatenverzeichnisse und -
dateien, hierbei steht dann auch Yes unter Logger Item. Dann auf Download File klicken, das 
Zielverzeichnis auf dem PC wählen und der Download startet, angezeigt durch einen 
Fortschrittsbalken. Das Kopieren (Download) kann bei großen Dateien lange dauern. Die 
Dateigröße wird unter Size [kB] angezeigt und die Downloadzeit kann abgeschätzt werden: 
Zeit in Sekunden = Dateigröße [kB] x 0,12.

Wenn er fertig ist, wird gefragt, ob die heruntergeladene Textdatei in 
das tdms Format konvertiert werden soll. Wenn man das durch Yes 
tun lässt, kann die Datei mit dem File Monitor geöffnet werden. Nötig
ist es nicht, weil die Textdatei auch direkt mit dem File Monitor 
geöffnet werden kann.
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Weiterführende Funktionen
Hinweis: Die meisten der im folgenden dargestellten Konfigurationsmöglichkeiten werden 
auf dasjenige Gerät angewendet, zu dem der mit Actual Channel (Karteikarte Configuration) 
eingestellte Kanal gehört.

Einbinden von Mehrachsensensoren

Bei Verwendung von Sechsachsensensoren der Modellreihen K6D oder F6D oder 
Dreiachsensensoren der Modellreihe K3R muss einmalig eine Kalibriermatrix geladen 
werden.8 Sie befindet sich in den mit dem Sensor mitgelieferten Dateien. Bei den 
Messverstärkern GSV-6 und GSV-8 wird die Kalibriermatrix für Sechsachsensensoren in der 
Regel im Gerät gespeichert, weil diese die Berechnung selbst durchführen können 
(Ausnahmen und Einschränkungen: Siehe Tabelle unten). Andernfalls müssen die Dateien mit 
den Kalibrierdaten der Mehrachsensensoren auf dem PC gespeichert bleiben, denn 
GSVmulti benötigt diese zur Messlaufzeit, um die Kräfte und Drehmomente zu berechnen. 
Auch müssen in diesem Fall immer mindestens 6 Kanäle pro Sensor geöffnet sein.

Diese Dateien mit den Kalibrierdaten haben folgende Namenskonvention (bitte nicht umbenennen):
<Sensorseriennummer>.dat
<Sensorseriennummer>.matrix
Beide Dateien müssen sich in demselben Verzeichnis befinden.

Zunächst müssen alle benötigten Eingangskanäle geöffnet sein und bei allen muss der 
gleiche Eingangstyp (Input Type), also die gleiche Eingangsempfindlichkeit eingestellt sein. 
Ist das der Fall, klicken Sie auf Special Sensor, dann öffnet sich folgender Zwischendialog, 
den Sie so belassen und mit OK bestätigen:

8 Die Modellreihen K3A und K3D bnötigen keine Kalibriermatrix. F6D Sensoren mit einem e am Ende der 
Modellbezeichnung haben einen eingebauten GSV-6 Messverstärker und die Kalibriermatrix ist i.d.R. 
bereits aufgespielt.
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Dann erscheint der Dialog für Mehrachsensensoren:

Klicken Sie darin links oben auf Add Sensor, dann öffnet sich ein Unterfenster:
Klicken Sie darin auf Open File/Dir, um die Kalibrierdaten erstmalig zu
laden. Wählen Sie im sich dann öffnenden Dateiauswahlfenster die 
zum Sensor gehörende *.dat Datei aus.

Der Mehrachsensensordialog sieht dann bei einem Standard-
Sechsachsensensor so aus:

Bitte vergleichen Sie sicherheitshalber zunächst die Seriennummer auf dem Typenschild des
Sensors mit der unter Sensor Serial No angezeigten; sie müssen übereinstimmen.

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de

40 16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de



Wählen Sie nun zunächst den ersten Kanal der Eingangskomponente 1 aus, mit Component 
1. Wenn Ihr Messverstärker GSV-6 oder -8 die Berechnung selbst durchführen wird (die 
Checkbox Calculated by device ist dann aktiviert), werden die Komponenten 2 bis 6 
automatisch ausgewählt. Andernfalls, d.h. bei Software-berechneten Sensoren, müssen Sie 
alle Eingangskomponenten manuell auswählen. Der Dialog sieht nun so aus:

Wenn gewünscht, können die Ausgangskanäle der Berechnung mit Rename Channels 
automatisch umbenannt werden, so dass der Kanalname die physikalische Größe und 
Richtung bezeichnet. Um dann die Messung mit Sechsachsensensoren zu aktivieren und 
ggf. die Sensordaten im GSV-6 oder GSV-8 zu speichern, klicken Sie OK Enable this Sensor.
Wenn die Sechsachsendaten im Gerät gespeichert werden und dort schon Daten vorhanden
sind, werden Sie gefragt, ob Sie einen vorhandenen Datensatz überschreiben oder einen 
neuen erzeugen wollen. Bei Überschreiben können Sie ggf. den Speicherindex angeben:

GSV-6 und -8 können nämlich bis zu 11 solcher 
Sensordatensätze speichern. Anschließend werden Sie bei 
Speichern und Berechnen im Gerät nach dem Gerätepasswort 
gefragt. In der Regel ist dies nicht verstellt; Sie können also das 
vor-ausgewählte Passwort
mit OK bestätigen. Bei GSV-
8 lautet es "Beln"

Wenn das Aktivieren der
Sensorberechnung

geklappt hat, erhalten Sie eine Bestätigungsmeldung und
der Dialog schließt sich.
Die Statusmeldungen in den Karteikarten Configuration und
Recorder zeigen den aktivierten Mehrachsensensor:
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Nach dem Laden der Sechsachsendaten sollte ein Nullabgleich bei unbelastetem Sensor 
durchgeführt werden, und zwar mit Klick auf Set All Zero im Recorder Yt (s. S. 89).
Um die Mehrachsenberechnung wieder zu deaktivieren, öffnen Sie den Multi-axis Sensor 
Dialog wieder. Die grüne Soft-LED Enabled leuchtet nun. Sie können den Sensor jetzt mit 
Disable this Sensor deaktivieren.

Weitere Informationen zum Mehrachssensor-Dialog

Unter Sensor Mode sehen Sie den Sensortyp bzw. den Modus. Er hängt bei 
Sechsachsensensoren von der Art des Sensors und der gewählten Kalibrierdaten ab. Bei 
Dreiachsensensoren kann hier zwischen drei verschiedenen Berechnungsmodi umgestellt 
werden. Es gibt insgesamt folgende Typen, bzw. Modi:

Sensor Mode Sensor
Modelle

 Durch GSV-8
berechenbar

 Durch GSV-6
berechenbar

Matrix Bemerkungen

Six-axis K6D, F6D Ja Ja 6 x 6 Durch Sensordaten festgelegt

Six-axis,
2nd order

K6D, F6D Ja Nein  2 Matrizen
je 6 x 6

Durch Sensordaten festgelegt

Three-axis
Fz,Mx,My

K3R Nein9 Nein 9 3 x 4 Dreiachsenmodus auswählbar, 
hier Kraft, 2x Drehmoment

Three-axis
Fx,Fy,Fz

K3R Nein 9 Nein 9 3 x 4 Dreiachsenmodus auswählbar, 
hier 3 Kräfte

Three-axis
Fz,sx,sy

K3R Nein 9 Nein 9 3 x 4 Dreiachsenmodus auswählbar, 
hier Kraft, 2x Weg

Six-axis,
6x12 Matrix

K6D-225 Nein Nein 6 x 12 Durch Sensordaten festgelegt, 12 
Eingangskanäle notwendig

Hinweise zu den Sensor-Modi:

• Der Modus "Six-axis, 2nd order" entspricht der Matrix Plus Lösung. Hier wird auch die 
zweite, quadratische Matrix in einer zusätzlichen Karteikarte angezeigt. Bei 
Berechnung durch den GSV-8 ist hier die maximale Messdatenrate (Data Frequency) 
auf 2000/s begrenzt.

• Bei den durch Software berechneten Modi müssen alle Eingangskomponenten unter 
Channel assignment in der General Karteikarte einzeln ausgewählt werden. In der 
Regel sind das bei Mehrkanalgeräten die Eingangskanäle 1-6.

• Beim 6x12 Matrix Modus müssen zusätzlich die Komponenten 7 bis 12 gewählt 
werden, indem die Checkbox Compo 7 to 12 in Channel assignment aktiviert wird. 
Meistens sind dies die ersten 6 Eingangskanäle eines zweiten Messverstärkers. In 
diesem Fall wird eine "Master-Slave" Synchronisation der Messdatenübertragung 
beider Geräte empfohlen, für die allerdings Hardware Voraussetzungen bestehen, s. 
S. 14.

9 Von Hersteller ME können die Kalibrierdateien so verändert werden, dass die Berechnung durch GSV-6 
oder -8 doch möglich ist. Es werden dann allerdings die Kanäle 5 und 6 unbenutzbar.
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• Bei den Dreiachsen-Modi Three-axis Fx,Fy,Fz und Three-axis Fz,sx,sy muss rechts 
unter Distance offsets eine Hebelarmlänge eingegeben werden; dort sind dann die 
Eingabeelemente rot markiert.

• Beim Dreiachsensensor hat der Eingangskanal 4 als Ausgangskanal keine 
Bedeutung. Beim 6x12 Matrix Modus gilt dies für die Eingangskanäle 7 bis 12. Diese 
werden zwar als Eingangswerte für die Berechnung benötigt, ihnen ist jedoch keine 
physikalische Ausgangsgröße zugeordnet. Nach Rename Channels habe sie die 
Bezeichnung "dummy." Man kann diese Kanäle im Hauptfenster verstecken, so dass 
sie nicht mehr sichtbar sind, und zwar indem man im Hauptfenster in der Karteikarte 
Configuration diesen Kanal mit Actual Channel auswählt und dann per Menüleiste auf 
Channel -> Hide klickt.

• Bei den durch Software berechneten Sensoren/Modi ist es zweckmäßig, die gesamte
Konfiguration in einer Session Datei zu speichern. Dann muss o.g. Auswahlvorgang 
der Sechsachsendaten nicht erneut durchgeführt werden, sondern nach dem 
nächsten Programmstart kann man mit Open Session diese einfach wieder 
herstellen.

• Bei den durch Software berechneten Sensoren/Modi wird bei der Aufnahme von 
Messdaten (s. S. 9 und 58) eine zusätzliche TDMS Datei angelegt, die die Rohdaten 
enthält, d.h. die mV/V -Werte, die der Sensor direkt ausgibt. Die Dateinamen der 
Rohdaten haben die Form <Datum-Uhrzeit>RAW.tdms, d.h. dem Dateinamen der 
Datei mit den normalen physikalischen Messwerten wird RAW angehängt. Die 
Rohdaten können u.U. helfen, bei Problemen die Ursache zu ermitteln oder man kann 
nachträglich eine andere Matrix anwenden.

Ändern der Sensor-Konfiguration und Verwenden mehrerer Mehrachsen-Sensoren

• Wenn für den gleichen Sensor andere Kalibrierdaten geladen werden sollen oder in 
dem selben GSV-6/-8 weitere Kalibrierdaten gespeichert werden sollen, wird 
empfohlen, die Sechsachsenberechnung vorher mit Disable this sensor zu 
deaktivieren, falls sie aktiv ist. Wenn die Daten im Gerät gespeichert waren, bleiben 
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sie erhalten (es sei denn, sie werden durch neues Laden überschrieben durch 
dementsprechende Angabe im Store in Device Memory Dialog).

• Wenn andere, im Gerät gespeicherte Kalibrierdaten verwendet werden sollen, so geht 
man vor wie oben gezeigt (nachdem der 
aktuelle Sensor disabelt wurde), setzt aber im 
Select Sensor Zwischendialog die Checkbox 
Use sensor data stored in device und wählt 
dann den gewünschten Sensor anhand der 
Seriennummer und des Speicherplatzes mit 
Select Sensor aus. Die Eingangskomponenten 
werden dann automatisch zugeordnet, denn 

sie gehören zum Messverstärker und können nicht geändert werden.

• Im GSV-6 oder GSV-8 ist nur eines der gespeicherten Kalibrierdatenarrays aktiv, und 
zwar stets dasjenige, das zuletzt mit OK Enable this sensor aktiviert wurde. Die 
Nummer des aktiven Sensors ist beim GSV-8 auch Teil der Benutzereinstellungen 
User 2 bis User 6, so dass man auch mit Load Settings zwischen Sensordaten 
umschalten kann, wenn die Konfiguration zuvor mit Save Settings abgespeichert 
worden ist.

• Wenn bei einer Messung mehrere Mehrachsensensoren verwendet werden sollen, 
wiederholt man den o.g. Ladevorgang, ohne vorher Sensoren zu entfernen. Dazu 
müssen dementsprechend genug Eingangskanäle im Messsystem vorhanden sein. 
Im Multi-axis Sensor Dialog kann man mit Sensor displayed rechts oben denjenigen 
auswählen, der angezeigt werden soll. Die Anzahl aktiver Sensoren wird oben in 
Number of Sensors angezeigt. Mit der GSVmulti PRO Variante können bis zu 8 
Mehrachsensensoren verwendet werden, mit der Standardvariante bis zu 4.

Weitere Anzeige- und Bedienelemente im Multi-Axis Sensor Fenster

General: Distance Offset: Hier können Abstände eines Kraftangriffspunktes eingegeben 
werden, die bei der Berechnung der Drehmomente berücksichtigt werden. Die 
Kalibriermatrix ist vom Hersteller normalerweise so ermittelt, dass die Drehmomente am 
Sensorursprung gelten. Oft sind aber an der Messplattform noch Anbauten und man will die 
Momente an diesem Punkt messen. Die Richtungen der Distance offsets sind bis 
einschließlich Programmversion 2.00 denen des Sensor-Koordinatensystem 
entgegengesetzt; ab 2.01 entsprechen sie bei Software-berechnetem System den 
Koordinatenrichtungen des Sensors.
General: Maximum Value: Die Maximalwerte des Sensors. Innerhalb dieser Grenzen 
±Maximum gelten die Genauigkeitsspezifikationen des Sensors. Werden die Maximalwerte 
überschritten, wird dies durch die rote Sensor Overload Schaltfläche oben im Hauptfenster 
angezeigt. Diese kann dann geklickt werden, um weitere Detailinformationen über die 
Maximalwertüberschreitung zu erhalten.
Zero Signal: Grundverstimmungswerte bei Nulllast des Sensors zum Zeitpunkt der 
Kalibrierung des Sensors beim Hersteller. Mit ihrer Hilfe kann vorheriges Nullsetzen des 
Sensors (mit Set All Zero) durch Klicken auf den gelben Untare Button aufgehoben werden. 
Man sieht dann die aktuelle Verstimmung in absoluten Werten. Die Untare Funktion 
entspricht der des Druckes auf die CHK-Taste beim GSV-8, wenn die 
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Sechsachsenberechnung in Gerät aktiv ist; sie ist jedoch bleibend und nicht flüchtig wie der  
Tastendruck.
Matrix: Die Elemente / Koeffizienten der Kalibriermatrix.
Storing location: Speicherort der Kalibriermatrix. Wenn im Gerät  (Device...), wird auch der 
Speicherindex unter Index in memory angezeigt.
Enable Distance measuring for 6-axis sensor: Mit dem GSV-8 kann man statt der Kräfte Fx 
und Fy die Strecken Sx und Sy in Metern berechnen lassen, die den Abstand einer 
Krafteinleitung zu dem Sensorursprung angeben; d.h. es muss eine Kraft <>0 eingeleitet 
werden.

Messen mit Dehnungsmessstreifen

Dehnungsmessstreifen (DMS, strain gage) sind kleine Folien mit Metallgittern, die auf einen 
Körper geklebt werden, um dessen Oberflächendehnung oder -stauchung zu messen. Die 
Dehnung ist ein Verhältnismaß und wird in µm/m angegeben, diese (Pseudo-) Einheit ist 
gleichbedeutend mit Microstrain (µInch/Inch) u.a., allgemein: "Dehnung x 10-6"

Um den Dehnungsmessstreifen zu justieren, damit er richtig in µm/m misst, ist die Kenntnis 
des K-Faktors nötig, der angibt, wie stark sich der Widerstand bzw. die Ausgangsspannung 
verändert. Außerdem muss man die Brückenart kennen; Einzel-DMS sind stets 
Viertelbrücken und bedürfen einer Brückenergänzung, die entweder extern oder im 
Messverstärker gesetzt wird, siehe dessen Bedienungsanleitung. Bei Brücken mit 

Querkontraktion ist zusätzlich die Kenntnis der
Querkontraktionszahl des Materials nötig, auf 
das der DMS geklebt ist. Sie gibt das 
Verhältnis von Längs- zu Querdehnung an.

Zur Justage klicken Sie in der Menüleiste auf 
Sensor->Strain gage... oder auf User Scaling 
und wählen dann die kleine Karteikarte Strain 
gage.

Mit Bridge type wählt man die Brückenart aus:

Full (4): Vollbrücke mit allen 4 DMS in 
Längsrichtung. Keine 

Brückenergänzung nötig.

Half (2): Halbbrücke mit 2 DMS in Längsrichtung. Halbbrückenergänzung nötig.

Quarter (1): Einzel-DMS. Viertelbrückenergänzung nötig.

Half (1+µ): Halbbrücke mit einem DMS in Längs- und einem in Querrichtung. 
Halbbrückenergänzung nötig. Querkontraktionszahl Poisson's ratio muss angegeben 
werden.

Full (2+2µ): Vollbrücke mit 2 DMS in Längs- und zwei in Querrichtung. Keine 
Brückenergänzung nötig. Querkontraktionszahl Poisson's ratio muss angegeben 
werden.

Unter Gage factor wird der K-Faktor eingegeben und unter  Poisson's ratio ggf. die  
Querkontraktionszahl. Die Eingangsempfindlichkeit Input Range wird bei den meisten 
Messverstärkern gleich richtig angezeigt, außer beim GSV-3.
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Dann auf Calculate klicken und anschließend auf Store to Device. Die neue User Scaling wird 
gesetzt und die Einheit ist dann µm/m.

Spannungsmessung mit Rosetten-DMS

Bei Verwendung von Dreifach-Rosetten Dehnungsmessstreifen (DMS) kann GSVmulti so 
konfiguriert werden, dass es die Signale der DMS in mechanische Spannungen und Winkel 

der Hauptspannung umrechnet. Die mechanische Spannung 
ist ein Maß für die Beanspruchung eines Körpers (auf den der 
Rosetten-DMS geklebt ist) aufgrund seiner Belastung von 
außen.

Es werden Rosetten-DMS verwendet, die einen Winkel von 45° 
zueinander haben. Diese drei Einzel-DMS müssen 
hardwareseitig mit Viertelbrückenergänzungen zur Vollbrücke 

komplettiert werden und es werden mindestens drei Kanäle benötigt. Die Messverstärker 
GSV-6BT und GSV-8 erfüllen diese Anforderung und nach interner Modifikation auch der 
GSV-4. In der entsprechenden Bedienungsanleitung steht, wie man Viertelbrücken-DMS 
richtig anschließt.

Um diese Art der Spannungsmessung zu konfigurieren, klickt man in der Configuration 
Karteikarte auf Special Sensor, dann öffnet sich folgender Zwischendialog, in dem Calculate 
principal Stress gewählt wird:

Alternativ kann man in der  Menüleiste Sensor->Rosette Stress wählen.

Dann öffnet sich der Rosette Sensors Dialog. Darin auf Add Rosette klicken, um eine 
Spannungsmessung hinzuzufügen.
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Mit Channel assignment müssen dann die Kanäle ausgewählt werden, an denen die 
jeweiligen Eingangskomponenten (Component Ea, Eb, Ec), d.h. die Einzel-DMS a, b und c 
angeschlossen sind. Unter Elastic Modulus wird das Elastizitätsmodul (E-Modul) des 
Materials eingegeben, auf das die DMS geklebt sind, unter Poisson's ratio dessen 
Querkontraktionszahl. Im Bild oben sind beispielhaft typische Werte für Reinaluminium 
gezeigt. Unter Rosette Strain gauge neben Gage factor a, b und c werden die K-Faktoren der 
verwendeten DMS eingegeben; mit All same muss man das nur einmal tun, sofern alle drei 
gleich sind. Die Eingangsempfindlichkeit Input Sensitivity  des Messverstärkers wird bei den 
meisten GSV-Modellen automatisch richtig angezeigt. Zum Schluss auf OK klicken. Die 
Kanäle werden dann in Sigma 1 für die Hauptspannung, Sigma 2 für die Nebenspannung 
und Phi für den Winkel der Hauptspannungsrichtung zum DMS a unbenannt, auch die 
Einheiten werden in N/mm² bzw. ° umgestellt:

Bei Verwendung mehrerer Rosetten-DMS für mehrere Messstellen mechanischer Spannung 
wird diese Konfiguration für jede Rosette wiederholt. Den Kanalnamen werden dann _1, _2 
usw. angehängt. Die Kanalnamen dürfen anschließend auch manuell wieder verändert 
werden (s. S.6), die Einheiten jedoch nicht. Es empfiehlt sich, diese ganze Konfiguration mit 
Save Session zu speichern, damit sie beim nächsten Programmstart (s. S.56) leicht mit 
Open Session wieder hergestellt werden kann.

Umschalten zwischen Spannungs- und Dehnungsmessung

Bei aktivierter Spannungsmessung erscheint die Statusmeldung Rosette Sensor: Stress 
enabled. Man kann, ohne die Konfigurationsdaten der Spannungsmessung zu verlieren, 
zwischenzeitlich auf Dehnungsmessung umschalten. Dazu klickt man wieder auf Special 
Sensor und wählt dann Display measured strain
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Alternativ kann man auch in der Menüleiste auf Sensor->Rosette Strain klicken. Die 
Einheiten, Kanalnamen und die Statusmeldung verändern sich:

Um wieder zur Spannungsmessung zurückzukehren, wählt man im Select Special Sensor 
Zwischendialog Calculate principal stress oder Menüleiste->Sensor->Rosette Stress und 
bestätigt den Rosettendialog mit OK.

Hinweis zur Speichern der Rosetten-Konfiguration: Die Kanalnamen werden in der Session-
Datei gespeichert; die Daten zur Spannungsmessung jedoch nur dann, wenn beim Speichern
die Spannungsmessung aktiv ist. Die Dehnungskonfiguration ergibt sich aus der User Scale, 
die  ebenso wie die Einheiten im Messverstärker gespeichert werden.
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Sensoren mit TEDS

Einige Sensoren haben einen Speicherbaustein, in dessen Speicher individuelle 
Konfigurationsdaten für diesen Sensor abgelegt sind. Diese sind im TEDS Standard nach 
IEEE 1451.4 standardisiert (Transducer Electronic Data Sheet).

Zur Zeit unterstützen nur die Messverstärker GSV-8 und GSV-6 Sensoren mit TEDS (GSV-6 
nur an Kanal 1).

Beim Anschließen eines Sensors mit TEDS oder beim Einschalten mit angeschlossenem 
Sensor liest der GSV-8 den Speicher aus und setzt Skalierung (User Scaling), Einheit und 
Eingangsempfindlichkeit automatisch so, dass richtige physikalische Messwerte angezeigt 
werden, d.h. User Scaling kann und muss nicht gesetzt werden wie auf S.8 beschrieben.

Wenn dies geschehen ist, verändert sich die Beschriftung der User Scaling Schaltfläche zu 
Scaling by TEDS:

Im allgemeinen muss der Benutzer dann nichts weiter tun. Um den Speicherinhalt explizit zu
lesen oder die TEDS-Ladeoptionen zu ändern, kann man in den TEDS Dialog gelangen, 
indem man diese Schaltfläche klickt oder Menüleiste -> Sensor -> TEDS...

Die Anzeige TEDS usage -> Sensor Info

Mit GSV-8 wird hier in jeder Zeile angezeigt, ob ein Sensor angeschlossen ist und ob die 
TEDS Daten geladen wurde. Mit GSV-6 ist nur Kanal 1 gültig. Die Einträge bedeuten:

• Input Type: Eingangstyp. TEDS Template mit IDs 33 und 35 (s.u.) können nur mit 
Brückeneingängen bestimmungsgemäß verwendet werden, ID 25 nur mit 
Spannungseingang.
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• Sensor Plugged? Der GSV-8 kann i.d.R. ermitteln, ob ein Brückensensor 
angeschlossen ist; dann lautet der Eintrag Yes; andernfalls No oder Unknown für 
unbekannt. Letzteres ist regelmäßig der Fall bei Eingangstyp= Spannung (Voltage) 
oder Temperatur sowie beim GSV-6.

• TEDS used: Diese Soft-LED "leuchtet" hellgrün, wenn TEDS Daten erfolgreich geladen 
wurden. In diesem Fall ist auch EEPROM connected an.

• EEPROM connected: Diese Soft-LED "leuchtet" hellgrün, wenn ein TEDS-
Speicherbaustein angeschlossen und erkannt wurde. Das gilt auch dann, wenn 
dessen Dateninhalt nicht als bekannt und konform interpretiert werden konnte; in 
diesem Fall leuchtet TEDS used nicht. Das ist regelmäßig bei leeren 
Speicherbausteinen der Fall.

• TEDS auto-load: Diese Soft-LED "leuchtet" hellgrün, wenn der GSV-8 so konfiguriert 
wurde, dass er an diesem Kanal TEDS Daten verwenden soll, siehe TEDS usage.

Konfiguration des TEDS-Geräteverhaltens

Der GSV ist per Herstellereinstellung so konfiguriert, dass er beim Einschalten versucht, 
TEDS Daten zu laden (GSV-8 auch bei Sensorwechsel); ferner gibt es vier Checkboxen für 
Detaileinstellungen, die nur gelten, wenn für diesen Kanal grundsätzlich TEDS-Daten geladen
werden sollen.

• TEDS Usage Input Ch. <no> Grundsätzliche TEDS-Lade-Eigenschaft für den links oben
unter Input Channel gewählten Kanal

• Set unit from TEDS data: Wenn gesetzt, wird auch die Einheit anhand der TEDS Daten 
gesetzt (gültig für alle Kanäle mit aktiviertem TEDS).

• Set input range from TEDS dat: Wenn gesetzt, wird auch der Eingangsmessbereich / 
Eingangsempfindlichkeit anhand der TEDS Daten gesetzt (gültig für alle Kanäle mit 
aktiviertem TEDS).

• Set offset from TEDS: Wenn gesetzt, wird auch der Nullpunkt anhand der TEDS Daten 
gesetzt (gültig für alle Kanäle mit aktiviertem TEDS). Wenn dies gesetzt ist, ist das 
Nullsetzen mit Set Zero (Hauptfenster->Configuration) weiterhin möglich, aber nach 
dem nächsten Einschalten wird wieder der Nullpunkt aus dem TEDS geladen.

• Set analog output from TEDS: Wenn gesetzt, werden die Skalierungsfaktoren der 
Analogausgänge anhand der TEDS Daten so gesetzt, dass der physikalische 
Maximalwert dem analogen Nenn-Ausgangswert entspricht (gültig für alle Kanäle mit
aktiviertem TEDS).

Wenn man die grundsätzliche TEDS-Lade-Eigenschaft verändern möchte, kann man mit 
Apply this to all input channels angeben, ob die gewählte Einstellung so für alle 
Eingangskanäle gelten soll. Anschließend Store to GSV device klicken.

Mit der hellblauen Schaltfläche Refresh kann man nach Wechseln von Einstellungen oder 
Neu-Anschluss eines TEDS Baustein die Anzeigen aktualisieren.
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Lesen und Anzeigen des TEDS Inhalts

Nach Klicken auf Read from TEDS device werden die Inhalte angezeigt, und zwar in den 
Karteikarten Basic TEDS data und TEDS 33 data (bzw. TEDS 35 data oder TEDS 25 data).Die 
verschiedenen Templates entsprechen unterschiedlichen Datenformaten für verschiedene 
Kategorien von Sensoren. Die Basic TEDS data sind bei allen Templates gleich organisiert, 
sie enthalten eine ID für den Sensorhersteller, die Template ID und die Seriennummer sowie 

die Einträge ModelNo, Version Letter und Version Number, die der Hersteller beliebig setzen 
darf.

Bei Sensoren von ME-Meßsysteme steht die Sensor-Seriennummer in Manufacturer Serial 
number.

GSV-6 und GSV-8 unterstützen Template ID 33 für Wheatstone-Brückensensoren und ID 35 
für Dehnungsmessstreifen; der GSV-8 zusätzlich ID 25 für Beschleunigungssensoren 
(Accelerometer).

Die Template-ID-spezifischen Dateninhalte werden in der rechten Karteikarte dargestellt; im 
folgenden wird nur ID 33 für Brückensensoren beschrieben.

Wenn man das TEDS Fenster über Menüleiste -> Sensor -> TEDS geöffnet hat, so werden 
mit dem GSV-8 einige Einträge grün hinterlegt dargestellt; dies sind solche, die erfahrene 
Benutzer aus bestimmten Gründen - z.B. bei einer Nachkalibrierung - verändern können, um 
die Daten dann in den Speicher zurückzuschreiben, was jedoch nur mit dem GSV-8 möglich 
ist (s.u.). Die weiß hinterlegten sind unveränderliche Eigenschaften des Sensors, die i.d.R. 
nicht verändert werden.

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de
16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de 51



Die Einträge im einzelnen:

• Physical Measurand: Die physikalische Messgröße des Sensors, für die auch diese 
Kalibrierung gilt. Diese bestimmt auch die Einheit. Anhand dieses Wertes wird die 
Einheit des GSVs gesetzt, wenn dementsprechend konfiguriert.

• Minimum physical value: X-Koordinate "Pmin" des unteren Punktes der 
Zweipunktform der Sensorkennlinie, s. Zeichnung unten

• Maximum physical value: X-Koordinate "Pmax" des oberen Punktes der 
Zweipunktform der Sensorkennlinie, s. Zeichnung unten

• Select Precision: Zahlendarstellungsform der Koordinatenpunkte (Pmin/max, Emin/max). 
Empfohlen sind 32 Bits.

• Minimum electrical value: Y-Koordinate "Emin" des unteren Punktes der 
Zweipunktform der Sensorkennlinie in mV/V, s. Zeichnung unten

• Maximum electrical value: Y-Koordinate "Emax" des oberen Punktes der 
Zweipunktform der Sensorkennlinie in mV/V, s. Zeichnung unten

• Bridge Type: Sensor Brückentyp (Full, Half, Quarter)

• Sensor Impedance. Sensor Innenwiderstand in Ohm

• Response time: Einschwingzeit des Sensors bei schnellen Änderungen (Sprüngen) 
der Messgröße, in Sekunden

• Excitation amplitude nominal: Empfohlene Sensorspeisung in Volt

• Excitation amplitude minimum: Minimale Sensorspeisung in Volt

• Excitation amplitude maximum: Maximale Sensorspeisung in Volt

• Calibration Date: Datum der letzten Sensorkalibrierung
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• Calibration Initials: Initialen der Person, die kalibriert hat

• Calibration period: Empfohlene Zeit bis zu einer Nachkalibrierung, in Tagen

• Measurand location ID: Benutzer-spezifische Identifikationsnummer der Messstelle

Editieren und Schreiben von TEDS Daten

Mit dem GSV-8 können Speicherbausteine (sog. 1-wire EEPROMs) auch beschrieben 
werden. Folgende Typen werden unterstützt: 24B33, MAX31826, 28E0710, 243110

Um Schreiben zu können, muss der TEDS-Dialog über Menüleiste -> Sensor -> TEDS... 
geöffnet werden, dann muss (außer bei leerem Baustein) zunächst mit Read from TEDS 
device gelesen werden.

Die grün hinterlegten Einträge in den Karteikarten mit den TEDS Daten können direkt 

verändert und dann mit Klick auf Write to TEDS device geschrieben werden. Dabei muss das 
Gerätepasswort des GSV-8 (default: Beln) eingegeben bzw. bestätigt werden.

Um einen vorher leeren Baustein zu beschreiben oder auch die weiß hinterlegten Einträge und die in 
den Basic TEDS data zu verändern und zu schreiben, gehen erfahrene Benutzer folgendermaßen vor:

1. Auf Edit All klicken, dann das Freischalt-Passwort MEsysTEDS42 eingeben. Es öffnen sich 
Karteikarten aller drei unterstützten Templates 33, 35 und 25.

2. Daten editieren; dabei darauf achten, dass nur die Daten im verwendeten Template =  
Karteikarte verändert werden. Das Template selbst, d.h. die Sensorkategorie wird in Basic 

10 Erst ab Hardware-Version 4.2
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TEDS data -> TemplateID gewählt. Wenn der Speicherbaustein vorher leer war, müssen alle 
Einträge geprüft und ggf. gesetzt werden.

3. Auf Write data to TEDS device klicken, dann Gerätepasswort eingeben.

Es ist auch möglich, TEDS Daten in eine Datei zu schreiben, und zwar mit Write TEDS data to
file  und eine solche Datei wieder zu lesen, mit Read TEDS data from file.

Justage von Sensoren mit einer bekannten Last

Allgemeine Sensoren, die nicht unter die zuvor genannten Kategorien Mehrachssensoren 
mit Kalibriermatrix, Sensoren mit TEDS oder Rosetten DMS zur Spannungsmessung fallen, 
werden in der Regel anhand der auf dem Prüf- oder Kalibrierprotokoll genannten Daten 
justiert, wie auf S. 8 gezeigt.

Falls man diese Daten nicht mehr zur Hand hat oder der Sensor vielleicht durch Alterung 
oder harsche Umweltbedingungen seine Übertragungseigenschaften verändert haben mag, 
kann man ihn durch ein interaktives Verfahren justieren. Dies ist u.U. auch bei Verwendung 
von DMS möglich, nämlich dann, wenn eine mechanische Größe wie etwa Kraft, Druck oder 
Drehmoment zu einer signifikanten und reproduzierbaren Dehnung an den DMS führt.

Für das Justageverfahren ist es nötig, dass dem Sensor eine genau bekannte Last 
aufgebracht werden kann. Es ist empfehlenswert, diese Last so zu wählen, dass sie 
entweder ungefähr dem maximalen Wert des Bereiches entspricht, in dem man tatsächlich 
messen will oder so, dass sie im Bereich von ca. 30% bis 100% des Nenn-Messbereiches 
des Sensors liegt.

Es ist ferner nötig, dass die Last (genauer: diejenige Last, die gemessen werden soll) vom 
Sensor entfernt werden kann. Tun Sie das zunächst und beobachten den Messwert. Wenn 
er deutlich von Null abweicht, ist es empfehlenswert, ihn vor dem Start des Verfahrens mit 

Set Zero auf Null zu setzen.

Dann kann man das Verfahren starten, 
entweder durch Menüleiste -> Sensor -> 
Calibrate... oder durch Klick auf User 
Scaling und Wahl der kleinen Karteikarte 
Calibration:

In dem links gezeigten Beispiel soll ein 
Kraftsensor mit einem Nennbereich von 2
kN mit einem 20 kg Gewicht justiert 
werden. Es soll jedoch in Newton 
gemessen werden. Dazu multipliziert 
man die Masse in kg mit dem 

Erdbeschleunigungsfaktor g, dessen Mittelwert 9,81 m/s² beträgt. Das Ergebnis der 
Kalibrierlast in der zu messenden Einheit wird in Calibration Load eingetragen.

Die Eingangsempfindlichkeit Input Range rechts wird bei den meisten Messverstärkern 
gleich richtig angezeigt.

Dann auf Execute Calibration klicken. Sie werden zunächst aufgefordert, zu bestätigen, dass 
der Sensor lastfrei ist:
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Dies mit Yes bestätigen. Anschließend werden einige Messwerte genommen; 
währenddessen erscheint eine Balkenanzeige: 

  

Dann werden Sie aufgefordert, die Last
aufzubringen: 

Tun Sie das. Falls der Sensor dadurch etwas schwingt, warten 
Sie kurz ab, bis er ruhig ist und klicken Sie dann OK.

Dann werden wieder einige Messwerte genommen, bis diese Meldung erscheint:

Der neu berechnete User Scaling Wert wird unter Scaling angezeigt:

Nun OK klicken, um den neuen Skalierungswert im Gerät zu speichern.
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Programmstart

GSVmulti kann auch per Doppelklick auf eine Session Datei gestartet werden, die zuvor mit 
Save Session gespeichert wurde.11 Dann wird diese Session geladen. Es kann auch eine 
*.tdms Messdatendatei per Doppelklick geöffnet werden, dann wird GSVmulti gestartet und  
diese Datei mit dem File Monitor geöffnet. Ist GSVmulti bereits offen, kann diese Methode 
jedoch nicht angewendet werden.

Man kann GSVmulti auch mit einer Programmverknüpfung und Aufrufparametern starten, 
so dass automatisch Aktionen ausgeführt werden. Diese kann in Windows im 
Autostartmenü angelegt werden, so dass sich das Programm beim Start des PCs 
automatisch öffnet. Das ist z.B. nützlich, wenn dauernd Messwerte aufgezeichnet werden 
sollen, damit nach einem Stromausfall oder einem automatischen Neustart diese 
Aufzeichnung abermals gestartet wird.

Es sind bis zu 3 Aufrufparameter möglich.

Erster Parameter: Für diesen gibt es drei Möglichkeiten:

1. "-l" Bei Programmstart wird automatisch die zuletzt geladene oder 
gespeicherte Session geöffnet, s.u.

2. Erster Aufrufparameter = Kompletter Pfad zu Sessiondatei (*.ucf): Diese 
Geräte-Sessiondatei wird geladen

3. Erster Aufrufparameter = Kompletter Pfad zu Messdatendatei (*.tdms): Diese 
Messdatendatei wird mit dem File-Monitor geöffnet

Zu 1.: Wenn der erste Aufrufparameter "-l" ist, können optional bis zu zwei weitere Parameter
angegeben werden.

Zweiter Parameter:

"-rYt": Nachdem die Session geladen wurde, wird automatisch eine Aufzeichnung mit dem 
Yt-Recorder gestartet, siehe S. 9. Dabei gilt die mit Configure Recording definierte 
Aufnahmekonfiguration, siehe S. 58.

"-rXY": Nachdem die Session geladen wurde, wird automatisch eine Aufzeichnung mit dem 
XY-Recorder gestartet, siehe S. 56. Dabei gilt entweder die mit Configure Recording 
definierte Aufnahmekonfiguration (siehe S. 58.) oder die schwellwertabhängige Triggerung, 
falls diese vorher aktiviert war. Ferner gilt der zuletzt gewählte Kanal für die X-Achse

Dritter Parameter: Aufzeichnungszeit in Sekunden. Nach Ablauf dieser Zeit wird das 
Programm geschlossen. Dies ist z.B. nützlich, um zu verhindern, dass die Messdatendatei 
sehr groß wird, womöglich sogar das Laufwerk vollschreibt.

XY Recorder

In der Karteikarte Recorder XY können ein oder mehrere Messwerte über einem anderen 
Kanal dargestellt werden. Deshalb müssen mindestens zwei Kanäle geöffnet sein. Im 
Gegensatz zum Recorder Yt werden die Messwerte also nicht gemäß y= f(t) über der Zeit 

11 Nach der Erstinstallation fragt Windows u.U. einmalig, ob Sie die Datei mit GSVmulti öffnen wollen. Wenn 
dies bestätigt wird, speichert Windows diese Datei <-> Programmzuordnung.
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dargestellt, sondern über einem anderen Kanal y= f(x). Der auf die X-Achse projizierte Kanal 
wird beim Eintritt in diese Registerkarte ausgewählt.

Im wesentlichen stellt der XY-Rekorder ähnliche Funktionen zur 
Verfügung wie der Yt-Rekorder.

Zusätzlich bietet er noch eine schwellwertabhängige Anzeige bzw. Aufzeichnung. Wenn 
diese aktiv ist, so werden nur einzelne Werte angezeigt (d.h Punkte, die miteinander 
verbunden sind), und dies nur dann, wenn der Wert des auf die X-Achse projizierten Kanals 
die vorher definierten Schwellwerte überschreitet.

Die Schwellwerte müssen also vorher festgelegt werden; dazu klicken Sie bitte auf Trigger 
Thresholds. Dann öffnet sich ein Fenster, in welchem Sie die Schwellwerte festlegen können,
wobei Sie dieses manuell  durch direkte Eingabe tun können (aktivieren Sie hierzu manually) 
oder Sie lassen die Schwellwerte automatisch erzeugen (automatically) durch Eingabe von 
Start- Endwert und Inkrement (From, To und Increment).

Bis zu 11 Schwellwerte werden hierin angezeigt, wenn es mehr sind, können Sie den ersten links mit dem 
Indexelement ganz links (hier schwarz markiert) verändern. Ausgegraute Einträge sind nicht vorhanden.

Anschließend starten Sie die Messung (falls dies nicht schon geschah) und klicken auf die 
Checkbox Activate, wobei sich diese Text-Schaltfläche dann zu Activated ändert.

Hinweis: Die mit Configure Recording definierten Einstellungen (s. S. 58) gelten mit 
aktivierten Triggerschwellwerten nicht.
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Beispiel: XY Recorder für Kraft-Weg-Messung

Softwareoptionen für XY Rekorder

Die Frage nach der Wahl des Kanals der X-Achse kann man unterdrücken, so dass bei jedem
Wechsel in die Recorder XY Karteikarte der gleiche X-Kanal verwendet wird. Das tut man, 
indem unter Menüleiste -> Options -> Preferences -> When changing to XY-diagram der 
Checkbox-Haken bei Ask for selection of X-channel herausgenommen wird.

Die andere Checkbox in diesem Feld beschreibt das Verhalten beim 
Triggerschwellen-Vergleich des XY Rekorders unter XY Trigger threshold 
compare. Bei Messdatenfrequenzen >5 Hz wird in der 
Ausgangskonfiguration, wenn Fastly, without Average nicht aktiviert ist, 

eine Mittelwertbildung über ungefähr 200 ms gebildet und der Mittelwert mit dem aktuellen 
Schwellwert verglichen. Ist diese Checkbox gesetzt, wird das ohne Mittelwertbildung mit 
jedem Einzel-Messwert getan.

Konfiguration der Aufnahme von Messdaten

Bei Klick auf die Schaltfläche Configure Recording in der Karteikarte Recorder Yt oder 
Recorder XY öffnet sich ein Fenster, in dem die Aufnahme vorbereitet und konfiguriert 
werden kann. Dies ist nur möglich, solange die Aufnahme (noch) nicht läuft, d.h. bei 
laufender Aufnahme kann deren Konfiguration nicht verändert werden. Die Messdaten 
werden  in einem effizienten binären Dateiformat gespeichert, dem tdms Format. Es enthält 
neben den Messdaten auch Metadaten, sog. Properties. Diese Dateien können mit dem File 
Monitor betrachtet und exportiert werden.
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Automatisches Starten und Beenden der Aufnahme

Es können in der Karteikarte Trigger Recording im Configure Recording Dialog verschiedene 
Bedingungen zum Starten oder Beenden definiert werden. Der Inhalt dieser Karteikarte kann 
sich anhand der gewählten Einstellungen ändern, daher wird empfohlen, die 
Bedienungsreihenfolge von oben nach unten einzuhalten. Zunächst muss der oberste Radio 
Button unter Start Recording und/oder Finish Recording auf Automatically gesetzt werden.

Startbedingung

Die Startbedingung Start Trigger Type kann das Überschreiten des Messwertes eines 
bestimmten Kanals mit einem definierbaren Schwellwert sein oder (nur bei den 
Messverstärkermodellen GSV-4, GSV-6 und GSV-8) ein digitaler Pegel einer Leitung, die am 
Digitaleingang des GSV angeschlossen ist. In diesem Fall stellt man i.d.R. den Typ des 
Digitaleingangs auf GP input (unter Menüleiste  → Device  Advanced Settings Digital I/O→ → ); 
dies ist jedoch nicht erforderlich, d.h. es dürfen auch andere I/O Typen in dem 
Geräteeinstellungen gewählt werden.

• Value exeeds threshold: Die Aufnahme wird gestartet, wenn Messwert > Schwellwert 
ist und der vorangegangene Messwert <= Schwellwert war, d.h. bei 
Schwellwertüberschreitung

• Value drops below threshold: Die Aufnahme wird gestartet, wenn Messwert < 
Schwellwert ist und der vorangegangene Messwert >= Schwellwert war, d.h. bei 
Schwellwertunterschreitung

• Value change delta threshold: Die Aufnahme wird gestartet, wenn die Betragsdifferenz
eines Messwertes mit seinem Vorgänger größer oder gleich dem Schwellwert ist, d.h.
wenn |Messwert(k) - Messwert(k-1)| >= Schwellwert ist.

• Digital I/O:  Die Aufnahme wird gestartet, wenn ein digitaler Pegelwechsel erfolgt. Die 
Pegelflanke wird mit dem Schalter Level Change Edge definiert und die Nummer des 
digitales Anschlusses (Leitung) wird mit dem Auswahlelement Digital I/O ausgewählt.

Für die schwellwertabhängige Startbedingung muss unter Threshold Value der Schwellwert 
eingegeben werden und mit dem Auswahlelement Trigger Channel der Kanal, dessen 
Messwert mit dem Schwellwert verglichen werden soll.

Wenn man unter Number of Pre-Trigger values eine Anzahl > 0 eingibt, so werden auch vor 
Eintreten der Startbedingung Messwerte mit der definierten Anzahl aufgezeichnet. Man 
kann dann auch die Checkbox Auto-Create Annotation at Trigger setzen, so dass bei 
Erreichen der Triggerbedingung an dieser Stelle automatisch eine Notiz (Annotation) erstellt 
wird, und zwar typabhängig einer der Texte „Start Rec: Threshold exceeded“, „Start Rec: 
Fallen below Threshold“, „Start Rec: D-threshold exceeded“, „Start Rec: Digital-In Rising“ und 
„Start Rec: Digital-In Falling“.12

Unter Event Number kann festgelegt werden, ob die Startbedingung zur Aufnahme zur 
einmal getestet wird oder mehrmals. Wenn Record single event (file) gewählt ist, wird nach 
den automatisch gestarteten Aufnahme aufgrund der definierten Triggerbedingung diese 

12 Die Funktion Pre-Trigger Values ist nur mit GSVmulti PRO verfügbar
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nicht mehr weiter geprüft. Bei Record several events (files) wird nach Beenden der 
automatisch gestarteten Aufnahme die Triggerbediengung wieder geprüft, so dass mehrere 
automatisch gestartete Messdatendateien erzeugt werden können.

Beendigungsbedingung

Für das automatische Beenden der Aufnahme wird unter End Condition Type zunächst aus 
zwei Grundkategorien gewählt:

• Time / Number of values: Nach einer einstellbaren Zeit oder nach Erreichen einer 
Anzahl von Messwerten wird die Aufnahme beendet

• Signal Trigger: Eine Schwellwertbedingung oder ein digitaler I/O Pegel beendet die 
Aufnahme

Mit Time / Number of values kann unter End condition time/number eine der folgenden 
Beendigungsbedingungen ausgewählt werden:

• Number of values: Nach Erreichen der Anzahl wird die Aufnahme beendet. Geben Sie 
rechts daneben die Anzahl ein: 

• Relative Time: Nach Erreichen dieser Zeit, gezählt ab Start der Aufnehme, wird sie 
beendet. Geben Sie rechts daneben die Zeit unter HH (Stunden), MM (Minuten) und 
SS (Sekunden) ein:

• Absolute Time (Daily file): Zu der festgelegten Uhrzeit wird die Aufnahme jeweils 
beendet und dann täglich eine in eine neue Datei aufgezeichnet. Die Checkbox When 
finished: Generate new file ist automatisch aktiviert. Geben Sie rechts daneben die 
Uhrzeit unter HH (Stunden), MM (Minuten) und SS (Sekunden) ein.

• Absolute Date, Time: Zu dem festgelegten Datum und Uhrzeit wird die Aufnahme 
beendet. Eine neue Datei kann nicht automatisch angelegt werden, deshalb ist die 
Checkbox When finished: Generate new file deaktiviert. Zum Festlegen von Datum 
und Uhrzeit klicken Sie rechts auf das Kalendersymbol und wählen im folgenden 
Dialog unten das Datum und geben oben die Uhrzeit im Format 
<Stunde>:<Minute>:<Sekunde> ein, mit OK bestätigen.

Mit Signal Trigger kann unter End Trigger Type eine der folgenden Beendigungsbedingungen 
ausgewählt werden:
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• Value exeeds threshold: Die Aufnahme wird beendet, wenn Messwert > Schwellwert 
ist und der vorangegangene Messwert <= Schwellwert war, d.h. bei 
Schwellwertüberschreitung

• Value drops below threshold: Die Aufnahme wird beendet, wenn Messwert < 
Schwellwert ist und der vorangegangene Messwert >= Schwellwert war, d.h. bei 
Schwellwertunterschreitung

• Value change delta threshold: Die Aufnahme wird beendet, wenn die Betragsdifferenz 
eines Messwertes mit seinem Vorgänger größer oder gleich dem Schwellwert ist, d.h.
wenn |Messwert(k) - Messwert(k-1)| >= Schwellwert ist.

• Digital I/O:  Die Aufnahme wird beendet, wenn ein digitaler Pegelwechsel erfolgt. Die 
Pegelflanke wird mit dem Schalter Level Change Edge definiert und die Nummer des 
digitales Anschlusses (Leitung) wird mit dem Auswahlelement Digital I/O 
ausgewählt.

Für eine schwellwertabhängige Beendigungsbedingung muss unter Threshold Value der 
Schwellwert eingegeben werden und mit dem Auswahlelement Trigger Channel der Kanal, 
dessen Messwert mit dem Schwellwert verglichen werden soll.

Wenn man unter Number of Post-Trigger values eine Anzahl > 0 eingibt, so werden auch 
nach Eintreten der Beendigungsbedingung Messwerte mit der definierten Anzahl 
aufgezeichnet. Man kann dann auch die Checkbox Auto-Create Annotation at Trigger setzen, 
so dass bei Erreichen der Triggerbedingung an dieser Stelle automatisch eine Notiz 
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(Annotation) erstellt wird, und zwar typabhängig einer der Texte „Stop Rec: Threshold 
exceeded“, „Stop Rec: Fallen below Threshold“, „ Stop Rec: D-threshold exceeded“, „ Stop Rec: 
Digital-In Rising“ und „ Stop Rec: Digital-In Falling“.13

Bei der Beendigungsbedingung Number of values und Relative Time kann unten die 
Checkbox When finished: Generate new file aktiviert werden. Das bewirkt, dass nach 
Beendigung der Aufnahme automatisch wieder in eine neue Datei aufgezeichnet wird und 
die gewählte Beendigungsbedingung dabei wieder getestet wird.

Verwenden der automatischen Aufzeichnung

Nachdem die  Aufnahmekonfiguration mit OK geschlossen wurde, wird sie für den nächsten 
Programmstart gespeichert. Um den automatischen Aufnahmestart zu aktivieren, muss die 
Messung im Recorder Yt (oder XY) mit Klicken auf Start measuring gestartet werden. Es 
erscheint dann eine Meldung:

Die Start Recording Schaltfläche blinkt, solange auf die Start-Triggerbedingung gewartet 
wird. Ist diese erreicht, wird die Aufnahme gestartet und die Start Recording Schaltfläche 
wechselt zu:

Wenn mehrere Dateien getriggert aufgezeichnet werden sollen, erscheint nach Beendigung 
der ersten Datei die Statusmeldung: "Number of recorded files ready: 1 Waiting for Trigger..."

Diese *.tdms Messdatendateien werden in das zuletzt gewählte Verzeichnis gespeichert. 
Um dieses zu setzen oder zu ändern, ist es empfehlenswert, einmalig eine Aufnahme 
manuell zu starten (d.h. mit Start Recording = Manually), weil nur dann ein 
Dateiauswahlfenster erscheint.

Weitere Konfigurationsmöglichkeiten für die Datenaufzeichnung

Karteikarte Save Memory Data:

Wenn im Recorder Yt mit Start Measuring eine Messung durchgeführt wurde, ohne dass 
diese aufgenommen wurde, können hiermit einige Daten nachträglich gespeichert werden. 
Diese Karteikarte hat nichts mit der eigentlichen Aufnahmekonfiguration zu tun. Sie ist nur bei Klick auf 
Configure Recording im Recorder Yt erreichbar.

13 Die Funktion Post-Trigger Values ist nur mit GSVmulti PRO verfügbar
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Karteikarte Data Reduction:

Insbesondere bei hoher Messdatenrate oder vielen Kanälen können die Messdatendateien 
recht groß werden. Mit der Datenreduktion kann diese Größe reduziert und ggf. können 
zugleich kurze Peaks erfasst werden.

Recording Interval: Zum Aktivieren der Datenreduktion auf One value per time interval 
stellen, zum Deaktivieren auf Record every value.

Time interval: Hier wird die Länge der Datenperiode definiert. Sie muss größer sein als
der Kehrwert der Messdatenrate der eingebundenen Messverstärker (Data 
Frequency).

Decimating Average: Wenn dieser Radio Button auf Mean values inside interval gestellt
ist, so wird innerhalb des festgelegten Datenintervalls auf allen Messwerten der 
arithmetische Mittelwert gebildet. Zu Beginn eines neuen  Datenintervalls wird dieser 
neu gestartet (dezimierende Mittelwertbildung). 

Create Additional Channels with Maximum/Minimum Values: Wenn hier Create 
Maximum / Minimum values aktiviert ist, so erzeugt GSVmulti in der Messdatendatei 
zusätzliche Kanäle (je einen pro Originalkanal für Maximum und Minimum), die den 
Maximalwert und den Minimalwert im Datenintervall angeben. Diese werden zu 
Beginn eines neuen  Datenintervalls jeweils neu ermittelt. Zusammen mit Decimating 
Average kann man bei relativ hoher Messdatenrate so Durchschnitts- und Peakwerte 
aufzeichnen. Im File Monitor werden die Kanäle der Maximal- und Minimalwerte 
gestrichelt dargestellt, den Kanalnamen ist jeweils "_Max" bzw. "_Min" angehängt.

Karteikarte Auto Export:

Die Messdatendateien haben ein bestimmtes, binäres Format, das *.tdms Format, das 
außer durch GSVmulti nur von wenigen Programmen gelesen werden kann (z.B. NI Diadem).
Mit Auto Export kann zur Messlaufzeit beim Beenden der Aufnahme einer tdms-Datei diese 
automatisch in ein anderes Format konvertiert werden, z.B. allgemein lesbare Textformate. 
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Enable Auto-Export muss dazu aktiviert werden. Alternativ können bereits aufgenommene 
tdms Dateien auch im File Monitor nachträglich konvertiert werden.

Select Destination file type: Hier wird das Dateiformat der exportierten Datei 
festgelegt.

Text file (tab separator): Es wird eine Tabellendatei im Textformat erzeugt. Die 
Messwerte der Kanäle und der Zeit/Datumsstempel sind mit dem 
Tabulatorzeichen getrennt. Es wird ein Header erzeugt. Die Dateiendung ist 
*.txt. Wenn dieser Typ gewählt ist, kann alternativ auch durch Aktivieren von 
GSV-6 Logger Format das Format der Messdatendateien gewählt werden, die 
der GSV-6BT auf SD Karte schreiben kann.

CSV file (select separator): Dieses Format ist dem Text file sehr ähnlich, aber 
man kann mit Cell Separator das Trennzeichen für die Zellen angeben und die 
Dateiendung ist *.csv. Dieses Format kann mit vielen gängigen 
Tabellenkalkulationsprogrammen, etwa LibreOffice Calc, geöffnet werden.

Excel Spreadsheet: Eine Excel Tabelle wird erzeugt. Der Export kann bei großen
Dateien / hoher Messdatenrate u.U. lange dauern und dann auch die 
Systemperformance beeinträchtigen (dann ist das csv Format eher zu 
empfehlen).

Influx DataBase: Eine Messdatendatei im Influx-Format wird erzeugt. Wenn 
dieser Typ gewählt ist, sollte der Measurement Name angegeben werden. Man 
kann fehlende oder (z.B. aufgrund von Störungen) extrem unplausible 
Messwerte mit Eliminate missing and excess values ausfiltern. Eine Influx-
Datei kann in eine Messdaten-Datenbank hochgeladen werden; bei ME-
Systeme ist auf Anfrage ein kleines zusätzliches Hintergrund-Programm 
erhältlich, welches dies bewerkstelligt.

Timestamp in UTC: Bei einigen Dateitypen können die Zeitstempel in Universal Time 
konvertiert in die exportierte Datei eingetragen werden.

Append to selected destination file: Wenn diese Checkbox aktiviert ist, werden die 
exportierten Messdaten an eine bereits bestehende Datei angehängt. Diese sollte 
bereits vorhanden und von gleichen Dateityp sein. Wenn Sie diese Checkbox setzen, 
wählen Sie bitte mit dem gelben Dateibrowser-Button rechts neben Destination Path 
of exported file(s) die Datei aus, an die angehängt werden soll.

Karteikarte Advanced:

Hier sind verschiedene spezielle Einstellmöglichkeiten zusammengefasst.

Record Hidden Channels: Falls mit Menüleiste -> Channels -> Hide Kanäle versteckt 
wurden oder in der geöffneten Session versteckte Kanäle definiert sind, kann man mit
dem Aktivieren der Checkbox festlegen, dass diese mit aufgenommen werden sollen.

Additional File: Am Ende der Aufnahme wird eine zweite Messdatendatei erzeugt, die 
Messwerte aller Kanäle enthält, die anhand einer Maximal- oder 
Minimalwertbedingung gefiltert sind. Filterbedingung und Werteanzahl können 
festgelegt werden. Diese Funktion wird mit der Checkbox Create second file with 
filtered values aktiviert.
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Filter Criterion: Hiermit wird festgelegt, ob anhand eines Maximal- oder 
Minimalwertes gefiltert wird. Die ganze Originaldatei wird anhand des 
Kriteriums durchsucht.

Number of Values around trigger / Number of values in filtered file: Anzahl der 
Messwerte pro Kanal in der gefilterten Datei.

Channel to apply criterion: Kanal, auf den die Max./Min Filterbedingung 
angewendet wird.

Timestamp Calculation: Bei dem erzeugten *.tdms Dateiformat werden Zeitstempel 
nicht mit jeder Messwertzeile gespeichert. Stattdessen wird die Startzeit und ein 
Zeitinkrement dt gespeichert und die Zeitstempel werden für die Anzeige bzw. den 
Export in ein anderes Dateiformat hieraus gebildet. Aus diesem Grund können nur 
zeit-kontinuierliche (äquidistante) Messungen aufgenommen werden. In diesem 
Abschnitt kann angegeben werden, wie GSVmulti das Zeitinkrement dt am Ende der 
Aufnahme berechnen soll. Hinweis: Ist die Datenreduktion aktiviert, d.h. in Data Reduction ist  One value 
per time interval aktiviert, sind diese Einträge ausgegraut, weil das Zeitinkrement durch die 
Datenreduktionseinstellung definiert wird.

Auto-Select dt mode: Ist diese Checkbox aktiviert (default), so entscheidet 
GSVmulti anhand fest vorgegebener Kriterien selbst, welcher 
Berechnungsmodus für dt verwendet wird. Wenn Messverstärker vorhanden 
sind, deren Messdatenrate als nicht hinreichend genau angesehen werden, 
wird der Modus Calculate dt from Final time verwendet. Sind alle 
Messverstärker zeitlich sehr genau und die Datenfrequenzen aller GSVs gleich 
eingestellt (bei Verwendung mehrerer Geräte), wird die Messdatenrate des/der
Messverstärker zur Berechnung verwendet, d.h. der Modus Use device data 
rate.

Select dt mode: Wenn Auto-Select dt mode nicht aktiviert ist, kann hiermit die 
Berechnungsmethode für dt angegeben werden.

Calculate dt from Final time: Hiermit wird dt anhand der Startzeit, der 
Beendigungszeit und der Anzahl der Messwerte berechnet, d.h.: dt= 
(Endzeit - Startzeit) / (Messwertanzahl-1).

Use device data rate: Hiermit wird dt anhand der im Messverstärker 
eingestellten Datenfrequenz berechnet, d.h. dt= 1/Datenfrequenz

User defined dt: Hiermit kann dt vom Benutzer gesetzt werden (dadurch 
kann sich eine falsche, bzw. fiktive Endzeit ergeben). Ist diese Methode 
gewählt, erscheint ein Eingabefeld Enter Data Period, in dem das 
Zeitinkrement dt in Sekunden einzugeben ist.

Resulting dt: Bei Verwendung der Methoden Use device data rate oder User 
defined dt wird hier das resultierende Zeitinkrement angegeben.

Replace Missing values: Bei Problemen mit der Verbindungsstabilität werden mit 
dieser Option fehlende Messwerte eines Geräts (festgestellt durch Timeout-Zählung) 
durch den sehr hohen Markerwert 1E+300 ersetzt. Wenn Eliminate missing and 
excess values unter Auto Export aktiviert ist, werden diese Werte beim Export in das 
Influx DB-Format weggelassen. Verwenden Sie diese Option nicht unter normalen 
Bedingungen, insbesondere dann nicht, wenn die getriggerte Aufzeichnung per 
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Schwellenwert aktiviert ist oder mit Software-berechneten Spezialsensoren!

Formatieren des Dateinamens

In der Eingabemaske Format Measuring File Name unten im Fenster kann der Name der 
Messdatendateien formatiert werden. Er gilt dann für die tdms Dateien und ggf. auch für 
exportierte andere Formate und besteht in der Ausgangskonfiguration (Default) aus Datum 
und Uhrzeit des Startzeitpunktes der Datei. Dies wird durch den Formatstring <%d_%m_%y-
%H_%M_%S> angegeben. Man kann hier fast beliebige Texte vor oder hinter dem 
Zeit/Datumsformatstring eingeben, d.h. vor < oder nach >.  Die Sonderzeichen % [ ] \ / : * ? " <
> | sind dabei zu vermeiden. Bei durch Trigger Recording automatisch gestarteten Dateien 
kann zusätzlich [No] angehängt werden; dadurch werden den Dateinamen automatisch 
hoch zählende Nummern angehängt. Mit der Schaltfläche Default rechts kann der ganze 
Formatstring zur Ausgangskonfiguration zurückgesetzt werden. Innerhalb der 
Formatierungskodes, eingeschlossen in < und > dürfen auch fast beliebige Texte und 
Zeichen stehen, außer [ ] \ / : * ? " < > |  und dem % Zeichen, das einen Formatierungskode 
einleitet. Diese sind:

Code Bedeutung

%a Abgekürzter Wochentag (z.B. Mo)

%A Kompletter Wochentagsname (z.B. Montag)

%b Abgekürzter Monatsname (z.B. Jan)

%B Kompletter  Monatsname (z.B. Januar)

%c locale-spezifische Default Datum/Uhrzeit Formatierung

%d Tag des Monats (01-31)

%H Stunde (24-Stunden Format) (00-23)

%I Stunde (12-Stunden Format) (00-12)

%j Tagesnummer des Jahres (001-366)

%m Monatsnummer (01-12)

%M Minute (00-59)

%p AM oder PM Eintrag

%S Sekunde (00-59)

%U Wochennummer des Jahres (00-53), wobei der erste Sonntag der erste Tag der ersten Woche ist

%w Wochentag als Dezimalzahl (0-6), wobei 0 den Sonntag repräsentiert

%W Wochennummer des Jahres (00-53), wobei der erste Montag der erste Tag der ersten Woche ist

%x locale-spezifisches Datum

%.1x langes Datumsformat

%.2x abgekürztes langes Datumsformat

%X locale-spezifische Zeit

%y Jahr innerhalb des Jahrhunderts (00-99)

%Y Jahr, einschließlich Jahrhundert (z.B. 2023)

%z Unterschied zwischen der lokalen Zeit und der UTC (HH:MM:SS)

%Z Zeitzonenname oder -abkürzung (abhängig von den locale Einstellungen des Betriebssystems)

Beispiel 1: Format Measuring File Name:
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 Meine Messung<Am%d-%m-%y Um%H-%M-%S> Uhr[No]

ergibt den Dateinamen:

"Meine Messung Am15-05-23 Um11-41-15 Uhr_01.tdms"

Unter Resulting file name example wird ein Beispiel des Dateinamens angezeigt.

Hinweis: Die erzeugten Namen der Messdatendateien dürfen im gleichen Verzeichnis nicht 
mehrfach auftreten. Bei der Defaultformatierung wird das dadurch gewährleistet, dass der 
Dateiname die Uhrzeit mit Sekunden enthält (da innerhalb einer Sekunde ohnehin nicht 
mehrere Dateien aufgezeichnet werden können). Ein Zeitformat ist also zu empfehlen oder, 
bei automatisch gestarteter Aufzeichnung, der Funktions-tag [No], der fortlaufende 
Nummern erzeugt.

Verwenden des File Monitor

Durch Klicken auf File Monitor in der Configuration Karteikarte öffnet sich ein Fenster, mit 
dem eine *.tdms Datei geöffnet wird. Alternativ kann auch eine Messdatendatei im Text-
Format geöffnet werden, die durch einen der Datenlogger-Geräte GSV-2MSD-DI oder GSV-
6Bt erzeugt wurde. In diesem Fall wird die *.txt Datei in eine *.tdms Datei vor dem Öffnen 
konvertiert und der Benutzer wird nach dem Speicherort für die erzeugte tdms Datei gefragt.
Die TDMS Tools bieten weitere Möglichkeiten, s. S. 140

Die Messdaten können dann betrachtet, geprüft und exportiert werden. Bei Öffnen und beim 
Wechsel der Karteikarte kann es bei großen Dateien sein, dass folgende Warnmeldung 
erscheint:

Sie bedeutet, dass nur 200000 zeitlich hintereinanderliegende Messwerte der Datei geöffnet 
wurden. Man kann das ändern, indem man unter Settings die Anzahl der zu öffnenden Werte
setzt oder Load All Values wählt:
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Die Optionen für die Datenmengen zum Öffnen sind für die Karteikarte Values (table) 
=Wertetabelle und Analogue values (graph) = grafische Ansicht jeweils getrennt setzbar.

Wenn man Load all values wählt, kann das Öffnen u.U. lange dauern.
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Unten in der Statuszeile wird die Anzahl der geladenen Werte durch Loaded values 
angezeigt.

Unter File content, der Baumansicht links wählt man die anzuzeigenden Kanäle. Ist 
Measuring values ausgewählt, werden alle Kanäle angezeigt. Um mehrere Kanäle 
anzuzeigen, wählt man diese mit gleichzeitig gedrückter Strg Taste aus.

Kanalnamen und -farben sind die gleichen, die auch bei der Messung galten.

Properties zeigt die Metadaten der Datei an, siehe Anhang. Hierin wurden einige 
Einstellungen der Messung, mit der die Datei erzeugt wurde, gespeichert.

Values (table) ist eine numerische Wertetabelle.
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Analogue values (graph) ist die grafische Ansicht. Hier gibt es weitere Möglichkeiten.

Rechts oben sind drei kleine Schaltflächen für Werkzeuge mit folgenden Grundbedeutungen:

Linke Schaltfläche: Cursor verschieben (siehe unten)

Mittlere Schaltfläche: Zoomoptionen

Rechte Schaltfläche: Bildausschnitt verschieben durch Ziehen mit der Maustaste

Nach Wahl der Zoomoption kann mit Ziehen mit der 
Maustaste (linke Taste gedrückt halten) der 
Zoomausschnitt gewählt werden. Alternativ kann 
das vertikale Mausrad zum Zoomen verwendet 
werden. Die Zoomoption links unten bedeutet: Alles 
sichtbar. Das kann alternativ auch erreicht werden, 
indem man mit der rechten Maustaste in den Grafen

klickt und Autoscale X / Y wählt bzw. ab- und wieder einschaltet (falls bereits gewählt) oder 
das Mausrad nach unten dreht.
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Verwenden des Cursors

Um einen oder mehrere Cursor anzuzeigen, muss 
zunächst das Cursor-Menü angezeigt werden. Dazu klickt 
man mit der rechten Maustaste in den Graphen und wählt 
Visible Items->Cursor legend.

Rechts unten erscheint die Cursorlegende.

Dort mit der rechten Maustaste hinein klicken 
und Create Cursor->Single-Plot wählen. Mit dem
Single-Plot Cursor hat man die meisten 
Möglichkeiten. Der Cursor ist einem der 
angezeigten Kanäle zugeordnet. Die 
Koordinaten werden angezeigt, wobei die X-
Koordinate bei Yt Diagrammen der Zeit 
entspricht und Y dem Messwert dieses Kanals.

Um die Kanalzuordnung zu ändern, klickt man mit der rechten 
Maustaste auf die Cursornummer, hier Cursor 0 in der 
Cursorlegende und wählt Snap to. Eine Kanalliste erscheint, wobei 
nur die oberen Einträge verwendbar sind, d.h. solche, deren 
Namen zu sichtbaren Kanälen gehören.

Auch in der Statuszeile unten werden die Koordinaten angezeigt, 
die Zeit hier mit höherer Auflösung bei Messungen mit hoher 

Datenfrequenz.

Der Cursor erscheint als gelbes Linienkreuz im Graphen. Um ihn verschieben zu 
können, muss das entsprechende Werkzeug bei den drei kleinen Schaltflächen 

oben gewählt sein (s.o.). Außerdem muss die vertikale gelbe Linie des Cursors im 
Zoomausschnitt sichtbar sein. Ist das nicht der Fall, kann man wie oben gezeigt, alles 
anzeigen lassen und ggf. wieder hineinzoomen.
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Man kann mit Create Cursor wie oben gezeigt einen zweiten Cursor erzeugen und hat dann 
weitere Möglichkeiten. Erstens werden die Koordinatendifferenzen in der Statuszeile 
angezeigt und zweitens kann mit den Funktionstasten ein zeitlicher Bereich von Messwerten
als Text in die Zwischenablage kopiert werden, statt nur ein Wert pro Kanal.

Im Bild oben ist zu sehen, wie man beispielsweise die Periode eines Signals ermitteln 
könnte.  Es werden zwei Cursor erzeugt, die beide demselben Kanal (=Plot) zugeordnet sind 
(hier "Dev3_2"). Man kann den aktiven Cursor, der in der Legende gelb hinterlegt ist, auch mit 

den Pfeiltasten verschieben, z.B. so, dass dY in der Statuszeile möglichst klein 
wird. dann kann man mit dt: die Periode ablesen, hier 32,3 Sekunden.
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Kopieren und Exportieren von Messwerten

Exportieren in andere Dateiformate

Die ganze Datei, d.h. alle zeitlich vorhandenen Messwerte können durch Klicken auf die 
Schaltfläche Export in ein anderes Format konvertiert werden.

Die Dateitypen und Optionen entsprechen denen oben unter Configure Recording ->
Karteikarte Auto Export: genannten. Zusätzlich kann mit den Radiobuttons unter Export 
angegeben werden, ob alle Kanäle exportiert werden sollen (All Channels) oder nur die in der 
Bauansicht links markierten (Selected Channels). Nach Klick auf OK öffnet sich ein 
Dateiauswahldialog. Gibt man hier eine passende, bereits existierende Datei an, werden die 
Messdaten angehängt; andernfalls wird eine neue Datei mit Header und/oder 
Spaltenüberschriften erstellt. Die erste Spalte enthält stets einen Zeitstempel mit Datum und
Uhrzeit.

Wie auch beim automatischen Export, werden Notizen (Annotations) bei den Zieldateitypen 
Text file und CSV file in der letzten Spalte eingefügt, bei plot-gebundenen Annotations an der 
zeitlich zugehörigen Stelle.

Weitere Exportmöglichkeiten bietet das Rechte-Maustaste Kontextmenü der grafischen 
Ansicht (Mauszeiger in die Grafik, rechte Maustaste->Export):
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Hiermit werden stets nur die in der Grafik sichtbaren Daten exportiert.

• Export Data To Clipboard kopiert die Daten als Text in die Zwischenablage, und zwar 
in folgendem Format (hier nur ein Kanal und zwei Zeilen):
 - Chan. 17_3 Time - Chan. 17_3
14:31:37,106 25.05.2023 -0,789969
14:31:37,106 25.05.2023 -0,791009
Für jeden Kanal wird eine eigene Zeitstempelspalte angelegt. Zeitstempel und Messwerte sind mit Tabulator 
getrennt; Datum und Uhrzeit mit Leerzeichen.

• Export Data To Excel öffnet Excel (wenn auf dem PC vorhanden) und fügt die Daten 
ein; dabei wird für jeden Kanal eine Zeitstempelspalte angelegt. Die Datei kann dann 
mit Excel ggf. bearbeitet und gespeichert werden.

• Export Simplified Image bietet die Möglichkeit, den Grafen als Bild zu exportieren. 
Dabei kann das Format ausgewählt und eingegeben werden, ob das Bild in die 
Zwischenablage (Clipboard) kopiert oder als Datei gespeichert werden soll. Der 

Hintergrund des Bildes ist hierbei weiß, die 
Plotfarbe bleibt unverändert, siehe Bild 
unten.

Kopieren in die Zwischenablage

In der Zwischenablage abgelegte Daten können grundsätzlich nur in geeignete andere 
Programme eingefügt werden, d.h. Daten im Textformat in Text- oder 
Tabellenkalkulationsprogramme und Bilder in Bildverarbeitungsprogramme.

Oben bereits genannte Möglichkeiten sind die des Rechte-Maustasten Kontextmenüs der 
Grafen:  Rechte Maustaste->Export->Export Data To Clipboard zum Kopieren des sichtbaren 
Bereichs als Tabellentext und ->Export->Export Simplified Image->Export to Clipboard zum 
Kopieren des Bildes in die Zwischenablage, das dann z.B. so aussieht:
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Ebenso kann ein Bild kann auch in die Zwischenablage kopiert werden durch rechte 
Maustaste->Copy Data. Hierbei entspricht das Bild mehr der Ansicht des Grafen im File 
Monitor Fenster, d.h. der Hintergrund ist schwarz, z.B.:

Man kann auch einzelne Messwerte oder markierte Bereiche als Text in die Zwischenablage 
kopieren. Dazu benötigt man einen oder zwei Cursor, die wie unter Verwenden des Cursors 
gezeigt, erst erzeugt werden müssen. Dann kann man durch Druck auf die Funktionstasten 
F11 oder F12 folgendes tun:

• F12: Kopieren der Messwerte aller links in der Baumansicht markierten Kanäle bei 
der Cursorposition

• F11: Anhängen der Messwerte aller markierten Kanäle bei der Cursorposition an ggf. 
in der Zwischenablage befindliche Tabellentextdaten

• Halten von Strg-Taste und F11: Kopieren aller zeitlichen Messwerte aller markierten 
Kanäle als Tabellentext zwischen zwei Cursor. Dazu müssen zwei Cursor erzeugt 
wurden sein.14

14 Kopieren des Bereiches zwischen zwei Cursor ist nur mit GSVmulti PRO verfügbar
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• Halten von Strg-Taste und F12: Anhängen aller zeitlichen Messwerte aller markierten 
Kanäle als Tabellentext zwischen zwei Cursor an Tabellentextdaten,14

die sich bereits in der Zwischenablage befinden.

Diese Kopierfunktionen mit F11/F12 kopieren nur die Messwerte ohne Zeitstempel. Die 
Messwerte werden mit Tabulatorzeichen getrennt.
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Kopieren und Einfügen zur Messlaufzeit

Auch während eine Messung läuft, können Messwerte in die Zwischenablage kopiert 
werden, um sie dann in andere Programme einfügen zu können (z.B. Text- oder 
Tabellenverarbeitung).

Mit GSVmulti PRO ist es auch möglich, einen konfigurierbaren String (Text) mit Messwerten 
direkt in andere Programme einzufügen, entweder durch Druck einer Funktionstaste oder 
automatisch durch Überschreiten von Schwellwerten.

Kopieren von Messwerten in die Zwischenablage

Wenn mindestens ein Messwertkanal (Channel) geöffnet ist und GSVmulti den 
Eingabefokus hat, wird bei Druck auf die Funktionstaste F12 ein Text aus Messwerten in die 
Zwischenablage kopiert. Wenn die Zwischenablage bereits einen Text enthält, wird mit 
Druck auf F11 der Zwischenablage ein Text aus Messwerten angehängt. Dies funktioniert 
unabhängig davon, ob eine Messung im Recorder Yt/XY gestartet wurde oder nicht. Die 
Formatierung des Messwerttextes kann bei der Standard-Variante nicht geändert werden 
(Default-Format) und ist bei mehreren Messkanälen wie folgt:

<Messwert Kanal 1><TAB><Messwert Kanal 2><TAB><Messwert Kanal N>

Beispiel mit 6 Kanälen:

-0,004810 0,230499 0,083257 -0,098635 0,094652 -0,870234

Wenn mit F11 Messwerte angehängt werden, wird vor dem Messwerttext ein 
Zeilenumbruch eingefügt, z.B.

Text in Zwischenablage

-0,004293 0,210927 0,108514 -0,122475 0,083306 -0,860497

Dadurch können mehrere Messwertzeilen erzeugt werden, indem man die erste mit F12 in 
der Zwischenablage ablegt und dann mit F11 weitere anfügt, z.B.:

-0,004248 0,198070 0,101477 -0,120024 0,089766 -0,856605

1,996082 0,214995 0,107485 -0,129403 0,104570 -0,860058

Einfügen eines Messwerttextes in andere Programme per F-Taste15

Wenn ein anderes Programm den Eingabefokus hat, kann durch Druck auf eine 
Funktionstaste ein Textstring mit Messwerten hierin eingefügt werden. Diese Funktion kann 
unter Menüleiste->Options->Copy & Paste konfiguriert werden:

15 Diese Funktion ist nur mit GSVmulti PRO verfügbar
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Mit der hier gezeigten Konfiguration wird beispielsweise bei Druck auf F2 in einem anderen 
Programm folgender Text eingefügt:

My values: 1,996199

0,184941 0,098549 -0,111647 0,104588 -0,882169 First:  0,033925

Das Einfügen in ein anderes Programm muss zunächst mit Menüleiste->Action->Enable 
Value Paste by F<no> oder Druck auf F10 ermöglicht werden. Ob eine Messung mit Start 
Measuring gestartet ist, ist dabei nicht relevant. Ist das Einfügen aktiviert, erscheint "Paste to
external enabled" in den Statuszeilen des Hauptfensters.

Die Steuerelemente in Options->Copy & Paste bedeuten im einzelnen:

• Enable Paste function now & at program start Wenn diese Checkbox aktiviert ist, wird 
die Paste-Funktion sofort und beim Neustart des Programms aktiviert. "Paste to 
external enabled" erscheint dann in den Statuszeilen des Hauptfensters.

• Include All Channels Wenn dies aktiviert wird, werden alle vorhandenen Kanäle in den 
Formatierungsstring Output Format eingefügt. Andernfalls können die dort 
eingefügten Kanäle mit Channels to Paste einzeln ausgewählt werden.

• Include Units Wenn diese Checkbox gesetzt ist, wird jedem Messwert seine 
konfigurierte Einheit angehängt, mit einem Leerzeichen zwischen Wert und Einheit.

• Include Timestamp Wenn diese Checkbox gesetzt ist, wird am Anfang des 
Messwerttextes (default) ein Zeitstempel mit Datum eingefügt. Sein Format hängt 
von der Windows-Spracheinstellung (locale) ab und ist bei deutschem wie folgt:
TT.MM.JJJJ HH.MM.SS,bbbbb z.B. 08.08.2023 18:43:46,09986

• Decimal Separator = Period Wenn diese Checkbox gesetzt ist, wird als Dezimaltrenner
auch bei deutschem Windows auf jeden Fall ein Punkt (period) verwendet; 
andernfalls - ja nach Windows-Spracheinstellung - ggf. ein Komma.

• Copy by F11/F12: Settings 
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◦ Auto-Format F11/F12 string Wenn diese  Checkbox nicht gesetzt ist, wird der 
Messwerttext, der bei Fokus auf GSVmulti mit F11/F12 in die Zwischenablage 
kopiert wird, ebenso formatiert wir hier definiert. Andernfalls, d.h. bei gesetzter 
Checkbox, gilt hierbei die in Kopieren von Messwerten in die Zwischenablage 
beschriebene Default-Formatierung.

◦ Regular Newline with F11 Wenn diese Checkbox gesetzt ist, wird, wenn Auto-
Format F11/F12 string nicht gesetzt ist, bei Druck auf F11 immer zuerst ein 
Zeilenumbruch eingefügt.

• Function key for pasting Hiermit sollte die Funktionstaste gewählt werden, mit der der
Messwerttext in das andere Programm eingefügt wird. Hinweis: Es ist sehr 
empfehlenswert, hier eine Funktionstaste auszuwählen, die in dem anderen 
Programm, in das eingefügt werden soll, keine oder keine relevante Funktion auslöst.
Hierzu kann die Bedienungsanleitung jenes Programms dienlich sein oder man 
probiert es erst mal aus. Andernfalls werden wahrscheinlich beide Funktionalitäten 
ausgelöst, was zu Problemen führen kann (möglicherweise zu Fehlfunktion oder 
sogar Absturz dieses anderen Programms).

• Value Type to Copy/Paste Hierin kann ausgewählt werden, ob die Messwerte der 
Hauptanzeige oder die des Single Value Display des Recorder Yt eingefügt werden 
sollen.

◦ Actual Values Die Hauptanzeige "normaler" aktueller Messwerte wird eingefügt, 
wie sie in der Value Display und Configuration Karteikarte angezeigt werden

◦ As Shown in Single Value Display Die numerischen Anzeige des Single Value 
Display im Recorder Yt kann zwischen verschiedenen Anzeigearten umgestellt 
werden, siehe Rekorder Yt. Ist dieser Radiobutton ausgewählt, werden die ggf. 
umgerechneten Werte, die hierin angezeigt werden, zum Einfügen verwendet.

• Channels to Paste Wenn Include All Channels deaktiviert ist, können Messwertkanäle 
dem einzufügenden Messwerttext hinzugefügt werden, indem man jeweils die 
entsprechende Checkbox aktiviert. In der Mitte steht der Kanalname und rechts die 
Kanalnummer. Versteckte Kanäle (hidden) können nicht ausgewählt werden. Beim 
Anwählen einer Kanal-Checkbox erscheint der Platzhalter für den Messwert dieses 
Kanals {Kanalname} im Formatierungsstring Output Format und ab dem erstem Wert 
wird der Default-Separator \T zwischen Messwerten eingefügt. Output Format kann 
zum Schluss manuell editiert werden und gilt letztendlich für die Erzeugung des 
einzufügenden Textes.

Der Formatierungsstring Output Format

Im Formatierungsstring können zwischen den Platzhaltern für variable Einträge, d.h. 
Messwerte {Kanalname} und Zeitstempel {Date Time}, beliebige Texte hineingeschrieben 
werden, die dann im Ausgabetext erscheinen. In diesen Texten können auch die 
Sonderzeichen
\T für einen Tabulator-Einzug (TAB) und
\N für einen Zeilenumbruch an beliebiger Stelle verwendet werden.

Es ist auch möglich, hiermit die Kanalreihenfolge zu ändern. Die Kanalnamen müssen dabei 
aber exakt richtig geschrieben werden.
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Beispiel: Diese Konfiguration:

mit dem Formatierungsstring:

My values: {DateTime}\TNo.1: {Chan. 17_1}\T{Chan. 17_4}\T{Chan. 17_6}\NThat's all

Fügt folgenden Text ein (Messwerte & Zeitstempel natürlich variabel):
My values: 08.08.2023 18:49:31,09163 No.1: 1,995757 mV/V -0,117022 mV/V -0,857558 mV/V

Thats all

Ändert man die Kanalreihenfolge z.B. zu:

My values: {DateTime}\TNo.4: {Chan. 17_4}\T{Chan. 17_6}\T{Chan. 17_1}

Wird folgender Text erzeugt:

My values: 08.08.2023 18:57:55,31113 No.4: -0,094565 mV/V -0,869309 mV/V 1,995695 mV/V

Einfügen eines Messwerttextes in andere Programme per Trigger16

Messwerttexte dieser Art können auch durch Über- oder Unterschreiten von 
konfigurierbaren Schwellwerten automatisch in ein anderes Programm eingefügt werden 
(statt durch Drücken einer Funktionstaste). Damit können z.B. Messwertstrings an 
vorkonfigurierbaren Referenzpunkten oder Wegmarken o.ä. ausgegeben werden. Es kann in 
Menüleiste->Options Trigger & Paste konfiguriert werden:

16 Diese Funktion ist nur mit GSVmulti PRO verfügbar
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Wenn die folgenden vier Bedingungen erfüllt sind, wird jeweils ein Messwerttext in ein 
anderes Programm eingefügt:

• Die Messung wurde im Recorder Yt gestartet

• Die Trigger-Paste Funktion wurde mit der Funktionstaste F8 oder Menüleiste->Action-
>Enable Trigger Paste aktiviert

• Das andere Programm, in das eingefügt werden soll, hat den Eingabefokus

• Die Schwellwertbedingung ist erfüllt, d.h. der Messwert des Trigger Channel hat die 
aktuelle Schwelle über- bzw. unterschritten

Diejenigen Steuerelemente in Options-> Trigger & Paste,  die den gleichen Namen wie in  
Options-> Copy & Paste haben, haben auch die gleiche Funktion, bezogen auf die per 
Triggerbedingung exportierten Messwertstrings. Des weiteren gibt es folgende:

Edit Thresholds: 

Bei Klick öffnet sich ein Fenster, mit dem die Schwellwerte definiert werden können.
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Darin bedeuten:

• Die kleine Zahl ganz links oben (hier im Bild =0) ist der Index des ersten angezeigten 
Schwellwertes. Diese zu bedienen (z.B. auch mit den kleinen Pfeiltasten links 
daneben) ist wichtig, wenn die Anzahl der Schwellwerte >11 ist; andernfalls sollte sie 
=0 sein, um alle Schwellwerte zu sehen.

• Die Zahlen rechts davon (oben) sind die Schwellwerte. Diese können stets manuell 
verändert werden. Ein ausgegrauter Eintrag bedeutet "nicht vorhanden"; man kann 
einen Schwellwert auch löschen, indem man mit der rechten Maustaste hineinklickt 
und Delete Element wählt. Die Schwellwerte sollte in einer regelmäßigen Reihenfolge 
gewählt werden, die zu Threshold Mode (im Options Fenster) passen sollten, s.u.

• Mit Create trigger thresholds = Automatically können die Schwellwerte auch 
automatisch mit gleichmäßigen Abständen erzeugt werden. Dazu wird der erste 
Schwellwert unter From eingetragen, der Abstand unter Increment und der letzte 
Schwellwert unter To. Man kann sie entweder nur aufsteigend (Choosing directions = 
Ascending only) oder auf- und absteigend (Ascending and descending) erzeugen 
lassen. Wenn man dies konfiguriert hat, werden die Schwellwerte mit Klick auf Auto-
Create (Calculate) erzeugt.

• Zum abschließenden Setzen wird OK, Close geklickt

Weitere Steuerelemente in Options-> Trigger & Paste:

• Trigger Channel: Hiermit muss der Kanal ausgewählt werden, dessen Messwerte mit 
den Schwellwerten verglichen werden sollen.

• Threshold Mode: Hiermit wird festgelegt, ob die Schwellwerte in auf- und/oder 
absteigender Reihenfolge vorliegen und ob das Triggerereignis bei Über- oder 
Unterschreiten eines Schwellwertes ausgelöst werden soll:

◦ Ascending only: Die Schwellwerte liegen in aufsteigender Reihenfolge vor und 
getriggert wird bei Überschreiten eines Schwellwertes (wenn also der Messwert > 
Schwellwert wird)

◦ Ascending, then descending: Die ersten Schwellwerte liegen in aufsteigender 
Reihenfolge vor und bei diesen wird bei Überschreiten eines Schwellwertes 
getriggert, die letzten Schwellwerte liegen in absteigender Reihenfolge vor und bei
diesen wird bei Unterschreiten eines Schwellwertes getriggert

◦ Descending only: Die Schwellwerte liegen in absteigender Reihenfolge vor und 
getriggert wird bei Unterschreiten eines Schwellwertes (wenn also der Messwert 
< Schwellwert wird)

• Execution Hiermit kann festgelegt werden, ob die schwellwertbedingte Ausgabe von 
Messwertstrings auch weiterhin erfolgen soll, nachdem ein Schwellwertsatz schon 
komplett durchlaufen wurde (Multiple times) oder nicht (Only once).

• Create Annotation for Recording: Wenn diese Checkbox gesetzt ist, werden bei den 
Triggerereignissen Annotations gesetzt, d.h. Notizen, die an diesen Stellen dem 
aufgenommenen tdms Dateien kurze Texte mitgeben, die im File Monitor angezeigt 
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werden, nämlich "Threshold No <nummer> exceeded" (Schwellwert überschritten) 
oder "Value below threshold No. <Num>" (Schwellwert unterschritten).

Notizen (Annotations) in Messwertdateien

Es besteht die Möglichkeit, in aufgenommene *.tdms Messwertdateien Texte hinzuzufügen, 
z.B. um Informationen über die Art oder die Bedingungen der Messung mit dem 
Messwertkurven zu speichern. Diese Texte werden im File Monitor angezeigt und können 
auch in Textformate exportiert werden. Sie können während der Messung gesetzt werden 
oder nachträglich im File Monitor.

Setzen von Notizen während der Aufnahme einer Messung

Nachdem eine Messwertaufnahme z.B. mit Start Recording gestartet wurde, können 
Notizen gesetzt werden, indem man mit der rechten Maustaste in den Grafen des Recorder 
Yt (oder Recorder XY) hineinklickt und dann im Kontextmenü Annotation... wählt.

Dann öffnet sich das Annotations Fenster.

Der Testcursor ist automatisch in die oberste Texteingabezeile gesetzt, so dass man den 
neuen Text gleich eingeben kann. Die Notiz kann mit Assigned Channel einem bestimmten 
Kanal zugeordnet werden oder nicht zugeordnet (Free). Man kann hier auch vorher gesetzte 
Texte bearbeiten.

Es ist auch möglich, Texte einzugeben, bevor die Aufnahme gestartet wurde, sie werden 
dann einer kommenden Aufnahme hinzugefügt. Der zugeordnete Zeitpunkt ist dann der 
Start der Aufnahme. 
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Die Checkbox Delete Annotations for next Recording after this recording has finished gilt 
dann für die übernächste Aufnahme, da aktuell noch keine läuft. Die Notiz wird also in jedem
Fall der kommenden Aufnahme hinzugefügt; ist diese Checkbox gesetzt, wird sie 
anschließend gelöscht, so dass die übernächste Aufnahme sie nicht mehr enthält; ist sie 
nicht gesetzt, werden die Annotations jeder Aufnahme hinzugefügt. Dieses Verhalten kann 
auch unter Menüleiste -> Options -> Preferences -> At Start Measuring mit der Checkbox 
Delete Annotations eingestellt werden, die die gleiche Funktion hat. Ist sie gesetzt, werden 
alle Notizen, die der letzten Aufnahme hinzugefügt wurden bei einer neuen Aufnahme 
gelöscht.

Im File Monitor werden die Notizen nur mit Yt Daten angezeigt17:

17 Wenn sie im XY Recorder gesetzt wurden, sind sie zwar vorhanden, können aber nicht angezeigt werden. 
Wenn man in Settings... Show XY Data as Yt Diagram aktiviert, werden sie angezeigt. Auch bei Export in ein
Textformat werden sie exportiert.
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Ein einem Kanal zugeordneter Text wird mit einem Pfeil auf diesen Plot versehen, ein freier 
Text nicht. Der Pfeil zeigt auch auf den Zeitpunkt, zu dem im Kontextmenü Annotation... 
geklickt wurde.

Mit dem Cursor-Zeiger kann die Position des Textes oder der 
Zeitpunkt / Pfeil verschoben werden:

Wenn man dies getan hat, so wird beim Schließen des File 
Monitors gefragt, ob die Datei gespeichert werden soll, weil 
diese Information (Text- und Zeitposition) mitgespeichert 
wird.

Wenn die tdms Datei in ein Textformat exportiert wird (Text File oder CSV File), so werden 
die Notizen darin in der letzten Spalte eingefügt, zu den Zeitpunkten, zu denen sie gesetzt 
wurden. Beim Export in das Excel-, InfluxDB- oder GSV-6-Format werden die Notizen nicht 
mit exportiert.

Setzen von Notizen im File Monitor

Auch im File Monitor kann man neue Notizen setzen, indem man mit der 
rechten Maustaste in den Graphen hineinklickt und im Kontextmenü Create 
Annotation wählt.
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Der Text wird dann in dem folgenden Fenster unter Annotation Name eingegeben:

Die Notiz kann mit Lock Style einem bestimmten Kanal 
zugeordnet werden (Snap to One Plot) oder als nicht 
zugeordnet (Free) definiert werden. Der zugeordnete Kanal 
wird mit Locked Plot ausgewählt.

Beim Schließen des File Monitors wird man dann gefragt, 
ob man speichern möchte, damit die neuen Notizen mit 
gespeichert werden.

Offset und Nullpunkt

Mit der Schaltfläche Set Zero in der Configuration Karteikarte wird der Messverstärker dazu 
veranlasst, den Eingangs-Rohwert auf Null zu setzen. Dabei ermittelt er einen Summanden 
"Roh-Offset", den er den Roh-Messwerten hinzuaddiert.

Bei Mehrachsensensoren und bei Spannungsmessung mit Rosetten-DMS müssen alle 
zugehörigen Eingangskanäle auf Null gesetzt werden, damit die Berechnung der 
physikalischen Größen richtig bleibt. Daher ist diese Schaltfläche bei Kanälen, die zu 
Mehrachsensensoren gehören, ausgegraut. Man verwendet dann stattdessen Set All Zero in 
der Karteikarte Recorder Yt oder Recorder XY.

Bei den Messverstärkern GSV-2, GSV-6 und GSV-8 kann zusätzlich ein User Offset verwendet
werden, den der Messverstärker nach Multiplikation mit dem Skalierungsfaktor (User 
Scaling) addiert. Die Messwertverarbeitung kann mathematisch so ausgedrückt werden:

Messwert = (RohMesswert+RohOffset) x Sensorskalierung + User Offset
Die Sensorskalierung entspricht bei Standardsensoren einer Multiplikation mit der User Scaling, bei 
Mehrachsensensoren ist es eine komplexere Berechnung (siehe S. 39 bzw. S.46).

Das heißt, der User Offset kann auch bei Mehrachsensensoren für einzelne Kanäle 
verwendet werden. Er wird in der Karteikarte Configuration unter User Offset / Tare 
angezeigt.

Klickt man auf diese Zahl, gelangt man in den Dialog zur Einstellung des User-Offset:

Man kann hiermit in New User Offset direkt einen neuen Offset eingeben und mit OK / Set 
speichern oder einen neuen Wert berechnen lassen. Dazu gibt man den gewünschten 
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Messwert in Desired Measuring Value ein (oder belässt hier 0) und klickt dann auf Calculate. 
Es werden automatisch einige Messwerte genommen und der berechnete Wert erscheint 
anschließend in New User Offset. Mit OK / Set im Gerät speichern.

Einschränkungen des Nullsetzens

Bei Temperatursensoren PT1000 und Typ K ist das Nullsetzen mit Set Zero im 
Ausgangszustand nicht erlaubt, ähnliches gilt für den Single-ended Spannungseingang.

Bei Klick auf Set Zero erscheint dann diese Meldung:

Bei Spannungseingängen will man oft die absolute Spannung messen, wie bei einem 
Voltmeter und eine Nullpunktänderung würde dies verfälschen. Auch bei der 
Temperaturmessung würde Nullsetzen die Messung verfälschen, es sei denn, der Sensor 
hat die Temperatur 0°C.

Um diese Einschränkungen aufzuheben, klickt man in der Menüleiste auf Options und wählt 
die Karteikarte Hardware:
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Um das Nullsetzen für Spannungseingänge zu erlauben, belässt man links oben Prohibit for 
temperature inputs und löscht den Check-Haken bei Prohibit for single-ended voltage input. 
Beim GSV-4 muss zusätzlich der Check-Haken bei Allow for single-ended with GSV-4 gesetzt 
werden. In diesem Fall (GSV-4) muss dann das Passwort berlin eingegeben werden. Am 
Ende mit OK bestätigen.

Um auch das Nullsetzen für Temperatureingänge zu erlauben, muss unter Allow Set zero 
Always allow gewählt werden.

Diese Konfiguration wird - wie alle Einstellungen im Options Menü - nicht im Messverstärker 
gespeichert, sondern in den Softwareeinstellungen.

Einschränken des Nullsetzens für Einzelkanäle

Der GSV-8 erlaubt zusätzlich auch in den Geräteeinstellungen die Konfiguration des 
Nullsetzverhaltens für Brücken- und Spannungseingänge18 Dies kann im Dialog Input Type 
(Karteikarte Configuration) unter Setting Zero Behaviour eingestellt werden:

Folgende Optionen sind hierbei möglich:

• Set Zero allowed, Relative Measuring: Das Nullsetzen ist erlaubt

• Set Zero prohibited, uses calibrated zero-point. Absolute measuring: Nullsetzen wird 
unterbunden und absolute ("wahre") Spannung oder Brückenverstimmung wird 
gemessen. Der verwendete RohOffset (s.o.) ist ein Hersteller-Kalibrierwert, der nur interne 
Offsetfehler des Verstärkers kompensiert, keine externen. Der aktuell eingestellte RohOffset 
geht u.U. verloren.

18 Ab Firmware-Version 1.54
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• Set Zero prohibited, uses actual / primary zero-point: Nullsetzen wird unterbunden und
der aktuell eingestellte Roh-Offset wird belassen.

Speicherverhalten des Nullpunktes beim GSV-6

Beim GSV-6 kann unter Menüleiste  → Device  Advanced Settings  → →
Administration festgelegt werden, ob der Nullpunkt nichtflüchtig gespeichert 
werden soll. Im Auslieferungszustand ist das der Fall (und bei allen anderen 
GSVs fest so eingestellt), d.h. nach einem Nullsetzen mit Set Zero / Set All Zero 
wird der Nullpunkt nach Aus- und Einschalten des Gerätes wieder hergestellt 

(Store value non-volatile). Wenn man das Speichern abschaltet (Don't Store (volatile)), geht 
der Nullpunkt nach dem  Aus- und Einschalten verloren. Diese Einstellung kann sinnvoll sein, 
wenn der Nullabgleich sehr oft ausgelöst wird, z.B. durch eine Maschine oder eine Anlage, 
beispielsweise pauschal vor jedem Messvorgang. Der Flash-Speicher des Nullpunktes (und 
aller anderen Betriebsparameter) nutzt sich nämlich ab und durch Deaktivieren des 
Speicherns wird einer Überschreitung der maximalen Speicheranzahl vorgebeugt.

Automatisches Nullsetzen (Auto-Zero)

Die Geräte GSV-2 und GSV-8 können so konfiguriert werden, dass sie unter bestimmten 
Bedingungen selbstständig einen Nullabgleich durchführen, nämlich dann, wenn der 
Messwert für eine bestimmte Zeit innerhalb eines Bereiches um Null herum bleibt. Dieses 
Zeitintervall und der Bereich sind einstellbar, und zwar in Menüleiste  → Device  Advanced →
Settings  Value Mode  Auto-Zero.→ →
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Diese Funktion kann z.B. 
sinnvoll sein, um 
thermische Drift eines 
Sensors zu unterdrücken;
hierbei würde man die 
Schwelle nahe Null 
setzen und bei der 
Messung darauf achten, 
dass die Last häufig und 
dann ausreichend lange 
entfernt wird. Bei 
Messung einer Dauerlast,
die nie auf Null geht, ist 
die Auto-Zero Funktion 
weniger geeignet; der 
GSV-2 stellt für diesen 
Anwendungsfall einen 

besonderen Driftkompensationsalgorithmus zur Verfügung, s.S. 

Beim GSV-2 entspricht der Auto-Zero Schwellwert dem unteren des Schwellwertschalters 
Nr. 1, d.h. ein Nullabgleich wird nach der angegebenen Zeit ausgeführt, wenn der 
Schwellwertschalter 1 inaktiv ist.

Das Zeitintervall (Time interval) wird bei GSV-2 und GSV-8 intern als Zählwert gespeichert, 
der Messwerte zählt, d.h. nach einer Änderung der Messdatenrate muss es ggf. neu gesetzt 
werden.

Nach Änderung der Einstellungen ist unten Store to device zu klicken.

Beim GSV-8 können die Bedingungen für das automatische Nullsetzen zwischen den 
Kanälen verknüpft werden. Diese erweiterte Einstellungen öffnen sich nach Klick auf Drift 
Compensation More...

Im oberen Bereich sind 
Einstellungen, die für alle Kanäle 
gelten, die im unteren gelten für 
den mit Channel gewählten 
Eingangskanal.

• Auto-Zero enabled: Hiermit 
kann die gesamte Funktion
global aktiviert und 
deaktiviert werden.

• If Condition(s) met: Time 
Interval to Set Zero: Hier 
wird das Zeitintervall 
angezeigt oder eingestellt, 
nach dessen Ablauf das 
Nullsetzen durchgeführt 
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wird, wenn die anderen Bedingungen zutreffen. Intern wird es als Zählwert 
gespeichert, s.o.

• Channel Handling: Hier kann gewählt werden, ob die Schwellwertbedingung für jeden 
Kanal unabhängig geprüft wird oder für alle Kanäle gemeinsam:

◦ Independent from each-other bedeutet, dass das Zeitintervall für jeden Kanal 
unabhängig und einzeln gezählt wird, solange sein Messwert innerhalb seines 
jeweiligen Schwellenbereichs liegt, sofern der Kanal entsprechend konfiguriert ist.

◦ Grouped: Conditions ANDed bedeutet, dass das Zeitintervall weitergezählt wird, 
wenn alle Kanäle, bei denen Apply Threshold Condition for this Channel aktiviert 
ist, unter ihrem individuellen Schwellwert bleiben.

Null gesetzt werden die Messwerte dann, wenn das Zeitintervall abgelaufen ist und 
bei diesem Kanal Perform Auto-Zero for this Channel aktiviert ist.

• Channel: Hier wird der Kanal gewählt, für den die folgenden Einstellungen gelten, 
sofern Apply the same settings for all Channels nicht aktiviert ist.

• Perform Auto-Zero for this Channel: Automatisches Nullsetzen bei diesem Kanal 
durchführen, wenn die anderen Bedingungen erfüllt sind.

• Apply Threshold Condition for this Channel: Wenn auch Grouped: Conditions ANDed 
aktiv ist, kann hiermit ausgewählt werden, ob die Schwellwertbedingung zur 
Zeitintervallzählung bei diesem Kanal geprüft wird, s.o.

• Value Range, where Auto-Zero is applied after time interval is reached: Hier wird der 
Schwellwertbereich um Null festgelegt, wobei der Wert in From <0 und in To >0 sein 
muss und es gilt: From = -To. An besten gibt man nur den positiven in To ein, From 
wird dann automatisch gesetzt.

• Apply the same settings for all Channels: Wenn aktiv, gelten die kanalspezifischen 
Einstellungen für alle Eingangskanäle gleichermaßen.

Am Ende werden Änderungen mit Store to device gespeichert.
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Analoge und digitale Filter

Filter wirken im Frequenzbereich des Messsignals, sie lassen also nur einen bestimmten 
Frequenzbereich durch und die anderen Bereiche werden abgeschwächt (gedämpft). Alle 
GSV-Messverstärker wirken originär als Tiefpassfilter, d.h. sie verarbeiten Messsignale von 
gleichbleibenden Größen mit f=0 bis zu einer bestimmten Grenzfrequenz fg. Die 
Grenzfrequenz ist diejenige Signalfrequenz, bei der die Amplitude bereits um -3dB, d.h. um 
den Faktor 0,707 gedämpft ist. Bei einem Tiefpass steigt die Dämpfung oberhalb dieser 
Grenzfrequenz weiter an. Bei digitalen Messverstärkern ergibt sich diese aus der 
Messdatenrate (s. S. 17), dem analogen Vorfilter und ggf. einem zusätzlichen Digitalfilter, s. 
S. 98. Wirksam für die Bandbreite des Messsignals ist die jeweils niedrigste dieser zwei bzw.
drei Tiefpass-Grenzfrequenzen.

Analogfilter

Alle digitale GSV-Messverstärker haben ein analoges Vorfilter, das in der 
Signalverarbeitungskette vor dem AD-Umsetzer liegt. Üblicherweise liegt seine 
Grenzfrequenz bei der Hälfte der maximalen Messdatenrate oder darunter.

Die Einstellungen des Analogfilters können beim GSV-2 und beim GSV-8 unter Menüleiste  →
Device  Advanced Settings  Filter  Which Filter = Analog→ → →  verändert werden:
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Beim GSV-2 und beim GSV-8 ist die analoge Grenzfrequenz in drei Stufen schaltbar. In der 
Ausgangskonfiguration ist Set automatically, according to data rate gesetzt und dann wird es
anhand der Messdatenrate automatisch eingestellt:

Modell (Zusatzbedingung) Messdatenrate Analogfilter: Grenzfrequenz

GSV-2
(ohne FIR-Filter, s.u.)

Kleiner oder gleich 7,14/s 3,5 Hz

Von 96 bis 625/s 260 Hz

Größer oder gleich 625/s 1700 Hz

GSV-2
(mit FIR-Filter, s.u.)

Kleiner oder gleich 15/s 3,5 Hz

Von 15 bis 1071/s 260 Hz

Größer oder gleich 1071/s 1700 Hz

GSV-8 Kleiner oder gleich 80/s 28 Hz

Von 96 bis einschließlich 3000/s 850 Hz

Oberhalb von 3000/s 11400 Hz

Die Grenzfrequenz wird unter Lower Cut-off frequency [Hz] angezeigt. Wenn  Set 
automatically, according to data rate nicht gesetzt ist, kann die Grenzfrequenz mit Cut-off 
frequency manuell ausgewählt werden.

Da GSV-2 und GSV-8 beide mit Sigma-Delta AD-Umsetzern ausgestattet sind, liegt die originale 
Eingangs-Samplingfrequenz im Mhz-Bereich und das analoge Vorfilter wirkt daher bei jeder der drei 
Einstellmöglichkeiten auch als Anti-Aliasing Filter.

Digitalfilter

Digitalfilter sind in der Geräte-Software implementiert, d.h. sie verarbeiten digitale (zeit- und 
wertdiskrete) Signale. Grundsätzlich gibt es bei GSV-Geräten zwei verschiedene Typen: FIR- 
und IIR-Filter. Bei Digitalfiltern hängen die Grenzfrequenzen von der Messdatenrate ab; sie ist
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stets kleiner als die Hälfte der Messdatenrate und wirkt tatsächlich als ein Divisor (d.h. ein 
Faktor <1) zur Messdatenrate. Bei einer Änderung der Datenrate ändert sich die 
Grenzfrequenz daher dementsprechend. GSVmulti zeigt die Messdatenrate in 
Konfigurationsfenster mit an.

FIR-Filter

Ein FIR-Filter (Finite Impulse Response) verarbeitet nur eine Folge von Eingangs-
Messwerten, diese Folge besteht aus dem aktuellen und zeitlich zurückliegenden, 
ungefilterten Messwerten. Es ist immer stabil, d.h. das Ausgangssignal enthält ungeachtet 
der Filtereinstellungen und des Eingangssignals keine Artefakte, es entspricht also dem 
Eingangssignal oder den Eingangssignal mit kleinerer Amplitude. Allerdings bedingt es wie 
alle Filter eine gewisse zeitliche Verzögerung, die Filterlaufzeit.

Ein wichtiger Parameter ist die Filterordnung, sie bestimmt, wie steil die 
Übertragungsfunktion im Dämpfungsbereich ist. Je höher die Ordnung, desto steiler ist es, 
d.h. Frequenzen oberhalb der Grenzfrequenz werden stärker gedämpft; allerdings ist bei 
höherer Ordnung auch die Laufzeit länger, siehe Bilder unten.

Die Geräte GSV-2, GSV-3 und GSV-8 bieten FIR-Tiefpassfilter, sie werden unter Menüleiste  →
Device  Advanced Settings  Filter  Which Filter = → → → Digital FIR konfiguriert. Unten links 
kann das Filter mit Use Filter aktiviert (enabled) oder deaktiviert (disabled) werden.

GSV-2: Zwei verschiedene zuschaltbare FIR-Filter zuschaltbar, eines zweiter Ordnung 
mit der -3dB-Grenzfrequenz = Messdatenrate * 0,18. Seine Übertragungsfunktion ist 
sanft, ohne Überschwinger in der Sprungantwort und es hat eine Laufzeit von nur 3 
Messwerten.

Außerdem eines 5. Ordnung mit Grenzfrequenz = Datenrate * 0,23. Seine 
Übertragungsfunktion ist im Dämpfungsbereich viel steiler, allerdings mit ca. 6% 
Überschwinger in der Sprungantwort; außerdem beträgt die Laufzeit 6 Messwerte.

GSV-3: Der GSV-3 bietet nur das FIR-Filter 2. Ordnung mit der gleichen Charakteristik 
wie beim GSV-2.

GSV-8: Beim GSV-8 kann das FIR Tiefpassfilter für jeden Kanal individuell eingestellt 
werden, wobei die gewünschte Grenzfrequenz unter Cut-off frequency [Hz] 
eingegeben wird. Die Filterordnung kann manuell unter Filter Order ausgewählt 
werden oder automatisch gesetzt werden, wenn die daneben liegende Checkbox Set 
Automatically gesetzt ist. Der Wertebereich reicht von 4 bis 14 in Zweier-Schritten 
(d.h. nur gerade Ordnungen sind möglich). Bei automatischer Wahl der Filterordnung 
wird das Filter laufzeitoptimiert, d.h. die niedrigst mögliche Ordnung wird gewählt. Die
Nenn-Dämpfung im Sperrbereich, d.h. oberhalb der Grenzfrequenz ist fest auf 60dB 
eingestellt. 
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IIR Filter

IIR Filter können beim GSV-6 und bei GSV-8 für jeden Kanal individuell konfiguriert werden. 
Ein IIR-Filter (Infinite Impulse Response) verarbeitet sowohl eine Folge von Eingangswerten 
als auch eine von Ausgangswerten vorheriger Filterdurchläufe. Dadurch kann bei niedrigerer 
Ordnung oft eine bessere Filtercharakteristik im Frequenzbereich erzielt werden. IIR Filter 
können instabil sein, der Berechnungsalgorithmus von GSVmulti vermeidet jedoch instabile 
Ergebnisse. Unter Umständen wird dann eine der folgenden Fehlermeldungstexte 
ausgegeben:

"DLL.Dfilter: Digital filter calculation failed to converge"
"DLL.Dfilter: Resulting coefficients discarded, because they may limit measuring precision (sum too big)"
"DLL.Dfilter: Resulting coefficients discarded, because they may limit measuring precision (gain too big)"

Die Filterordnung ist festgelegt auf vier. Beim IIR Filter kann mit Filter Type zwischen vier 
verschiedenen Filtertypen (Charakteristiken) gewählt werden, die sich dadurch 
unterscheiden, ob niedrige oder hohe Frequenzen oder bestimmte Frequenzbereiche 
durchgelassen oder gedämpft werden.

• Low Pass: Tiefpassfilter: Niedrige Frequenzen unterhalb der Grenzfrequenz werden 
durchgelassen, oberhalb werden sie gedämpft.  Anwendungsbeispiel: Störungs- oder 
Vibrationsunterdrückung für bestimmte Eingangskanäle.

• High Pass: Hochpassfilter: Frequenzen oberhalb der Grenzfrequenz werden 
durchgelassen, darunter legende werden gedämpft. Dadurch wird auch eine 
gleichbleibende Größe (f=0) unterdrückt. Anwendungsbeispiel: 
Schwingungsmessung oder Erkennung von zeitlichen Änderungen (Transienten).

• Band Pass: Bandpassfilter: Frequenzen unterhalb der unteren Grenzfrequenz (Lower 
Cut-off frequency) und oberhalb der oberen Grenzfrequenz (Upper Cut-off frequency) 
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werden gedämpft und Frequenzen, die zwischen diesen beiden Grenzfrequenzen 
liegen, werden durchgelassen. Anwendungsbeispiel: Messung von Schwingungen in 
bestimmtem Frequenzbereich.

• Band Stop: Bandsperre: Frequenzen zwischen der unteren Grenzfrequenz (Lower Cut-
off frequency) und der oberen Grenzfrequenz (Upper Cut-off frequency) werden 
gedämpft. Anwendungsbeispiel: Unterdrückung einer bestimmten Störfrequenz oder 
von Vibration.

Filterkonfiguration und -simulation mit GSV-6 und GSV-8

Typischerweise werden die Bedienelemente in Menüleiste  → Device  Advanced Settings  → →
Filter in der Reihenfolge von oben nach unten bedient. Soll die Konfiguration für die 
Eingangskanäle unterschiedlich sein oder nur für einen Kanal gelten, wählt man diesen 
zuerst mit Input Channel aus. Wenn Filter bereits konfigurierte sind, wird dies unter 
Configured filter(s) angezeigt, und zwar: None (noch nie konfiguriert) IIR, FIR oder FIR and IIR 
(beide). Mit Which Filter wählt man beim GSV-8 zum Anzeigen oder Konfigurieren zwischen 
IIR und FIR. Mit Filter Type wählt man beim IIR Filter die Charakteristik aus (Low Pass, High 
Pass, Band Pass oder Band Stop, s.o.). Hat das Filter nur eine Grenzfrequenz (Low Pass / 
High Pass), wird diese unter Cut-off Frequency angezeigt bzw. bedient. Hat es eine untere 
uns eine obere, wird diese unter Lower Cut-off frequency (untere) und  Upper Cut-off 
frequency (obere) angezeigt bzw. bedient. Beim FIR-Filter kann ggf. die Filterordnung unter 
Filter Order verändert werden (s.S. 99).

Durch Klicken auf den Button Frequency Response Show→  wird das Filter im 
Frequenzbereich simuliert. Dabei ist dann rechts im Bild auf der X-Achse die Frequenz im 
Bereich f=0 bis f= Fa/2 aufgetragen und auf der Y-Achse die Dämpfung in dB (Dezibel), so 
dass 0dB bedeutet: Frequenz wird durchgelassen. Mit dem Button Step Response Show→  
wird das Filter im Zeitbereich simuliert. Dabei wird ein Sprung auf das Filter gegeben, dessen
Amplitude zum Zeitpunkt t=0 von 0 auf 1 springt und das Ausgangssignal des Filters, die 
Sprungantwort, wird rechts im Graphen dargestellt. Auf der X-Achse ist die Zeit in Sekunden 
aufgetragen und auf der Y-Achse der Amplitudenverlauf als Faktor, wobei 1 der 
Eingangsamplitude bei t>0 entspricht. Damit können Laufzeit und Überschwinger bestimmt 
werden. Der Filtersimulator bildet den wahren Rechenkern mit dem Original-Algorithmus des GSV-6 
und des GSV-8 in Zeitbereich ab. Mit Show Coefficients können die Filterkoeffizienten, d.h. das 
Ergebnis der Filterbestimmung, angezeigt werden.

Mit Store to Device wird die angezeigte Filterkonfiguration im Gerät gespeichert. Ist dabei die
Checkbox Apply to all input channels gesetzt, wird es für alle Eingangskanäle gesetzt. Ist Use
Filter auf Enabled gesetzt, wird das Filter im Gerät aktiviert; ist zugleich Apply to all input 
channels gesetzt, wird das Filter bei allen Eingangskanälen mit konfigurierten Filtern aktiviert
und mit Use Filter = Disabled wird es abgeschaltet. 

Es ist sehr empfehlenswert, die Filtersimulation mit Frequency Response und Step Response
durchzuführen, weil das Filter hierbei berechnet wird und man eventuelle Unstimmigkeiten 
früh erkennt. Im folgenden sind Beispiele von Simulationsergebnissen aller Filtertypen von 
IIR-Filtern beim GSV-6 dargestellt.
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Kommunikationsinterfaces und Messdatenframes

Ein Kommunikationsinterface, auch Schnittstelle genannt, besteht aus einem oder mehreren
elektrischen Signalen, die Information übertragen. Bei GSV-Geräten kann das serielle 
Interface auf unterschiedlichen Hardware-Anschlüssen laufen, z.B. USB, UART, RS232, 
RS422, Ethernet oder Bluetooth-Classic/SPP. Im Add Channel Dialog wird das richtige 
Kommunikationsinterface anhand des gewählten Gerätetyps (Device Type) automatisch 
gewählt; mit Ausnahme des GSV-6, bei dem mit Communication Interface zwischen 
Serial/USB/BT und CAN gewählt werden kann. Für CAN benötigt man einen Adapter, s.S.
107.

Bitrate / Baudrate, Ein / Aus

Die seriellen Schnittstellen aller GSV-Geräte haben die Grundkonfiguration 8 Datenbits, keine 
Parität und 1 Stopbit (8N1)19. Die Kommunikations-Bitrate muss im Add Channel Dialog bei 

19 Ausgenommen seltene Sondertypen wie z.B. GSV-2 mit Parität
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den meisten Geräten richtig gewählt sein. Dies gilt nicht für das USB-Interface des GSV-8 
und des GSV-2MSD-DI und beim Bluetooth-Classic Interface (z.B. GSV-6BT). Bei diesen 
Geräten ist die Einstellung Bits/s in Add Channel an diesen Interfaces irrelevant. Das gilt auch für 
GSV-8 über Ethernet, weil hier ein Umsetzer-Gerät, z.B. Moxa,  dazwischen geschaltet ist, in welchem
die Bitrate allerdings richtig konfiguriert sein muss.

Bei Auswahl des Gerätetyps 
(Device Type) wird die Default-
Bitrate vorgeschlagen; ist diese 
jedoch im Gerät anders 
eingestellt, muss sie mit Bits/s 
dementsprechend ausgewählt 
werden. Dabei am besten die 
kleinen Pfeiltasten verwenden, 
denn das Bedienelement enthält
eine Liste der in diesem Gerät 

vorhandenen Bitraten (=Baudraten).

Die Bitrate von seriellen Interfaces ist einer der Hauptfaktoren, die die maximal einstellbare 
Messdatenrate einschränken (s. S. 17 und 111); dies gilt jedoch nur, wenn sie relevant ist. 
Der GSV-8 und einige GSV-2 und GSV-6 Modelle haben mehrere Kommunikationsinterfaces 
und die niedrigste relevante Bitrate eines aktivierten Interfaces schränkt die maximale 
Datenrate am meisten ein. Beim GSV-8 kann das die Bitrate einer UART, RS422 oder CAN-
Schnittstelle sein.

Sehr hohe Bitraten können mit bestimmten Hardware-Schnittstellen jedoch nicht übertragen
werden; z.B. ist die maximale Standard-Bitrate bei RS232-V24 oft nur 115200 Bits/s; auch 
ein sehr langes Schnittstellenkabel wirkt hier einschränkend.

Bitrate und Ein- Ausschaltzustand von Schnittstellen werden unter Menüleiste -> Device -> 
Advanced Settings -> Interface bedient. Welche Interfaces bedienbar sind, hängt von der 
Geräteausführung ab; die Karteikarte Interface ist ggf. nicht vorhanden. Nur bei GSV-2, GSV-
6 und GSV-8 können Bitraten verändert werden; beim GSV-2 muss hierzu ein 
Konfigurationsjumper gesetzt sein; siehe GSV-2 Bedienungsanleitung.
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Änderungen an Schnittstelleneinstellungen werden erst nach einem Neustart des Gerätes 
wirksam. Nach Klicken auf Store to Device wird das im Text Info vermerkt:

Beim GSV-8 kann UART, RS422 und das CAN-Interface mit der Enabled On/Off Checkbox 
abgeschaltet werden, sofern sie vorhanden sind. Das zu tun ist sinnvoll, wenn es nicht 
benötigt wird, weil die maximal einstellbare Messdatenrate dann größer ist. Jedes Gerät hat 
mindestens eine Schnittstelle, die nicht abschaltbar ist, bei GSV-8 ist das USB.

GSV-8 mit Ethernet verwendet die UART-Schnittstelle für das Ethernet-Umsetzer-Gerät; die Bitrate muss 
also bei beiden Geräten (GSV-8 und Ethernet Umsetzer) gleich eingestellt werden. Mit GSVmulti kann dies
nur GSV-8-seitig getan werden; der Ethernet (TCP-IP) Device Server Moxa Nport5110A wird über Ethernet 
konfiguriert.

Die RS422 Schnittstelle ist differentiell, d.h. das Sende- und Empfangssignal verwendet jeweils zwei 
Leitungen, insgesamt fünf. Dadurch sind deutlich höhere Bitraten und längere Leitungen realisierbar.

Folgende Bitraten werden unterstützt; der Defaultwert ist fett gesetzt:

GSV-2 und GSV-3, je nach Ausführung UART, RS232, USB, RS422: 4800, 9600, 19200, 38.400, 
57.600, 115.200, 230.400, 250.000, 460.800, 625.000, 921.600, 1.250.000. Größer als 
230.400 ist für RS232-V24 nicht empfohlen.

GSV-6:  je nach Ausführung UART, Ethernet, USB:  19.200, 38.400, 57.600, 115.200, 230.400,  
460.800, 921.600.

GSV-6 CAN-Schnittstelle: 25.000, 50.000, 100.000, 125.000, 250.000, 500.000, 1000.000

GSV-8 UART 3,3V, Ethernet: 19.200, 38.400, 57.600, 115.200, 230.400, 460.800
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GSV-8 RS422: 19.200, 38.400, 57.600, 115.200, 230.400,  460.800, 921.600, 1.250.000, 
1.458.333, 1.750.000, 2.500.000, 3.500.000

GSV-8 CANopen: 50.000, 100.000, 125.000, 250.000, 500.000, 1.000.000

GPS/GNSS und User-Device20, seriell, USB: 2400, 4800, 9600, 19.200, 38.400, 57.600, 115.200,
230.400, 460.800, 921.600. Die Bitrate wird im Add Channel Dialog gewählt, verändern kann 
GSVmulti sie bei diesen Geräten nicht.

Permanente Messdatenübertragung

Im Auslieferungszustand senden alle Messverstärker selbstständig Messwerte mit der 
eingestellten Messdatenrate. Die selbstständige Messdatenübertragung kann beim GSV-2, 
GSV-3, GSV-6 und GSV-8 unter Menüleiste  → Device  Advanced Settings  Value Mode  → → →
Value frame Transmission konfiguriert werden. 

Auch wenn sie abgeschaltet ist, zeigt GSVmulti in der Regel 
dennoch Messwerte an, weil es die Übertragung beim Öffnen des 
Gerätes temporär startet, d.h. es führt dann pauschal Start 
Transmission aus.

Die Einstellung der permanenten Datenübertragung, die dauerhaft 
gespeichert wird, gilt also vor allem nach dem Einschalten des 
Gerätes. Sie wird unter Permanent value transmission non-volatile 
state bedient. Ist die obere Auswahl Values transmitted 
permanently aktiv, sendet das Gerät nach dem Einschalten 
Messwerte, ist hingegen Values NOT transmitted permanently aktiv,
tut es das nicht. Falls ein Gerät nach dem Deaktivieren sofort 
aufhört Messwerte zu senden, wird in der Configuration Karteikarte
des Hauptfensters statt dem Messwert nach einer gewissen Zeit 
timeout angezeigt. Das kann temporär dadurch behoben werden, 
dass man den Button Start Transmission unter Value frame 

transmission -> Volatile state klickt. Die Soft-LED Actually transmitting values leuchtet dann 
wieder.

Die Abschaltung der permanenten Datenübertragung ist beispielsweise bei folgenden 
Anwendungen sinnvoll:

• GSV-6BT mit hoher Messdatenrate >200/s, um den Bluetooth-Verbindungsaufbau zu 
erleichtern. Der Set Frequency Dialog aktiviert dies ggf. selbst dementsprechend.

• Per Digitaleingang getriggerte Messdatenübertragung, s. S.119

• Andere Software, die z.B. Messwerte nur auf Anfrage (per Kommando Get Value) 
einliest

CAN- und CANopen Einstellungen

Neben der Bitrate können für die CAN-Schnittstelle ein oder mehrere CAN-IDs geändert 
werden. CAN ist ein Bussystem, an dem mehrere Geräte, sogenannte Nodes, angeschlossen
sein können. GSVs mit CAN haben darüber hinaus mehrere Dienste, z.B. Messdaten-Senden,
Befehle Empfangen und Befehlsantworten senden. Geräte und Dienste werden am CAN-Bus

20 Diese Gerätetypen sind nur mit GSVmulti PRO verfügbar.
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durch die CAN-IDs unterschieden; jede CAN-ID darf daher am gleichen Bus nur einmal 
vorkommen. Beim CANopen Anwendungsprotokoll (GSV-2 und GSV-8) kann nur die Geräte-
ID (Node-ID) verändert werden, die CAN-IDs der Dienste ergeben sich daraus auf eine Weise, 
die der CANopen Standard festlegt.

GSVmulti unterstützt CAN-Umsetzer-Hardware des Herstellers PEAK Systems und zwar 
standardmäßig das Modell PCAN USB. Alternativ kann über Menüleiste->Options-
>Hardware->CAN-Adaptertype auf das Modell PCAN PCI u.a. umgestellt werden.

Die Einstellungen zu CAN-ID und Bitrate erreicht man über Menüleiste -> Device -> Advanced
Settings -> Interface. Bei CANopen-Geräten wird hier die Node-ID angezeigt und geändert. 
Beim GSV-6-CAN können folgende IDs gesetzt werden:

• Command ID: ID für Befehlsanfrage. Sie muss von der 
Response-ID und der Value-ID verschieden sein.

• Response-ID: ID für Antworten auf Befehle. Sie muss 
von der Command-ID verschieden sein.

• Value-ID: Auf dieser ID werden Messdaten versendet. 
Sie muss von der Command-ID verschieden sein.

• Multicast-ID: Diese ID ist reserviert und wird z.Zt. nicht 
verwendet.

Bei den meisten GSV-6 Modellen sind die CAN-Interface 
Einstellungen auch dann zugänglich, wenn die Hardware-
Ausführung keine CAN-Schnittstelle bietet. Sie sind dann zu 
ignorieren, der On / Off state sollte dann stets aus (Off) sein.

CRC bei GSV-6 und GSV-8

Mit der Checkbox Menüleiste -> Device -> Advanced Settings -> Interface -> CRC for all Serial 
Frames kann beim GSV-6 und beim GSV-8 eine Prüfsummenberechnung für alle seriellen 
Schnittstellen aktiviert werden. Dadurch versieht das Gerät die Messdatenframes mit einer 
CRC-16 Checksumme und GSVmulti verwendet dann auch für Kommandoanfragen die 
dafür vorgesehene CRC-8 Checksumme, die Kommandoantworten werden dann ebenso 
damit verschickt.

Eine Prüfsumme kann sinnvoll sein, wenn das serielle Protokoll nicht über eine USB- 
Ethernet- oder Bluetooth-Schnittstelle läuft, sondern direkt versendet wird (z.B. RS232, 
RS422, UART), insbesondere wenn elektromagnetische Störeinflüsse vorliegen. Die 
Checksumme verlängert den Messdatenframe um 2 Bytes, so dass die maximale 
Messdatenrate u.U. etwas niedriger ist. Genauere Informationen zu Indikation und 
Berechnung der Checksumme steht in der Protokolldokumentation. Datenframes bei denen 
die CRC-Prüfung fehlschlägt, werden still ausgefiltert, d.h. wenn CRC-Fehler auftreten (z.B. 
durch starke Störungen), werden Messwerte weggelassen, es tritt aber keine Verfälschung 
der Datenströme auf (d.h. sie ist extrem unwahrscheinlich).
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Datenframe: Kanalanzahl und Datentyp

Die Messverstärker GSV-2, GSV-3, GSV-6 und GSV-8 bieten verschiedene Einstellungen 
hinsichtlich des Datentyps der über die digitale Schnittstelle übertragenen Messdaten. 
GSVmulti kann alle einstellbaren Datentypen auswerten; wenn nötig, rechnet es die 
eingehenden Messdaten anhand von User Scaling automatisch um. Eine Änderung des 
Datentyps kann aber sinnvoll oder notwendig sein, wenn auch andere Programme 
verwendet werden sollen, die nur einen bestimmten Datentyp kennen oder wenn die 
Messdatenrate vergrößert werden soll, denn auch der Messdatentyp kann dieses Maximum 
einschränken.

Der Messdatentyp kann unter Menüleiste  → Device  Advanced Settings  Value Mode  → → →
Frame / Value Type geändert werden. Die Details der Messdatenframes und die Dekodierung
der Messdaten werden in den Geräte-Bedienungsanleitungen beschrieben und für den GSV-
6 und GSV-8 in der Protokollbeschreibung.

Messdatentyp bei GSV-2 und GSV-3

Es kann zwischen zwei verschiedenen binären Datenformaten und Text-
Datenformat gewählt werden.

• 16-Bit value, 3-Byte frame: Einstellbar bei GSV-2 und 3. Der 
Messdatenframe besteht nur aus 3 Bytes, das erste ist ein 
konstantes Präfix, danach kommen 2 Bytes mit binär kodierten 
Messwerten. Diese Einstellung ermöglicht die höchste 
Messdatenrate, s.S. 17. Beim GSV-2 wird das unterste Byte der 24-

Bit-Werte weggelassen, so dass diese Einstellung hier nur mit eher hohen 
Messdatenraten empfehlenswert ist, bei der die effektive Auflösung wegen des 
höheren Rauschens ohnehin verringert ist. Beim GSV-3 ist dies der Default-Datentyp.

• 16-Bit value, 4-Byte frame: Nur beim GSV-3:  Der Messdatenframe besteht aus 4 
Bytes, das erste ist ein konstantes Präfix, danach kommt ein Flagwert, der den 
Zustand des Schwellwertschalters enthält, dann der binär kodierte 16-Bit Messwert. 
Der 4-Byte Frame ermöglicht eine sicherere Frame-Synchronisation bei Verwendung 
anderer Software, weil man das maskierte zweite Byte als Präambel auffassen kann 
und dadurch wird eine Fehlsynchronisation viel unwahrscheinlicher.

• 24-Bit value, 5-Byte frame: Nur beim GSV-2:  Der Messdatenframe besteht aus 5 
Bytes, das erste ist ein konstantes Präfix, danach kommt ein Flagwert, der den 
Zustand der Schwellwertschalter enthält, dann der binär kodierte 24-Bit Messwert. 
Der 5-Byte Frame ermöglicht eine sicherere Frame-Synchronisation bei Verwendung 
anderer Software, weil man das maskierte zweite Byte als Präambel auffassen kann 
und dadurch wird eine Fehlsynchronisation viel unwahrscheinlicher. Beim GSV-2 ist 
dies der Default-Datentyp.

• ASCII Text:  Einstellbar bei GSV-2 und 3. Der Messdatenframe ist ein ASCII-konformer 
Text, wobei das erste Byte stets das Vorzeichen + oder – darstellt und der Frame mit 
den Steuerzeichen CarriageReturn und LineFeed (0x0D0A) abgeschlossen wird. 
Dieses ist ein weithin kompatibles Format und es ist (mit den meisten 
Programmiersprachen) am einfachsten mit selbstgeschriebenen Programmen 
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auszuwerten; allerdings ist die maximale Messdatenrate am niedrigsten, weil die 
Übertragung eines Messwertes bis zu 18 Bytes benötigt.

Formatierung der Messwerttext-Darstellung

Beim GSV-2 und GSV-3 kann die Anzahl 
der Stellen des Messwertes im Textframe 
in einem Unterdialog konfiguriert werden, 
der sich öffnet, wenn man auf Menüleiste 

 → Device  Advanced Settings  Value → →
Mode  → Format Value klickt. Beim GSV-2 
Modellen mit LC-Display ändert dies auch 
die Darstellung der Messwerte im Display. 
Die Anzahl möglicher Nachkommastellen 
(Decimal places) hängt grundsätzlich noch
von der Anzeigenormierung ab (User 
Scaling=Display scaling). Die maximale 
Anzahl signifikanter Stellen unter Number 
of Digits ist beim 24-Bit Messverstärker =8 

und beim 16-Bit Gerät GSV-3 =5. Unten im Konfigurationsdialog werden anhand der oben 
gewählten Ziffernanzahl Beispiele für den Messwerttext angezeigt, wahlweise für die 
Displayanzeige (LCD) oder die serielle Schnittstelle (Serial Port). Hiermit kann auch die 
Anzahl der Bytes pro Frame gezählt werden, wobei +2 für das Suffix zu addieren ist, um die 
maximale Messdatenrate zu bestimmen (ByteAnzahl, s.S. 111).

Diese Geräteeinstellung Number of Digits ist zwar unabhängig von der der Software (s. S.
32), wenn sie jedoch bei aktiviertem ASCII-Messwertframe niedriger ist als die der Software, 
werden Nullen angehängt, d.h. sie bedingt dann den niedrigsten Anzeigeschritt.

Messdatentyp bei GSV-6 und GSV-8

Es kann zwischen ganzzahligem Datenformat und Fließkommadarstellung gewählt werden. 
Der eingestellte Messdatentyp gilt für alle vorhandenen Schnittstellen außer EtherCAT und 
CANopen.

• 16-bit Integer values: Ganzzahliges Binärformat, bei dem jeder Messwert im 
Datenframe mit 2 Bytes dargestellt wird. Diese Einstellung ermöglicht die höchste 
Messdatenrate, s.S. 17.

• 24-bit Integer values: Nur beim GSV-8: Ganzzahliges Binärformat, bei dem jeder 
Messwert im Datenframe mit 3 Bytes dargestellt wird.

• Float values: Fließkommadarstellung, bei dem jeder Messwert im Datenframe mit 4 
Bytes dargestellt wird und fertig skalierte Messwerte angibt, sofern der zum 
entsprechenden Kanal gehörige Sensor richtig konfiguriert ist. Diese Einstellung ist 
für die Darstellung physikalisch skalierter Messwerte bei bestimmten Sensortypen 
wie Mehrachsensensor (s.S. 39) und Temperatursensor erforderlich. Sie entspricht 
der Default-Einstellung.
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Kanalanzahl im Messdatenframe

Beim GSV-1A8USB werden grundsätzlich nur die Kanäle übertragen, die mit Add Channel 
geöffnet worden sind. Beim GSV-6 und GSV-8 ist diese Anzahl unter Menüleiste  → Device  →
Advanced Settings  Value Mode → →Number of Channels in Frame konfigurierbar. Bei diesen 
drei Gerätetypen beeinflusst sie die maximal einstellbare Messdatenrate: je weniger Kanäle, 
desto höher ist diese (das absolute Maximum der Messdatenrate, z.B. 48000/s bei GSV-8 
Standard, kann jedoch nicht überschritten werden). Beim GSV-4 ist die Kanalanzahl 
unveränderbar =4.

Beim GSV-6 und GSV-8 können im Add Channel Dialog nur Eingangskanäle
geöffnet werden, die auch im Messdatenframe übertragen werden. Bei 
einer Verringerung der Kanalanzahl werden geöffnete Kanäle automatisch 
entfernt, die dadurch nicht mehr vorhanden sind; bei einer Vergrößerung 
dieser Anzahl können die neuen Kanäle anschließend mit Add Channel 
manuell geöffnet werden.

Die Mindestanzahl ist beim GSV-8 =2, so dass dann nur Eingangskanäle 1 
und 2 vorhanden sind; bei älteren GSV-6 Geräten kann nur die Kanalanzahl 
1,2,3 oder 6 gesetzt werden. Die Eingabe ist mit Store to device 
abzuschließen. Beim GSV-8 wird die Kanalanzahl bei UART und USB-
Schnittstelle unabhängig voneinander verwaltet und für das jeweils aktive 
Interface bedient, d.h. über USB wird die Kanalanzahl des USB-Frames 

eingestellt und über UART/RS422 die Kanalanzahl der UART- und RS422-Schnittstelle.

Wenn ein oder zwei Counter bzw. Frequenzzählerkanäle vorhanden sind (s. S. 131), 
vergrößert sich die maximale Kanalanzahl dementsprechend.

GSV-6 und GSV-8 verhalten sich hinsichtlich der Messdatenerfassung in Zusammenhang 
mit dieser Einstellung unterschiedlich. Der GSV-8 erfasst immer alle 8 Kanäle21, unabhängig 
von Number of Channels in Frame; der GSV-6 hingegen erfasst nur konfigurierte Kanäle.

Datenframe und Messdatenrate

Die Kommunikations-Bitrate (Baud, in Bits/s) und die Anzahl der Bytes pro Messdatenframe 
(ByteAnzahl) bedingen die maximale Messdatenrate. Diese ist u.U. noch durch andere 
Einstellungen eingeschränkt, außerdem gibt es bei jedem Gerätemodell ein absolutes 
Maximum, das im Datenblatt oder der Bedienungsanleitung angegeben ist und nicht 
überschritten werden kann. Wenn mehrere Schnittstellen vorhanden sind, etwa beim GSV-8, 
so gilt die niedrigste Fdata,max aller eingeschalteten Schnittstellen als Maximum.

Anhand der seriellen Kommunikation ist bei allen Geräten und Schnittstellen, bei denen die 
Kommunikations-Bitrate relevant  ist (s.S. 104), die maximale Messdatenrate theoretisch 
folgende:

Fdata,max = Baud / (ByteAnzahl x 10)

Der Wert ist abzurunden, außerdem kann er je nach Gerät niedriger ausfallen. Das kann 
daran liegen, dass nur bestimmte Werte für Messdatenraten setzbar sind. GSVmulti zeigt 
den Wertebereich im Configuration Tab -> Data Frequency Dialog an, man kann also erst die 
Einstellungen des Messdatenframes ändern und dann das Maximum dort ablesen.

21 Bei High-Speed Sondergerät sind es 4 Kanäle
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GSV-6 und GSV-8 haben das gleiche serielle Messdatenprotokoll, in dem der Aufbau der 
Messdatenframes festgelegt ist. Dabei gilt:

ByteAnzahl = N x DT + 4

oder, wenn die CRC-Prüfsumme aktiviert ist:

ByteAnzahl = N x DT + 6

Dabei ist:

N: Kanalanzahl im Messdatenframe

DT: Anzahl der Bytes pro Messwert, d.h. =2 bei 16-Bit Integerwert, =3 bei 24-Bit-Integerwert 
und =4 bei Float-Messwert.

Beispiel: 6 Kanäle, Float, ohne CRC: ByteAnzahl=28; Fdata,max= 822/s bei Baud=230400 
Bits/s (z.B. GSV-6).

Bluetooth Einstellungen beim GSV-6BT

In den Dialog für Geräteverhalten und Kommunikationseinstellungen des Bluetooth 
Interfaces des GSV-6BT gelangt man über Menüleiste  → Device  Advanced Settings  → →
Interface → Bluetooth Settings, d.h. man klickt den Button Open Dialogue. Bei Eintritt in 
dieses Menü wird die Messdatenübertragung gestoppt, d.h. während es offen ist, erscheint 
unter Measuring Value in Hauptfenster Configuration die timeout Meldung.

Der Bluetooth Mode muss Classic 
sein, damit man den GSV-6BT mit 
GSVmulti öffnen kann; dieses "SPP" 
Geräteprofil emuliert eine serielle 
Schnittstelle. Der Low Energy Modus
ist nicht mit GSVmulti kompatibel. Er
folgt dem BLE/Gatt Standard und 
hierfür gibt es eine gesonderte 
Anleitung. Mit ihm kann man 
beispielsweise mit Smartphones 
und einer BLE/Gatt App mit dem 
GSV-6BT kommunizieren und u.a. 
Messwerte auslesen. Zum 
Umschalten stellt man auf  Low 

Energy und klickt dann Store to device. Nachdem man dann GSVmulti geschlossen oder mit 
Menüleiste -> Device -> Close... alle Kanäle dieses Gerätes entfernt hat, ist der Low-Energy 
Modus aktiviert. Mit einem Gatt-Browser Programm / App kann man in den Classic Mode 
zurückschalten, um wieder per GSVmulti auf das Gerät zugreifen zu können; in der Anleitung
ba-gsv6bt-gattservices_en.pdf ist beschrieben, wie das geht.

Unter Maximum Power for BT Low Energy kann die maximale Sendeleistung für den  Low-Energy 
Modus verringern; per Default ist sie auf Maximum = 7dBm gestellt. Mit weniger Sendeleistung kann 
die Batterie etwas länger halten, jedoch ist die Reichweite verringert, weniger als -3dBm wird nicht 
empfohlen.
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Geräteverhalten bei geschlossener Bluetooth Verbindung

Der GSV-6BT enthält neben der Hardware -Messapplikation (GSV-6CPU) einen zweiten 
Mikrocontroller, der u.a. auch die GSV-6CPU ein- und ausschalten kann. Bei geöffneter 
Bluetooth-Verbindung, d.h. wenn die blaue Geräte-LED an ist, ist die  Messapplikation stets 
eingeschaltet, was durch die leuchtende grüne Geräte -LED angezeigt wird (sowohl im 
Classic als auch im Low-Energy Modus). Der Gerätezustand bei geschlossener Bluetooth-
Verbindung (blaue LED aus) kann unter On / Off state of measuring amp when BT connection
is closed konfiguriert werden. Das ist nützlich, um im Stand-alone Betrieb Messdaten auf der
SD-Karte aufzeichnen zu können, s. S.33. Wenn die Messapplikation abgeschaltet wird, ist 
das Gerät in einem Standby-Betrieb und verbraucht dabei sehr wenig Strom, so dass die 
Batterie sehr lange hält. Die Optionen bedeuten im Einzelnen:

• Device remains on: Die Messapplikation bleibt stets an.

• Device switches off: Die Messapplikation wird nach Schließen der Verbindung 
abgeschaltet und bleibt aus. (Auslieferungszustand)

• Periodical Logger: Die Messapplikation wird durch eine Hardware-Uhr (RTC) in einem 
definierbaren Zeitintervall >= 1 Minute kurzzeitig eingeschaltet, um eine 
Messwertzeile aufzuzeichnen, s. S.33, Single Log Periodically.

• On/Off by Key: Die Messapplikation kann mit einem Taster ein- und ausgeschaltet 
werden, der an einer bestimmten Digitalleitung (BT-DIO3) angeschlossen ist. Bei der 
Modellvariante GSV-6BT M8 ist dieser standardmäßig bereits vorhanden, siehe 
Bedienungsanleitung.22

• On/Off by Switch: Die Messapplikation kann mit einem Schalter ein- und 
ausgeschaltet werden, der an einer bestimmten Digitalleitung (BT-DIO3) 
angeschlossen ist.23

Weitere Anzeige- und Bedienelemente der BT-Einstellungen

• BT Device Name: Der Bluetooth-Name des Gerätes im BT-Classic Modus. Ein Ändern 
dieses Namens ist möglich, aber für Endbenutzer nicht empfohlen.

• BGscript Version: Die Firmwareversion des zweiten Mikrocontrollers (BT-Controller).

• Digital Out 1 / 2: Hiermit können die Digitalausgänge "IO_1" bzw. "IO_2" des BT-
Controllers testweise auf High geschaltet werden. Der Zustand ist flüchtig. Diese 
Digitalausgänge sind nicht zu verwechseln mit "SW1-3" = "DIO1-3" = "Threshold output", die 
über die Messapplikation angesteuert werden, s. S.119.

• Digital Out 4 (LED): Hiermit die User-LED des BT-Controllers testweise eingeschaltet 
werden. Der Zustand ist flüchtig.

• Battery Voltage: Die Spannung der Batterie. Ist sie kleiner als 3,7V, sollte sie geladen 
werden!

• Read All again: Alle Einstellungen noch einmal auslesen.

22 Vorhanden ab BGscript-Version 1.00
23 Vorhanden und uneingeschränkt funktionabel ab BGscript-Version 1.02
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Übertragung des Maximal- oder Minimalwertes

Beim GSV-2, GSV-3, GSV-6 und GSV-8 kann der Messwertframe so umkonfiguriert werden, 
dass statt aktueller Messwerte nur Maximal- oder Minimalwerte übertragen werden, d.h. 
positive oder negative Spitzenwerte. Verwendet man diesen Gerätemodus, wird der aktuelle 
Messwert nicht mehr angezeigt. Um beides zu sehen, kann man eine numerische Anzeige 
per Software umschalten, wie auf S. 30 gezeigt. Mit Menüleiste -> Device -> Advanced 
Settings -> Value Mode -> Maximum / Minimum values wird hingegen die Konfiguration des 
Gerätes geändert. Das kann insbesondere bei Verwendung anderer Software sinnvoll sein 
oder wenn beim GSV-2 das Maximum auf dem Gerätedisplay angezeigt werden soll.

Um Maximalwerte zu übertragen, wird Value transmission auf Transmit maximum values 
gestellt. Beim GSV-8 muss dann auch die Ckeckbox Acquire maximum and minimum gesetzt
sein, damit die Max- und Min-Werte erfasst werden. Man kann dann die Übertragung mit 
Transmit minimum values auch auf Minimalwerte setzen.

Beim GSV-2 und GSV-8 gibt es die 
Möglichkeit, Betragsmaxima zu 
übertragen. Das bedeutet, dass das 
Maximum der Messwerte mit 
"weggelassenem Vorzeichen" übertragen 
wird. Dazu aktiviert man die Checkbox 
Maximum values are maximum values of 
absolute values MAX(|vals|) und wählt 
zugleich Transmit maximum values. Die 
Geräte bilden dann erst den Betrag der 
Messwerte und ermitteln daraus den 
Maximalwert, der also immer positiv ist.

Beim GSV-2 gibt es alternativ noch den 
Value transmission Modus Transmit 
max. / min values. Dieser ist dem 
Betragsmaximalwert ähnlich, jedoch wird 
das Vorzeichen nicht weggelassen, 

sondern mit übertragen. Beispiel: Messwert erst =0, dann neuer Maxwert 10. Übertragen 
wird 10. Nun entstehe ein neuer Minimalwert -12. Mit Transmit max. / min values überträgt 
der GSV-2 nun -12, mit maximum values of absolute values würde er 12 übertragen.

Alle Geräte übertragen grundsätzlich die Maxima- oder Minimalwerte mit der eingestellten 
Messdatenrate, d.h. wenn kein neues Maximum bzw. Minimum vorliegt, wird das 
vorangegangene wiederholt.

Der GSV-2 bietet aber auch einen Maximum-Ereignismodus an. Wenn die Checkbox 
Transmit value on new maximum event gesetzt ist, werden nur neue Maximalwerte 
übertragen. Dadurch passiert es regelmäßig, dass der GSV-2 keine Messwerte sendet, d.h. 
der Messdatenstrom ist unregelmäßig und GSVmulti zeigt dann häufiger timeout in der 
Messwertanzeige in der Configuration Karteikarte an.
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Definierbarer Messwerttext zum Einbinden anderer Geräte

Mit GSVmulti PRO ist es u.U. möglich, auch die Messwerte anderer Messgeräte anzuzeigen, 
und zwar unter folgenden Voraussetzungen:

• Das Gerät sendet über eine serielle Schnittstelle (real oder virtuell) mit der 
Grundeinstellung 8 Datenbits, keine Parität und 1 Stopbit (8N1).

• Eine der folgenden Bitraten wird unterstützt: 2400, 4800, 9600, 19.200, 38.400, 
57.600, 115.200, 230.400, 460.800, 921.600.

• Das Gerät sendet Texte mit Messwertframes als ASCII- oder UTF-8-String, d.h. es 
sind 8 Bits pro Zeichen.

• Es versendet die Messwertframes automatisch und selbsttätig, d.h. sie müssen nicht
angefragt werden.

• Das Layout des Messwertframes bleibt konstant, d.h. sein Grundaufbau ändert sich 
während der Messlaufzeit nicht.

• Der Dezimaltrenner im Messwert ist ein Punkt (period), kein Komma.

• Jeder Messwertframe wird durch Carriage return und Line feed abgeschlossen, d.h. 
durch die Steuerzeichen LF,CR (0x0D0A).

Um ein solches Gerät zu öffnen, wählt man im Add Channel Dialog unter Device Type die 
Geräteart UserDefined aus. Der Dialog zur Konfiguration des Messwerttextes öffnet sich ggf.
automatisch; tut er das nicht, klickt man auf Value String/DEFINE.

Er bietet folgende Einstellmöglichkeiten:

Frame Prefix Mode (Präfix des 
Messdatenframes): Ein Präfix ist ein Zeichen, 
dass in jedem Messwertframe immer als erstes 
kommt; es gibt hier drei Auswahlmöglichkeiten:

Has Character Prefix: Es gibt ein Präfix 
und dieses wird in Define Prefix Character 
als Zeichen eingegeben, z.B. $ oder % 

oder A.

Has Binary Prefix: Es gibt ein Präfix und dieses wird in Define Binary Prefix (hex) als 2-
stellige Hexadezimalzahl eingegeben, z.B. 0A oder B4 oder 80.

No Prefix, 1st char is - or digit: Es gibt kein Präfix und der Messwertframe beginnt mit 
einem Messwert, d.h. das erste Zeichen ist - + oder eine der Ziffern von 0 bis 9.

Mit Number of values in String/Frame wird angegeben, wie viele Messwerte / Kanäle der 
Messwertframe enthält. Jeder Messwert kann dann einem Kanal in GSVmulti zugeordnet 
werden, das muss jedoch nicht für jeden Messwert im Frame getan werden. Diese Anzahl 
sollte also stimmen, unabhängig davon, ob alle Werte angezeigt werden sollen oder nicht. 
Wenn im Add Channel Dialog Open all input channels aktiviert wird, wird der erste Messwert 
im Frame dem ersten Kanal dieses Gerätes zugeordnet, der zweite dem zweiten usw. 
Möchte man die angezeigte Kanalreihenfolge ändern, muss man in der gewünschten 
Reihenfolge für jeden zu öffnenden Kanal Add Channel klicken, Open all input channels 
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deaktivieren und den Kanal, d.h. seine Position im Messdatenframe mit Channel/Pos. 
auswählen.

Wenn der Messwertframe mehr als einen Messwert/Kanal enthält, muss ein Zeichen 
definiert werden, mit dem die Werte innerhalb des Frames voneinander getrennt sind. Mit 
Value Separator kann man hier folgendes auswählen:

Komma ,
Semikolon ;
Pipe |
Leerzeichen space
Tabulator tab
Andere other

Wenn other gewählt wird, trägt man das Trennzeichen unter Separator Char ein.

Wenn der Messwertstring außer Zahlen und Trennzeichen noch weitere Texte oder Zeichen 
enthält, die vom Trennzeichen verschieden sind (s. Beispiel 3), so kann man die Checkbox 
Filter-Out Non-Numeric aktivieren. GSVmulti analysiert die Messwertstrings dann 
eingehender und filtert unnötige Teile aus; dies benötigt jedoch Rechenzeit, so dass die 
Performance des PCs u.U. schwächer wird.

Die Definition des User-defined Device wird in der Session gespeichert, d.h. es ist 
empfehlenswert, wenn alles funktioniert, Save / Load Session zu verwenden, s.S. 14.

Beispiele:

1. Im oben gezeigten User Defined Device Screenshot hat der Frame das Präfix % und nur 
einen Messwert. Das entspräche z.B. folgendem String:
%-123.789<CR><LF>

2. Ein Messwerttext sieht etwa so aus:
-2.699876,+0.97575,0.000001,6899.076,6,0,1<CR><LF>
Dann konfiguriert man User Defined Device folgendermaßen:

3. Ein Messwerttext sieht etwa so aus:
ST,NT,+    1.3  <CR><LF>
Dann konfiguriert man User Defined Device folgendermaßen:
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Automatische Wiederaufnahme bei Abbruch der Kommunikationsverbindung

Es kann vorkommen, dass der Datenstrom der Messdaten abbricht; Ursache kann z.B. eine 
unterbrochene Bluetooth-Funkverbindung sein oder eine versehentlich entfernte 
Kommunikationsleitung. GSVmulti bemerkt dies und zeigt nach 5 Sekunden in der 
Configuration Karteikarte timeout an:

Wenn die Messdatenrate kleiner als 2/s ist, so beträgt diese Zeit 
nicht 5s, sondern 10/ Messdatenrate s. Die weitere Reaktion des 

Programms hängt von der Konfiguration und davon ab, ob eine Messung mit Start 
Measuring gestartet wurde oder nicht. Für den Zustand der gestarteten Messung versucht 
GSVmulti, die Verbindung automatisch wiederaufzunehmen. Dieses Verhalten kann unter  
Menüleiste -> Options -> Hardware -> If connection to device is lost: konfiguriert werden:

In der Ausgangskonfiguration ist die automatische Wiederaufnahme 
Try to reconnect automatically aktiviert, sie kann mit No auto-reconnect 
deaktiviert werden.

Ist sie aktiviert und die Messung gestartet, so geschieht folgendes, wenn ein GSV-
Messverstärker GSV-2, -3, -4, -6 -8 mindestens 4,5 Sekunden keine Messdaten sendet:

1. Der Verbindungsabbruch wird mit einem Lesekommando überprüft. Ist es erfolgreich,
wird nur das Kommando Start Transmission gegeben um zu versuchen, die 
permanente Messdatenübertragung wieder zu beleben (s. S. 107). Ist es nicht 
erfolgreich, wird die Schnittstellenverbindung zunächst geschlossen. Das ist 
notwendig, um sie anschließend wieder öffnen zu können. Sind mehrere GSVs 
geöffnet, so wird dies mit allen getan und ggf. eine Liste der GSVs mit 
Verbindungsproblemen erstellt.

2. Nun wird versucht, den oder die GSV mit Verbindungsproblemen wieder zu öffnen. Ist
dies erfolgreich, wird die Messung fortgesetzt, wenn nicht, wird dies in regelmäßigen 
Zeitabständen von ca. 1 Sekunde immer wieder versucht. Wenn währenddessen 
Messdaten aufgenommen werden (Start Recording), so können durch die fehlenden 
Daten anschließend ungenaue Zeitstempel entstehen.

Wenn die automatische Wiederaufnahme der Verbindung unter Options->Hardware 
deaktiviert ist, so erhält der Benutzer nach 5 Sekunden ohne Messdaten bei gestarteter 
Messung folgende Meldung:

Der Benutzer kann dann auf Stop klicken, so wird die Messung 
und ggf. auch die Datenaufnahme gestoppt. Man kann dann 
mit Menüleiste -> Device -> Close oder Remove Channel die 
Verbindung manuell schließen und wieder öffnen (Add Channel
/ Device -> Open). Oder man klickt in dieser Meldung auf 
Continue und das Programm wartet ohne andere Aktionen 
weiter auf Messdaten.
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Digitale Ein/Ausgänge und Schwellwertschalter

Die Modelle GSV-2 und GSV-3 bieten konfigurierbare Schwellwertschalter und GSV-4, GSV-6 
und GSV-8 frei konfigurierbare digitale Ein- und Ausgänge, die auch als Schwellwertschalter 
konfiguriert werden können. Ein Schwellwertschalter ist ein digitaler Ausgang, der bei Über- 
oder Unterschreiten des Messwertes über bzw. unter einen Schwellwert ein- oder 
ausgeschaltet wird.

Zum Einstellungsdialog der digitale Ein- und Ausgänge gelangt man mit Menüleiste -> 
Device -> Advanced Settings -> Digital I/O

Beim GSV-4, GSV-6 und GSV-8 werden rechts unter DIO levels mehrere Soft-LEDs angezeigt, 
die hellgrün "leuchten", wenn der digitale I/O High ist, d.h. wenn 5V bzw. 3,3V anliegen; liegt 
Low =0V an, sind sie dunkelgrün. Die Anzahl der angezeigten Soft-LEDs entspricht der 
Anzahl der digitalen I/Os: 12 beim GSV-4, 5 beim GSV-6 und 16 beim GSV-8. Nur bei den I/O 
types QEI input, Sync. Master und Sync. Slave (s.u.) werden die Zustände nicht angezeigt oder sind nicht 
zuverlässig gültig, weil sie zu schnell wechseln.

Actual Level ist ein Soft-Schalter, der den Zustand des I/Os anzeigt, der mit I/O number 
gerade gewählt ist. Beim I/O type GP Output kann der Pegel des Digitalausgangs hiermit 
geändert werden, s.u. Die Bedienelemente Actual Level und  DIO levels sind gut geeignet, um 
die Funktion der digitale Ein- und Ausgänge zu testen.

Bei einer Änderung der Konfiguration kann diese auf alle digitalen Anschlüsse angewendet 
werden, wenn die Checkbox Apply to all DIOs gesetzt ist (vorausgesetzt, sie ist für alle 
erlaubt). Als letzten Schritt einer Änderung für jeden zu konfigurierenden I/O Store to device 
klicken.

Es ist zweckmäßig, zunächst mit I / O number die Digitalleitung auszuwählen, deren 
Konfiguration man einsehen oder ändern möchte; manche Funktionen sind nämlich auf 
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bestimmte Leitungen festgelegt. Der GSV-3 hat nur einen Schwellwertschalter, hier ist  I / O 
number nicht änderbar. Der GSV-2 hat zwei Schwellwertschalter, die man hiermit auswählt.

Unter Terminal name / Pin-No wird der Name oder die Pinnummer der Leitung angezeigt, so 
wie sie z.B. in der Bedienungsanleitung genannt wird. Der I / O Type zeigt die Funktion der 
Leitung; diese wird auch in der Textausgabe Function genauer beschrieben. Bei einer 
Konfigurationsänderung sollte diese nach der Wahl der I/O number gesetzt werden. 
Folgende Funktionen gibt es:

GP Input: Digitaleingang zur allgemeinen Verwendung (General-Purpose), z.B. 
getriggerte Messdatenaufnahme wie ab S. 59 beschrieben.

QEI Input (nur GSV-8): Digitaleingang ist belegt für Zählerfunktion, hier Read-Only, d.h. 
dieser Typ kann hier nicht gesetzt und auch nicht verändert werden, wenn er gesetzt 
ist. Stattdessen kann der Counter-Eingang im Counter/Frequency Dialog geändert 
werden, s. S. 

Tara Single: Digitaleingang zum Durchführen eines Nullabgleichs für einen einzelnen 
Eingangskanal, der mit Input channel to set zero ausgewählt werden kann.

Tara All : Digitaleingang zum Durchführen eines Nullabgleichs aller Eingangskanäle

Reset Digital Out: (nur GSV-6 & GSV-8) Digitaleingang mit dem alle als Ausgang 
konfigurierten digitalen IOs in den Einschaltzustand versetzt werden, der mit Default 
output level definiert werden kann.

Reset Max/Min: (nur GSV-6 & GSV-8) Digitaleingang mit dem die Maximal- und 
Minimalwertermittlung zurückgesetzt werden kann. Beim GSV-8 nur sinnvoll, wenn 
diese in der Karteikarte Value Mode unter Acquire maximum and minimum aktiviert 
ist.

Trigger Send value (nur GSV-4 & GSV-8): Digitaleingang mit dem das Senden eines 
oder mehrerer Messwerte über die USB- und UART Schnittstelle ausgelöst wird, 
sofern die permanente Messdatenübertragung deaktiviert ist (s. S.107). Die Art des 
Messwertes und andere Details werden beim GSV-8 mit Triggered value sending 
Mode festgelegt; und zwar mit folgenden Auswahlmöglichkeiten:

Actual Values: Auslösen des Sendens eines Messwertframes mit aktuellen 
Messwerten über die Schnittstelle(n) an inaktiv-zu-aktiv Flanke des digitalen 
Eingangs.

Maximum Values: Bei  inaktiv-zu-aktiv Flanke am digitalen Eingang wird die 
Maximalwertermittlung (alle Eingangskanäle) begonnen und an aktiv-zu-inaktiv 
Flanke wird ein Frame mit diesen Maximalwerten an die Schnittstelle(n) gesendet.

Minimum Values: Bei  inaktiv-zu-aktiv Flanke am digitalen Eingang wird die 
Minimalwertermittlung (alle Eingangskanäle) begonnen und an aktiv-zu-inaktiv Flanke
wird ein Frame mit diesen Minimalwerten an die Schnittstelle(n) gesendet.

Mean values: Bei  inaktiv-zu-aktiv Flanke am digitalen Eingang wird eine dezimierende 
Mittelwertbildung aller Eingangskanäle begonnen und an aktiv-zu-inaktiv Flanke wird 
ein Frame mit diesen Mittelwerten an die Schnittstelle(n) gesendet. 

Send while active: Während der Input-Pegel aktiv ist, werden Messwertframes mit 
aktuellen Messwerten über die Schnittstelle(n) gesendet, mit der eingestellten 
Datenrate.
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GP Output: Digitalausgang zur allgemeinen Verwendung (General-Purpose); der 
Zustand kann mit anderen Programmen oder mit dem Software-Schalter Actual Level
gesetzt werden.

Threshold Switch: Der Digitalausgang dient als Schwellwertschalter, Details siehe S.
121

Sync. Master: Der Messverstärker erzeugt an diesem Digitalausgang ein 
Rechtecksignal, das zur Synchronisation der Übertragung von Messwerten bei 
Geräten dient, die als Trigger Sync. Slave konfiguriert sind, s. S.14.

Sync. Slave: Digitaleingang, an dem ein Rechtecksignal anliegen sollte, das zur 
Synchronisation der Messdatenübertragung dient, s. S.14.

Trigger File Log (nur GSV-6BT): Digitaleingang, an dem die Aufnahme von 
Messdatendateien auf SD-Karte ausgelöst werden kann, so dass Messdaten geloggt 
werden, während der aktive Pegel anliegt, s.S.33.

Schwellwertschalter

Der Schwellwertgeber vergleicht den Messwert mit zwei konfigurierbaren Schwellwerten, 
einem oberen (ON-Threshold, bzw. Upper Threshold) und einem unteren (OFF- bzw. Lower 
Threshold). Je nach Ergebnis des Vergleichs und je nach Modus wird der Digitalausgang 
aktiviert, deaktiviert oder der vorherige Zustand wird belassen. Dabei kann mit Threshold 
switch Mode aus bis zu vier verschiedenen Modi ausgewählt werden. Je nach Gerätemodell 
sind nicht alle verfügbar, d.h. Einträge sind ggf. ausgegraut.

Hysteresis switch (normal): Der Schwellwertgeber mit Hysterese unterscheidet drei 
Fälle und verhält sich folgendermaßen:

• Wenn der Messwert „MW“ (bzw. Maximal- oder Minimalwert) größer als der 
obere Schwellwert „SWo“ (ON Threshold) ist, wird der Ausgang aktiviert, d.h. 
wenn MW>SWo: out,neu=aktiv

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) kleiner als der untere 
Schwellwert „SWu“ (OFF Threshold) ist, wird der Ausgang deaktiviert, d.h. wenn 
MW<SWo: out,neu=inaktiv

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) zwischen den beiden 
Schwellwerten, also im Hysteresebereich ist, bleibt der Digitalausgang 
unverändert, d.h. wenn MW<SWo || MW>SWu: out,neu=out,alt. Dadurch kann man 
beispielsweise vermeiden, dass der Ausgang schnell hin- und herschaltet, 
wenn der Messwert um den Schwellwert herum rauscht.
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Window Comparator: (GSV-2, GSV-3, GSV-6 und GSV-8) Der Schwellwertgeber arbeitet
als Fensterkomparator, d.h. es werden zwei Fälle unterschieden:

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) größer als der obere 
Schwellwert (Upper Threshold) oder kleiner als der untere Schwellwert (Lower 
Threshold) ist, wird der Ausgang deaktiviert, d.h. wenn MW>SWo || MW<SWu: 
out,neu=inaktiv

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) zwischen den beiden 
Schwellwerten, also innerhalb des „Fensters“ ist, wird der Ausgang aktiviert, 
d.h. wenn MW<SWo && MW>SWu: out,neu=aktiv.

Bipolar hysteresis switch: (GSV-2, GSV-6 und GSV-8) Bipolarer Schwellwertgeber mit 
Hysterese: Dieser Modus ist dem Hysteresis switch (normal) ähnlich, aber die 
Funktionalität ist zusätzlich im negativen Bereich „gespiegelt“, d.h. er verhält sich 
folgendermaßen:

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) größer als der obere 
Schwellwert (ON Threshold) oder kleiner als der negierte obere Schwellwert ist,
wird der Ausgang aktiviert, d.h. wenn MW>SWo || MW<(-SWo): out,neu=aktiv
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• Wenn der Messwert (bzw. Maximal- oder Minimalwert) kleiner als der untere 
Schwellwert (OFF Threshold) oder größer als der negierte untere Schwellwert 
ist, wird der Ausgang deaktiviert, d.h. wenn MW<SWu || MW>(-SWu): 
out,neu=inaktiv

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) zwischen den beiden 
Schwellwerten in positiven oder negativen Bereich, also in einem der beiden 
Hysteresebereiche ist, bleibt der Digitalausgang unverändert. D.h. wenn 
(MW<SWo && MW>SWu) || (MW>(-SWo) && MW<(-SWu)): out,neu=out,alt.

Bipolar window comparator: (GSV-6 und GSV-8) Bipolarer Fensterkomparator: Dieser 
Modus ist dem Window comparator ähnlich, aber die Funktionalität ist zusätzlich im 
negativen Bereich „gespiegelt“, d.h. er verhält sich folgendermaßen:

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) größer als der obere 
Schwellwert (Upper Threshold) oder kleiner als der untere Schwellwert (Lower 
Threshold) oder kleiner als der negierte obere Schwellwert oder größer als der 
negierte untere Schwellwert ist, wird der Ausgang deaktiviert, d.h. wenn 
MW>SWo || MW<SWu || MW<(-SWo) || MW>(-SWu): out,neu=inaktiv.

• Wenn der Messwert (bzw. Maximal- oder Minimalwert) zwischen den beiden 
Schwellwerten in positiven oder negativen Bereich ist, also innerhalb eines der 
beiden „Fenster“ ist, wird der Ausgang aktiviert, d.h. wenn (MW<SWo && 
MW>SWu) || (MW>(-SWo) && MW<(-SWu)): out,neu=aktiv.
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 Mit dem Auswahlelement Threshold compared with kann ausgewählt werden, ob der 
aktuelle Messwert (Actual value), der Maximalwert (Maximum value) oder der Minimalwert 
(Minimum value) mit den Schwellwerten verglichen werden soll. Wenn Maximal- oder 
Minimalwert ausgewählt ist, muss beim GSV-8 darauf geachtet werden, dass unter 
Menüleiste -> Device -> Advanced Settings > Value Mode  Maximum / Minimum values→  der 
Haken der Checkbox Acquire maximum and minimum gesetzt ist, damit der GSV-8 die 
Maximal- und Minimalwertermittlung tatsächlich durchführt.

Die Schwellwerte selbst werden in ON-Threshold bzw. Upper Threshold für den oberen 
Schwellwert und in Off-Threshold bzw. Lower threshold für den unteren Schwellwert 
eingegeben, jeweils in der Einheit, in der der zu vergleichende Eingangskanal konfiguriert ist. 
Beim GSV-4 stehen insgesamt nur 8 Schwellwertpaare zur Verfügung, die mit Threshold 
number zugeordnet werden, sie sind zugleich den Eingangskanälen fest zugeordnet, s.u.

Mit Input channel to react on wird beim GSV-6 und beim GSV-8 der Eingangskanal 
ausgewählt, dessen Mess-/Max-/Minwert mit den beiden Schwellwerten verglichen werden 
soll. Dabei sind beim GSV-8 die Nummern 1 bis 8 analoge Eingangskanäle und 9 und 10 sind
Zählerkanäle. Diese Auswahl ist beim GSV-8 unabhängig davon, ob der Kanal in der 
Einstellung der Kanalanzahl im Datenframe (s.S.111) vorhanden ist oder nicht; Zähler sollten
aber nur ausgewählt werden, wenn sie konfiguriert sind. Beim GSV-6 hingegen muss der zu 
vergleichende Kanal auch im Frame vorhanden sein; hier sind 1 bis 6 analoge 
Eingangskanäle und Nr. 7 ist beim GSV-6BT der Zählerkanal.

Beim GSV-4 wählt man den Eingangskanal, der mit den Schwellwerten verglichen wird, mit 
Threshold number (Schwellwertnummer) aus; dabei sind Nr. 1 und 2 dem Eingangskanal 1 
zugeordnet, Nr. 3 und 4 dem Kanal 2, Nr. 5 und 6 dem Kanal 3, sowie Nr. 7 und 8 dem 
Eingangskanal 4.

Aktiv/Inaktiv Pegel, Invertierung

In der Beschreibung der Funktionen der Digitalen IOs werden die Begriffe "aktiv" und "inaktiv" 
verwendet. Beim GSV-2, GSV-3, GSV-4 und beim GSV-6 und GSV-8 im Auslieferungszustand 
(Not inverted) bedeuten sie folgendes:
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Aktiv: High, d.h. 5V (bzw. beim GSV-6: 3,3V)
Inaktiv: Low, d.h. 0V

Mit dem GSV-6 und dem GSV-8 kann diese Zuordnung bei die meisten digitalen I/O-Typen 
mit Line inverted umgekehrt, d.h. invertiert werden. Wenn dieser Radio button auf Inverted 
gesetzt ist, bedeutet:
Aktiv: Low, d.h. 0V
Inaktiv: High, d.h. 5V (bzw. beim GSV-6: 3,3V)
Folgende I/O-Typen können invertiert werden: Tara Single, Tara All, Reset Digital Out, Reset 
Max/Min, Trigger Send value, Threshold Switch, Trigger File Log.

Standardmäßiger digitaler Ausgangspegel

Beim GSV-6 und dem GSV-8 kann für digitale IOs, die auf einen der Ausgangstypen 
konfiguriert sind, festgelegt werden, welcher Pegel nach dem Einschalten des Gerätes 
anliegen soll, wenn der Ausgang noch nicht anderweitig gesetzt wurde, z.B. durch den 
Schwellwertschalter oder beim GP output durch den Benutzer. Das wird unter Default output
level eingestellt. Die Invertierungseinstellung mit Line inverted ist dabei irrelevant, d.h. als  
Default output level wird entweder Low (0V) oder High (5V/3,3V) angegeben.

Analogausgang beim GSV-8

Der GSV-8 bietet acht konfigurierbare Analogausgänge, die unter Menüleiste -> Device -> 
Advanced Settings -> Analog Out konfiguriert werden können.
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Mit Output Channel wählt man zuerst einen der 8 Analogausgänge aus, dessen 
Konfiguration man betrachten oder ändern möchte.

Analog output type ist der Typ des Analogausgangs, der die Ausgangsgröße Strom oder 
Spannung und den Wertebereich festlegt. Folgende Typen sind vorhanden:

Voltage 0 .. 10V: Spannungsausgang, unipolar von 0 bis 10V.
Nullpunkt: 0V (wenn User offset =0)
Sättigung: negativ: -0,5V, positiv: 10,5V

Voltage -10 .. +10V: Spannungsausgang, bipolar von -10 bis 10V.
Nullpunkt: 0V (wenn User offset =0)
Sättigung: negativ: -10,5V, positiv: 10,5V
Default-Typ der Herstellereinstellung

Voltage 0 .. 5V: Spannungsausgang, unipolar von 0 bis 5V.
Nullpunkt: 0V (wenn User offset =0)
Sättigung: negativ: -0,25V, positiv: 5,25V

Voltage -5 .. 5V: Spannungsausgang, bipolar von -5 bis 5V.
Nullpunkt: 0V (wenn User offset =0)
Sättigung: negativ: -5,25V, positiv: 5,25V

Current 4 .. 20mA: Stromausgang, unipolar von 4 bis 20mA
Nullpunkt: 4 mA (wenn User offset =0)
Sättigung: negativ: 3,2mA positiv: 20,8 mA

Current 0 .. 20mA: Stromausgang, unipolar von 0 bis 20mA
Nullpunkt: 0 mA (wenn User offset =0)
Sättigung: negativ: 0 mA positiv: 21 mA
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Der Nullpunkt am Analogausgang kann durch User offset verändert werden, so dass man 
auch bei unipolaren Typen bipolar messen kann, d.h. positive und negative Zahlen- bzw. 
Messwerte analog darstellen kann. Der User Offset kann wahlweise in Prozent des 
Ausgangsbereiches (%) oder in Volt (V) bzw. mA eingeben werden, dazu muss diese Einheit 
mit dem daneben liegenden Pulldown-Menü ausgewählt werden.
Wenn beispielsweise der Analogausgangstyp Voltage 0 .. 10V ist und man User offset auf 
50% oder 5V stellt, verändern sich die Bereiche folgendermaßen:

Voltage 0 .. 10V: Spannungsausgang, bipolar von 0 bis 10V.
Nullpunkt: 5V (wenn User offset =50%)
Sättigung: negativ: -0,5V, positiv: 10,5V

Damit die negative Vollaussteuerung dann durch 0V und die positive durch 10V angezeigt 
wird, muss der User scaling factor =0,5 sein. User offset und User scaling factor wirken nur 
auf den Analogausgang und sind nicht zu verwechseln mit der User Scaling und User Offset, 
die im Hauptfenster (Karteikarte Configuration) bedient werden.

Ablesen kann man diese Ergebnisse nach jeder Änderung der Eingaben durch die Ausgabe 
in Transfer characteristic (Übertragungsfunktion). Dabei entspricht der positive und negative 
Vollaussteuerungswert der User Scale oder bei aktiviertem Sechsachsensensor dessen 
Maximalwert. Die User scale entspricht bei allgemeinen Sensoren i.d.R. nicht dem Nennwert 
des angeschlossenen Sensors, s. S. 8. Mit o.g. Beispiel kann sich z.B. folgendes ergeben:

Die positive Vollaussteuerung 1590,91 ergibt somit 10V am Ausgang (Results in 10V at the 
output).

Um bipolar messen zu können, stellt man User offset auf 50% oder 5V, der User Scaling 
factor wird dann automatisch auf 0,5 gestellt:

Der digitale Wert =0 (Zero value at input) ergibt nun 5V am Ausgang (results in 5V at the 
output), die negative Vollaussteuerung ergibt 0V am Ausgang.

Der Eingangswert Value at input von 1590,91 N ergibt sich in diesem Beispiel durch einen 
1000 N Kraftsensor mit folgenden Daten:
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Oft möchte man erreichen, dass der Nennwert des
Sensors der Vollaussteuerung am Analogausgang
entspricht und nicht die  Eingangs-
Vollaussteuerung. In diesem Fall wäre das:

1000 N => 10V
-1000 N => 0V

Man rechnet den User scaling factor also manuell 
um:

Neuer User scaling factor = 
(Vollaussteuerung/Sensornennwert) x Alter User scaling factor

Hier: (1590,91/1000) * 0,5 = 0,795455

Modus des Analogausgangs

In der Grundeinstellung folgt der Analogausgang dem Sensorsignal des dazugehörigen 
Eingangskanals, d.h. Eingang 1 -> Ausgang 1 usw. Diese Zuordnung kann aber durch Analog
output mode geändert werden.

Dabei gibt es folgende Möglichkeiten:

Active, follows analog input:  Der Analogausgang folgt dem Messwert des 
dazugehörigen Eingangskanals; Default-Modus der Herstellereinstellungen.

Active, follows Counter Input: Der Analogausgang folgt dem Messwert der Counter- 
oder Frequenzmessung. Diese Einstellung ist nur an den Ausgangskanälen (Output 
Channel) 7 und 8 möglich und die Counter/Frequenzmessung selbst sollte  
konfiguriert sein wie ab S. 131 beschrieben. Ausgangskanal 7 entspricht dabei dem 
ersten Zählerkanal und  Ausgangskanal 8 dem zweiten; ist nur ein Zählerkanal 
konfiguriert, verwendet man also Ausgang Nr. 7.

Input independent, write direct only: Der Analogausgang ist vom Eingang getrennt und
kann nur durch Schreibbefehl der Software gesetzt werden. Das ist u.a. nützlich zum 
Testen des Ausgangs. Dazu wählt man zuerst diesen Modus und klickt dann auf 
Store to device. Anschließend kann man unter Output Voltage bzw. Output Current mit 
dem Schieberegler oder der numerischen Zahleneingabe die Spannung bzw. den 
Strom einstellen und anschließend auf Write Value / Set klicken. Dann sollte dieser 
Wert ausgegeben werden, unabhängig von User offset und User scaling factor.
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Active, Software Input: Der Analogausgang ist vom Eingang getrennt und wird zur 
Messlaufzeit von GSVmulti beschrieben. Diese Einstellung ist nur mit GSVmulti PRO 
verfügbar und wird unten genauer erläutert.

Channel off: Der Analogausgang ist deaktiviert.

Analoge Ausgabe von Software-Kanälen

Mit GSVmulti PRO ist es möglich, beliebige Kanäle kontinuierlich auf dem Analogausgang 
auszugeben. Das ist besonders nützlich, wenn es sich um Software-berechnete Kanäle 
handelt, z.B. Math-Channels oder Software-berechnete Mehrachsensensoren (s. S. 39). 
Math-Channels sind Kanäle, die Ergebnisse einer vom Benutzer definierten Rechenvorschrift
(MathScript) ausgeben; sie sind in einer gesonderten Anleitung ausführlich beschrieben.

Wenn dieser Analog output mode gewählt ist, muss man mit dem Auswahlelement Software
Input Channel den Quellkanal, d.h. dieser muss zum Konfigurationszeitpunkt bereits 
eingebunden sein. Es können nur angezeigte Kanäle ausgewählt werden, keine versteckten 
(also nicht solche, die mit Menüleiste -> Channel -> Hide ausgeblendet wurden).

Wenn man dann Store to device klickt, wird im GSV-8 der Input independent, write direct only 
Modus gesetzt und die Information über die Analogausgabe via Software speichert 
GSVmulti in seiner Konfigurationsdatei. Es ist sinnvoll, die gesamte Kanalkonfiguration u.a. 
in einer Session Datei zu speichern, s. S. 14

Auch die Analogausgangs-Einstellungen User offset und User scaling factor werden zur 
Berechnung der Software-generierten Analogausgabe berücksichtigt, allerdings kann  
Transfer characteristic hiermit keine sinnvollen Werte anzeigen (s.o.).

Die Analogausgabe erfolgt nur zur Messlaufzeit, d.h. nach Klick auf Start Measuring.

Die Aktualisierungsrate des Software-Analogausgangs folgt der Messdatenrate, sofern diese
kleiner als 1000/s ist. Andernfalls wird versucht, jede Millisekunde einen Wert auszugeben. 
Die Aktualisierungsrate wird jedoch durch die Auslastung und die Leistung des PCs u.U. 
eingeschränkt. Auch die zeitliche Äquidistanz der Samples des Ausgangs-DA-Wandlers ist 
nicht unbedingt gegeben, d.h. es kann vorkommen, dass zwischen zwei Aktualisierungen 
gelegentlich etwas mehr Zeit vergeht als sonst.
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Zähler und Frequenzmessung mit GSV-6BT und GSV-8

Mit dem GSV-6BT und den GSV-8 hat man die Möglichkeit, das Signal von digitalen 
Pulsgebern auszuwerten und dafür einen (oder beim GSV-8 auch zwei) zusätzliche 
Messkanäle zu konfigurieren. Der Pulsgeber kann ein Inkrementalgeber mit A/B Spur sein 
oder auch ein einfacher optischer oder magnetischer Schalter. Hiermit können je nach 
Sensor, Anordnung und Gerätekonfiguration Größen wie Position, Drehwinkel oder Weg 
sowie Geschwindigkeit, Frequenz oder Drehzahl gemessen werden. Detaillierte 
Beschreibungen liegen für beide Geräte in Form von gesonderten Bedienungsanleitungen 
vor, die Anschlussbelegung geht aus den allgemeinen Bedienungsanleitungen hervor. Der 
Konfigurationsdialog wird über Menüleiste -> Device -> Advanced Settings -> Value Mode 
durch Klicken auf Counter/Frequency/Speed Open Dialogue geöffnet. Im unteren Bereich 

kann man User Scale, User Offset 
und die Einheit Unit bedienen; 
diese Einstellungen entsprechen 
denen im Configuration 
Hauptfenster. Neben Measurable 
Value Range wird der messbare 
Wertebereich von (From) bis (To) 
angezeigt, der auch anhand der 
Benutzereingaben aktualisiert 
wird.

Beim GSV-8 können bis zu zwei 
Sensoren mit Pulsausgang 
angeschlossen werden, die dann 
mit Counter No. ausgewählt 
werden; wird nur einer verwendet, 
muss dieser Nummer 1 sein. 
Function beschreibt die 
Grundfunktion:

Disabled: Der Zählereingang ist abgeschaltet und der Zählerkanal nicht vorhanden.

Counter / Position / Angle:  Der Zählereingang ist als Zähler konfiguriert, d.h. Pulse 
oder Pulssequenzen werden ganzzahlig gezählt. Weitere Details unten.

Frequency / Speed: Der Zähler wird zur Frequenzmessung verwendet. Diese 
Einstellung eignet sich z.B. zur Messung von Geschwindigkeit, Frequenz oder 
Drehzahl. Weitere Details unten.

Both Counter and Frequency (nur GSV-8): Vom Zählereingang 1 wird sowohl der 
Zählerstand als auch die Frequenz berechnet und in zwei zusätzlichen Kanälen 
ausgegeben. Die Bedienung / Anzeige User Scale, User Offset, die Einheit Unit und die 
Anzeige des Wertebereichs wird mit Show / Store values for umgeschaltet.

Unter Hardware und Input Mode werden Einstellungen festgelegt, die u.a. anhand des 
angeschlossenen Pulssensors auszuwählen sind. Die Eingangsmodi Input Mode bestimmen
die Art der Pulsauswertung, sie hängen u.U. mit anderen Modi Function und Method 
zusammen, siehe dort.
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Non-QEI: A=freq, B=dir: Die QEI-Encoder-Auswertung ist
abgeschaltet, es wird ein Rechtecksignal an Eingang A erwartet.
Der Eingang B bestimmt die Zählrichtung (bzw. das Vorzeichen bei
Frequenzmessung): High = offengelassen: Vorwärts. Low = Auf
Masse gelegt: Rückwärts. Dieser Modus kann bei allen Messtypen
und Methoden angewendet werden.

QEI input x1: Bei einem kompletten Quadraturzyklus (siehe Bild)
wird um 1 vor- oder zurückgezählt; die Zählrichtung ergibt sich aus
dem Vor- oder Nacheilen des A- ggü. dem B-Signal: A-Puls zuerst:
Vorwärts, B zuerst: Rückwärts. Dieser Modus hat die höchste
Abdeckung der Fehlsignalunterdrückung.

QEI input x2: Bei einem kompletten Quadraturzyklus (siehe Bild)
wird um 2 vor- oder zurückgezählt und bei einem halben Zyklus um
1. Die Zählrichtung ergibt sich stets aus dem Vor- oder Nacheilen
des A- ggü. dem B-Signal.

QEI input x4: Bei einem kompletten Quadraturzyklus (siehe Bild)
wird um 4 vor- oder zurückgezählt und bei 1/4 Zyklus um 1.

Unter Hardware kann man beim GSV-8 folgendes einstellen:

Use Pull-Up: Wenn diese Checkbox gesetzt ist, liegen an den QEI/Zählereingängen 
Pullup-Widerstände. Diese Einstellung ist nötig, wenn der angeschlossene Pulsgeber 
nur zwischen den Zuständen 'offen'=hochohmig und 'geschlossen'= mit GND 
verbunden umschaltet (sog. Open-Drain Ausgang). Auf diese Weise dürfen auch 
Geber mit einer von 5V verschiedenen Betriebsspannung verwendet werden. Wenn es
hingegen ein 5V Push-Pull Ausgang ist, kann man Use Pull-Up weglassen.

Input Filter: Die Auswertungshardware biete ein Eingangsfilter, das sehr kurze 
Störpulse unterdrücken kann; allerdings verringert sich die Maximalfrequenz der 
Eingänge in allen Modi auf 200kHz und auch die Messgenauigkeit bei 
Periodendauermessung degradiert etwas (siehe ba-gsv8-Inkrementalenkoder.pdf).

Zählermessung

Bei Messungen als Zähler wird die Auswahl Function auf Counter / Position / Angle gesetzt. 
Diese Einstellung eignet sich z.B. zur Messung von Position, Drehwinkel oder Weg. Es kann 
vor- und zurückgezählt werden, siehe Beschreibung der Eingangsmodi Input Mode, die hier 
alle zur Verfügung stehen. User Scale und User Offset werden verwendet, um den 
Zählerstand in die interessierende Größe umzurechnen, daher kann das Endergebnis auch 
nicht-ganzzahlig sein. Der Zähler kann wie jeder analoge Messwert mit Set Zero auf 0 
gesetzt werden. Es gibt folgende Optionen:

Store value at power-off: Beim Ausschalten des Gerätes 
wird der aktuelle Zählerwert gespeichert und beim 
nächsten Einschalten wieder hergestellt. Das ist z.B. bei 
absoluter Wegmessung nützlich; allerdings muss dann 
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darauf geachtet werden, dass der Wegsensor nie bei ausgeschaltetem Gerät 
verfahren wird.

Saturate to numeric limits: Der Zählwert wird bei Überschreitung des Maximums und 
Unterschreitung des Minimums gesättigt; dieser Sättigungswert richtet sich nach 
dem eingestellten Integer-Messwertdatentyp (s. S.110) und ist beim Typ Float 10 
Millionen. Wenn sich die Zählrichtung umkehrt und er wieder in den darstellbaren 
Wertebereich eintritt, wird der Sättigungszustand automatisch zurückgesetzt. GSV-8: 
Wenn die Sättigung aus ist, läuft der Zähler über, d.h. von hohen positiven oder negativen Werten zu 
Null und wenn der interne 32-Bit Zähler überläuft, von hohen positiven Werten zu negativen und 
umgekehrt. GSV-6: Wenn die Sättigung aus ist, läuft der Zähler über, d.h. von hohen positiven zu 
negativen Werten bei Vorwärtsrichtung und umgekehrt bei Rückwärtsrichtung.

Use Home / Index input: Der QEI Decoder bietet neben den notwendigen Anschlüssen 
A, B und GND einen zusätzlichen Eingang Home/Index. Durch diese Option wird er 
verwendet und ist der Eingang dann aktiv, so wird der Zählwert auf einen 
vordefinierten Wert gesetzt, den man unter Home / Index start value eingibt. In vielen 
Fällen wird 0 verwendet, so dass ein Puls am Home/Index-Eingang den Zähler 
zurücksetzt.

Home/Index inverted (nur GSV-8): Wenn Use Home / Index input gesetzt ist, kann man
hiermit den aktiven Pegel festlegen: Checkbox gesetzt: Aktiv= Low; nicht gesetzt: 
Aktiv=High. Beim GSV-6 ist der Home/Index Eingang standardmäßig invertiert.

Frequenz / Drehzahl / Geschwindigkeit per Zählung

Hierbei wird die Differenz zwischen 2 Zählerständen innerhalb einer Messdatenperiode 
ausgewertet. Die zu messende Frequenz muss daher höher sein als die Messdatenrate.

Die verschiedenen Input Modes stehen alle zur Verfügung. Der Frequenzmessmodus per 
Zählung ist geeignet, wenn bei relativ geringer Datenrate eher hohe Frequenzen gemessen 
werden sollen, z.B. solche, die ein Drehgeber mit vielen Pulsen pro Umdrehung liefert. 
Method unter Frequency / Speed stellt man bei diesem Modus auf Counting Pulses. Die 
Grundeinheit, d.h. die Wertung der Messwerte mit User scale =1, ist in diesem Modus Hz, 
d.h. /s.

Torzeit (Gate time)

Damit die Frequenz (bzw. Geschwindigkeit/Drehzahl) richtig angezeigt wird, muss sich der 
Zähler-Rohwert innerhalb einer Datenperiode möglichst häufig geändert haben, d.h. die 
Betragsdifferenz eines neuen Zählerwertes zu dem vorherigen muss >=1 sein.
Die Messdatenrate ist für alle Kanäle gleich, d.h. sie gilt zunächst auch für die Auswertung 
des Zählers. Um auch relativ niedrige Drehzahlen/Frequenzen bei eher hohen Datenraten 
messen zu können, gibt es die Möglichkeit, die Datenperiode für die Frequenzmessung zu 
vergrößern. Dies geschieht mithilfe eines (ganzzahligen) Datenperioden-Multiplikators, des 
Gate-Time-Counters. Angezeigt und bedienbar ist auch die aus Gate-Time-Counter und 
Messdatenrate folgende Gate time, die die Torzeit in Sekunden angibt.
Die Mindestfrequenz, die gemessen werden kann, berechnet sich somit zu:
fmin = Datenrate / Gate-Time-Counter [Hz]
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Frequenz / Drehzahl / Geschwindigkeit per Periodendauermessung

Hierbei wird die Periodendauer beliebiger Rechtecksignale direkt gemessen. Dieser Modus 
ist besonders geeignet für Drehzahlmessung, bei der pro Umdrehung nur wenige Pulse (z.B. 
1 Puls pro Umdrehung) erzeugt werden, z.B. durch einen magnetischen Schalter, der sich 
auf dem Umdrehungskreis relativ zu einem Magneten bewegt.

GSV-8: Der Quadraturencoder-Modus ist hier irrelevant; es wird stets die Zeit 
zwischen einer Flanke am Eingang A zu der nächsten am Eingang B ausgewertet. Ist 
die QEI-Auswertung aus (Non-QEI: A=freq, B=dir), wird die Periodendauer eines 
Rechtecksignals an Eingang A gemessen und B bestimmt die Drehrichtung. Die 
Genauigkeit und der Wertebereich der Messung sind bei diesem Messmodus 
unabhängig von der Messdatenrate und vom QEI-Decodermodus.
GSV-6BT: Hierbei schaltet der GSV-6BT an Eingang A einen Oszillator  mit f=1MHz zu 
und der Messeingang ist der Eingang I ("Index"). Der Eingangsmodus wird daher auf 
Non-QEI: A=freq, B=dir gesetzt, d.h. der Drehencoder A/B Eingang steht nicht zur 
Verfügung. Der Eingang A muss offen bleiben, andernfalls könnte das Gerät 
beschädigt werden!
Der Eingang B bestimmt das Vorzeichen des Messwertes bzw. die Drehrichtung; wird 
er offengelassen (=high), ist diese stets positiv.
Die Messdatenrate muss bei diesem Periodendauermodus deutlich größer sein als 
die maximal zu messende Frequenz, und zwar mindestens 3 mal höher als diese.

Bei beiden Geräten hat der Gate-time Counter in diesem Modus eine andere Bedeutung: Er 
bestimmt die Zeit, nach der der Messwert auf Null gesetzt wird, wenn am Messeingang 
keine Pulse mehr anliegen. Damit bedingt dieser zugleich das messbare Minimum.
Auch im Periodendauermodus ist die Grundeinheit, d.h. die Wertung der Messwerte mit 
User scale =1, in diesem Modus Hz, d.h. /s.

GSV-8: Frequenz / Drehzahlmessung mit Auto-Period Modus

Wenn die Messmethode Method auf Auto-Period-Mode gestellt ist, entscheidet der GSV-8 
anhand der gemessenen Frequenz automatisch, ob die Zählmethode oder die 
Periodendauermessung verwendet wird. Wenn pro Periode der Messdatenrate der 
Zählerwert kleiner als 2000 ist, wird die Periodendauermessung verwendet, andernfalls die 
Zählmethode. Der Schwellwert ist z.B. bei der Default-Messdatenrate von 10 Frames/s also 
20 kHz. Auf diese Weise kann die Messunsicherheit im gesamten Messbereich bei unter 
0,05% v.S. gehalten werden.
Die Torzeit wird in diesem Modus nicht verwendet, auch der QEI- Eingangsmodus hat keine 
Wirkung.

Beispiele zur Einstellung von User Scale zur Anpassung an bestimmte encoder:

Beispiel 1: Mit einem Drehencoder soll die Drehzahl in Umdrehungen pro Minute gemessen 
werden (Einheit rpm). Der Encoder liefere 360 vollständige Quadratur-Zyklen pro 
Umdrehung. Der Eingangsmodus sei QEI input x1. Dann wird User Scale auf folgenden Wert 
gestellt: 60 U/min / 360 = 1/6 = 0,1666667 rpm.

Beispiel 2: Mit demselben Encoder soll U/min = rpm angezeigt werden, der Eingangsmodus 
sei aber QEI input x4. Dann stellt man wird User Scale auf folgenden Wert gestellt: 
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60 U/min / (360*4) = 1/24 = 0,041666667 rpm.

Beispiel 3: Mit einem magnetischen
Linearencoder und GSV-8 soll Position in mm
und Geschwindigkeit in m/s zugleich
angezeigt werden. Er liefere 4 vollständige
Quadratur-Zyklen pro mm. Man kann dann z.B.
so konfigurieren:
Der erste Messkanal ist der Weg (Counter), 
User Scaling = 1/(4*4), der zweite die
Geschwindigkeit (Speed),  User Scaling= 
1/(4*4*1000)

Wenn die Zähler/Frequenzmessung konfiguriert ist, wird ein neuer Kanal im Gerät erzeugt, 
den man öffnen kann wie auf S. 13 beschrieben.

Weiteres zur Geräteadministration

Im folgenden werden bisher nicht behandelte Einstellungen und Informationen beschrieben, 
die in Menüleiste  → Device  Advanced Settings  Administration→ →  erreichbar sind.

Fehlerspeicher des GSV-8

Der GSV-8 hat einen Fehlerspeicher, der vor allem Störungen speichert, deren Ursache in 
falschem Anschluss oder fehlerhaftem Sensor liegt. Es werden bis zu 81 Fehler gespeichert.
Sie können durch Klicken auf Fault Memory / Open Dialogue eingesehen werden:

Durch Anklicken werden die Einträge 
markiert und unten unter Details 
werden Einzelheiten dieses Fehlers 
angezeigt. No/age ist die Nummer des
Eintrags, mit dem neuesten 
beginnend. Unter Occurred at working 
hours wird die Betriebszeit (die Zeit 
des Betriebsstundenzählers, s.S. ) 
angezeigt, zu der der Fehler auftrat, im
Format Stunden:Minuten. Fault type 
no / Kind of fault nennt die Art der 
Störung und kann folgende Einträge 
enthalten:

1: Sensor input saturation: Ein Sensoreingang war gesättigt, d.h. der Messbereich 
wurde überschritten. Unter Details wird mit input channel(s) der oder die 
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Eingangskanal/kanäle genannt, an denen der Fehler aufgetreten war. Mögliche 
Ursachen:

• Defekter Sensor

• Überlasteter Sensor

• Defektes Sensorkabel 

• Falscher Sensoranschluss

• Input Type falsch gewählt, d.h. Eingangsmessbereich zu klein

2: Sensor maximum exceedance: Bei einem Mehrachsensensor wurde das für diesen 
Sensor gespeicherte Maximum überschritten. Unter Details wird mit physical 
channel(s) der oder die Eingangskanal/kanäle genannt, an denen der Fehler 
aufgetreten war. Er kann die gleichen Ursachen haben wie (1), zusätzlich könnten 
falsche Sensorkalibrierdaten geladen worden sein, s.S. 39

3: Sensor or sensor connection broken: Bei einem Brückeneingang wurde ine falsche 
Gleichtaktspannung an Ud+ oder Ud- ermittelt. Unter Details wird mit input channel(s) 
der oder die Eingangskanal/kanäle genannt, an denen der Fehler aufgetreten war und 
die Leitung Ud+ / Ud- wird auch genannt. Mögliche Ursachen:

• Defekter Sensor

• Falscher Sensoranschluss

• Defektes Sensorkabel: Kurzschluss oder Leitung offen

4: Analog output: wrong connection: Fehler am Anschluss eines Analogausgangs. 
Möglicher Ursache ist ein offener Stromausgang oder ein überhitzter 
Ausgangstreiber(Output driver overheated), z.B. durch Kurzschluss eines 
Spannungsausgangs. Ein nicht angeschlossener Stromausgang (Open current 
output) wird als Fehler interpretiert, der Ausgangskanal wird unter Details genannt (... 
at channel...)

5: Digital output: Wrong connection: Kurzschluss (Short circuit) an einem 
Digitalausgang (DIO no), der in Details genannt wird. Die Ursache kann auch sein, 
dass an einem als Ausgang konfigurierten DIO wiederum ein Ausgang angeschlossen
wurde (level collision)

Flags (Hex) sind Angaben über Kanal- oder I/O-Nummern, die für jede Fehlernummer unterschiedlich 
definiert und in der Protokollbeschreibung dokumentiert sind.

Mit Save to File kann der Fehlerspeicherinhalt in eine Textdatei exportiert werden, sie hat per 
Default den Namen FaultMemory.log. Sie enthält einen Header, der u.a. die aktuellen 
Betriebsstunden nennt (Device working hours) und für jeden Eintrag eine Zeile. Z.B. ergibt 
oben gezeigter Fehlerspeicher folgenden Dateiheader und die erste Zeile:
Fault memory saved from GSV-8 Ser.No: 16256044 Date: Mi, 24. Jan 2024 Time: 19:59 Device working hours: 4895:5

No/age Fault type no / Kind of fault Occurred at working hours [H:MM] Flags (Hex) Details
1 2: Sensor maximum exceedance 4231: 9 8 663:56 before now, a multidimensional sensor maximum exceedance occurred. at physical channels: 4

Mit Erase Fault Memory kann der Fehlerspeicher gelöscht werden; das Gerätepasswort wird 
dabei abgefragt. Das Löschen kann nicht wieder rückgängig gemacht werden!
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Durch Klicken auf Refresh können Fehler, die eventuell neu aufgetreten sind, nachgeladen 
werden. Der GSV-8 speichert neue Fehler in einem Zeitintervall von mindestens zwei 
Minuten.

Die Log-Datei des Fehlerspeichers ist auch Teil des Settings Archive, s.S. 25.

Betriebsstundenzähler des GSV-8 und GSV-6BT

Der GSV-8 und der GSV-6BT haben Betriebsstundenzähler, der die Zeit zählt, die das Gerät 
eingeschaltet ist. Sie werden in der Administrator Karteikarte unter Device working hours 
angezeigt. Es gibt zwei Zähler: Einen absoluten, der nicht zurückgesetzt werden kann (Total 
device working hours) und einen, der von Benutzer auf 0 gesetzt werden kann, z.B. um die 

Zeitdauer einer bestimmten Messkampagne zu überprüfen. Er wird User 
device working hours genannt und wird mit Klick auf Reset user device 
working hours / Clear auf 0 gesetzt.

GSV-2 Menüsprache

Bei GSV-2 Messverstärkern mit Tastatur und LCD-Menü kann man unter Menu 
language of device die Sprache des Gerätemenüs einstellen (English oder German
= deutsch).

Driftkompensation mit GSV-2

Die meisten Sensoren driften aufgrund von Temperaturänderungen. Bei manchen wird dies 
gut kompensiert, bei anderen wie z.B. Dehnungsindikatoren und Einzel-
Dehnungsmessstreifen ist dies nicht immer gut möglich. Der GSV-2 bietet für solche Fälle 
einen Algorithmus zur Driftkompensation an, der den Transienten des Messwertes (d.h. 
seine zeitliche Änderung/Ableitung) mit einer vordefinierten Schwelle vergleicht. Messwerte, 
die sich langsamer ändern als dieser Transienten-Schwellwert, werden vom GSV-2 nicht 
ausgegeben, sondern intern gespeichert.  Messwerte, die sich schneller ändern als dieser 
Transienten-Schwellwert, werden ausgegeben und dabei wird die Differenz zum 
gespeicherten ("gedrifteten") Messwert gebildet.

Entscheidend für die Anwendbarkeit dieser Driftkompensation ist also, dass die 
interessierenden Messwerte (das Nutzsignal) unmittelbar auf eine eher schnelle Änderung 
folgen.

Man erreicht den Konfigurationsdialog der Driftkompensation durch Klicken auf den Button 
Drift Compensation rechts unten in Menüleiste -> Device -> Advanced Settings -> Value 
Mode.
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Der Transienten-Schwellwert wird unter Threshold for Value Transient in Slope in <Einheit> per 
200ms für ein konstantes Zeitintervall von 200ms angegeben. Wenn die Messdatenrate 

kleiner als 5 /s ist so wird der Transient zusätzlich unter 
Slope per Data Period (<1/Messdatenrate>) ms pro 
Messdatenperiode angegeben, weil diese dann kleiner ist als
200ms. Im Bild links z.B. für 3 /s.

Die Multiplikation der Angabe  Slope per 200ms mit 5 ergibt 
die Änderung pro Sekunde.

Man aktiviert die Driftkompensation mit Drift Compensation enabled. Der Messwert wird 
dann nur nach einer gültigen Nutzsignaländerung ausgegeben, d.h. wenn der Messwert sich
schneller änderte als der  Transienten-Schwellwert. Man kann zusätzlich eine Wartezeit 
definieren, innerhalb derer auch schnelle Änderungen (z.B. Schwingungen) nach einem 
gültigen Messwert ignoriert werden. Diese wird unter Wait Time in Sekunden angezeigt; Wait
Counter ist eine Zähler dieser Zeit in 200ms Intervallen. Nach Erkennen eines gültigen 
Messwertes wird diese Zeit gewartet, bis wieder der aktuelle Messwerttransient mit dem  
Transienten-Schwellwert verglichen wird wie oben beschrieben.

Für die Verwendung der Driftkompensation sind niedrige Messdatenfrequenzen <50/s 
empfohlen.

Eine typische Anwendung ist ein Dehnungsindikator an einem metallischen Pfeiler, der einen
Kran trägt. Gemessen werden soll die aufgenommene und abgeworfene Last des Krans. Der
Pfeiler ist Temperaturschwankungen unterworfen, die sich im Signal des  Dehnungsindikator
als Drift bemerkbar machen. Die Aufnahme und Abgabe der Last erfolgt viel schneller als die
Temperaturdrift, sofern die Last ein gewisses Minimum nicht unterschreitet. Man macht 
zuerst Testmessungen ohne Driftkompensation, um die Nutzsignal-Transienten und die 
optimale Messdatenrate zu bestimmen (s.S. 17, man benötigt beim Testen hier aber keine 
sehr hohe Rate; ca. 10 Hz genügen) und nimmt diese auf. In diesem Beispiel sollten die 
Testmessungen die Aufnahme und Angabe minimaler und maximaler Lasten enthalten und 
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ggf. verschiedene Fahrgeschwindigkeiten. Aus der Aufnahme der Messung kann man dann 
den Transienten-Schwellwert und ggf. die Wartezeit bestimmen (letzteres z.B. aus der Zeit 
der Schwingung aufgrund der Laständerung), um die Driftkompensation zu konfigurieren. 
Anschließend empfehlen sich weitere Tests mit aktivierter Kompensation. Die 
Driftkompensation kann die Messunsicherheit etwas vergrößern.

Weitere Software-Präferenzen

Hier werden bisher nicht behandelte Einstellungen unter Menüleiste -> Options -> 
Preferences  und ->Default Settings erklärt.

In der Ausgangskonfiguration wird der Benutzer beim Starten der Messung gefragt, ob er 
diese auch aufnehmen will. Diese Frage kann man unterdrücken, indem bei dieser Meldung 
die Checkbox Don't ask anymore and always perform selected action aktiviert wird:

Je nachdem, ob anschließend Yes für Aufnehmen oder No für 
nicht Aufnehmen geklickt wird, gilt dies für jeden zukünftigen 
Klick auf Start Measuring. Dieses Verhalten kann man auch in  
Menüleiste -> Options -> Preferences -> At Start Measuring 
konfigurieren:

Wenn die Checkbox Ask for recording the measuring data nicht gesetzt ist, 
wird die Frage nach der Aufnahme bei Start Measuring nicht gestellt. Dann 
kann man unter If not, do you always want to record the data? festlegen, ob 
Start Measuring immer automatisch aufzeichnet (Yes) oder nicht (No).

Beim Schließen des Programms wird der Benutzer gefragt, ob er eine Session-Datei 
speichern will, falls sich etwas geändert hat, das für die Session Datei relevant ist (z.B. 

Kanäle hinzugefügt oder entfernt wurden), s. S. 14.

Man kann diese Frage unterdrücken, indem in dieser 
Meldung die Checkbox Don't ask anymore and always 
perform selected action aktiviert wird. Je nachdem, ob 
anschließend Yes für Speichern oder No für nicht 
Speichern geklickt wird, gilt dies für jede zukünftige 
Programmbeendigung; gespeichert wird jedoch in jedem

Fall nur, wenn Relevantes geändert wurde. Mit automatischem Session-Speichern öffnet 
sich dann bei Beendigung eine Dateiauswahlbox, in der die letzte Session-Datei 
vorausgewählt ist. Dieses Verhalten kann man auch in  Menüleiste -> Options -> Preferences 
-> When closing the program konfigurieren:

Wenn die Checkbox Ask for saving the session, if session data has 
changed nicht gesetzt ist, wird die Frage nach dem Speichern bei 
Programmbeendigung nicht gestellt. Dann kann man unter If not, do you 
always want to save the session? festlegen, ob nach jeder relevanten 
Änderung gespeichert werden soll (Yes) oder nie automatisch (No).
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Wenn mehrere GSVs eingebunden sind und diese unterschiedliche Messdatenfrequenzen 
haben (was nicht empfohlen wird), so wird der Benutzer bei Klick auf Karteikarte Recorder Yt
oder XY gewarnt, wenn die Differenz größer als 5 ist:

Wenn man darin die Checkbox Don't show this warning again 
aktiviert, wird diese Warnung nicht mehr ausgegeben. Das kann 
man auch mit einer Checkbox unter Menüleiste -> Options -> 
Preferences  mit Warn if device data rates are different 
konfigurieren.

Weitere Einstellungen in Options->Preferences betreffen den XY Rekorder (S. 58), das Single 
Value Display (S. 30), die Anzahl angezeigter Dezimalstellen von Messwerten (S. 32) und das
Zeitintervall des Lesens von Messdaten aus den Messverstärkern (S. 31).

Unter Menüleiste -> Options -> Default Settings kann auf die Grundeinstellungen der 
Software zurückgesetzt werden. 

Wenn man Yt / XY recorder: Reset Graph Scaling klickt, werden z.Zt. (bis
inkl. Version 2.1) nur die Skalierungen beider Achsen des XY-Recorders 
und die Y-Achse des Yt-Recorders zurückgesetzt. Bei Eintritt in die 
entsprechende Karteikarte kommt dies zur Wirkung.

Wenn man Reset all program settings to default values klickt, werden 
alle Software Einstellungen zurückgesetzt zu dem Zustand nach der 

Installation von GSVmulti. Dazu muss eine Abfrage bestätigt werden (Are you sure to reset 
the program settings?) und man wird dann darauf hingewiesen, dass das Zurücksetzen erst 
nach einem Neustart des Programms zur Wirkung kommt. Das Zurücksetzen hat keinen 
Einfluss auf Einstellungen der Messverstärker Hardware, es kann aber nicht rückgängig 
gemacht werden.

Werkzeuge für Messdatendateien TDMS Tools

Das Standardformat für Messdatendateien, *.tdms wurde mehrfach erwähnt, z.B. S. 33. Durch 
Menüleiste -> File -> TDMS Tools öffnet sich eine Auswahl für verschiedene Werkzeuge, mit 
denen besondere Aufgaben und Reparaturen an Messdatendateien durchgeführt werden 
können.
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Mit Try to Fix File / Repair kann man versuchen, eine defekte tdms-Messdatendatei zu reparieren. 
Dabei ist nicht garantiert, dass dies gelingt und es kann auch sein, dass Teile der Daten verloren 
gehen, der Rest aber wieder lesbar wird. Eine solche defekte Datei kann beispielsweise entstehen, 
wenn der PC während einer Aufnahme abstürzt oder ein Stromausfall vorkam oder GSVmulti 
irregulär geschlossen wurde (z.B. durch den Windows Task-Manager). Beim Versuch, eine solche 
Datei mit dem File Monitor zu öffnen, eine Fehlermeldung erscheinen.

Nach Klicken auf  Try to Fix File / Repair wählt man die defekte tdms Datei aus, sie wird dann unter 
einem andern Namen gespeichert, und zwar wird dem Original-Dateinamen _fixed angehängt.

Mit Make Compatible / Fix Group Name wird eine *.tdms Datei, die von einem anderen Programm 
erzeugt wurde, für GSVmulti kompatibel gemacht, so dass sie mit dem File Monitor geöffnet werden 
kann. In tdms Dateien sind die Kanäle grundsätzlich Gruppen (Groups) zugeordnet und GSVmulti 
erwartet eine Gruppe, die den Namen Measuring values hat. Nach Klick auf Make Compatible / Fix 
Group Name wählt man die zu ändernde Datei aus. Die erste Gruppe der Datei wird nach Bestätigung
durch den Benutzer umbenannt und deren Kanäle können dann im File Monitor betrachtet werden, 
sofern es sich um reguläre Messdaten handelt. Achtung: GSVmulti benennt bis einschließlich 
Version 2.1 diese Datei nicht um, sondern ändert sie nur. Es wird daher empfohlen, die Datei vor 
Verwendung von  Fix Group Name manuell umzubenennen.Ab Version 2.2 wird dem Original-
Dateinamen _changed angehängt werden.

Mit Defragmentation / Defragment werden tdms Dateien defragmentiert. Das kann sinnvoll sein bei 
sehr großen Dateien, weil diese einige redundante Einträge haben können, etwa Properties.

Master-Slave Dateien von GSV-6BT zusammensetzen

Der GSV-6BT unterstützt die auf S. 14 beschriebene Hardware-Synchronisation. Die 
Aufnahme von Messdaten auf der SD-Karte (s. S. 33) kann jedoch aus verschiedenen 
Gründen nicht auf triviale Weise synchron erfolgen. Das Starten der Aufnahme kann und 
sollte zwar per Hardware-Schalter erfolgen, indem jeweils der nicht für Master-Slave 
verwendete Digitaleingang dafür konfiguriert (s. S. 119, Typ: Trigger File Log) und verdrahtet 
wird, aber der Zeitpunkt, wann die Aufnahme tatsächlich begonnen wird, ist etwas ungewiss.

Jedoch unterstützt der GSV-6BT einen Mechanismus, um zwei Zeilen etwa 0,2 bis 0,4 
Sekunden nach dem Start der Aufnahme einer Datei im Master- und Slave Gerät zum 
gleichen Zeitpunkt zu markieren. Der Master schreibt dazu ein M an das Ende dieser Zeile 
und der Slave ein S.

Zum Beispiel:
22/04/01,17:43:27.46500 -0.00423 2.10000 2.10000 -2.10000 -2.10000 -2.10000 19964.02930 M

22/04/01,17:42:27.18348 -0.00410 2.10000 2.10000 -2.10000 -2.10000 -2.10000 32014.39063 S

In diesem Beispiel hatten die beiden RTC Uhren eine Zeitdifferenz von ca. 1 Minute. Man kann die 
Zeitunterschied etwas minimieren, indem man die RTCs beider GSV-6BT mit Klick auf Sync. setzt, 
wie ab S. 33 beschrieben, jedoch werden sie dennoch etwas auseinanderlaufen.

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de
16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de 141



Um diese beiden Dateien zusammenzusetzen, klickt man zunächst auf Merge and import 
Master/Slave txt files / Concatenate in den TDMS File Tools und es öffnet sich folgender 
Dialog:

Man wählt mit Add File die zeitlich zusammengehörenden Dateien nacheinander aus. Eine 
sollte die eines Masters sein, was man an dem X in der Spalte Master sieht. Dann klickt man 
auf Merge files und wählt das Zielverzeichnis für die Messwertdatei im Textformat aus, die 
dann alle Kanäle beider Geräte in nebeneinanderliegenden Spalten enthält und zeitlich 
zusammengesetzt ist. Dabei werden ggf. Messwerte am Anfang und am Ende weggelassen,
um die Anzahl der Messwertezeilen anzugleichen. Anschließend kann man auswählen, ob 
diese Datei in eine weitere im tdms Format konvertiert werden soll. Die Kanäle des Masters 
bilden die ersten Spalten, die der Slaves die weiteren, deren Kanalnamen _1 und ggf _2 usw 
angehängt wird:
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Problembehandlung

Im folgenden werden häufig auftretende Probleme, Fehlermeldungen und mögliche 
Lösungen beschreiben. Weitere Tipps erhält man auf der ME-Website, z.B. in der 
Wissensdatenbank.

1. Das Gerät kann nicht mit Add Channel geöffnet werden

Um ein Gerät erfolgreich öffnen zu können, sollten drei Informationen bekannt sein und 
richtig eingegeben werden:

• Das Gerätemodell, z.b. GSV-2, GSV-8, GSV-6 seriell oder GSV-6CAN. In manche Smart
Sensors ist ein digitaler Messverstärker eingebaut, z.B. ein GSV-6 CAN. Typenschild, 
Datenblatt oder Bedienungsanleitung sollten Auskunft geben.

• Die COMport Nummer. In vielen Fällen sind im Pull-Down Menü 
COMport Number des Add Channel Dialogs nur wenige Einträge
und man findet den richtigen leicht. Einträge in spitzen Klammern,
wie hier gezeigt, sind wahrscheinlich nicht richtig. In selteneren Fällen ist die 

COMport Nummer bekannt, jedoch nicht in der Liste. 
Dann kann man sie in dem kleinen Zahleneingabe-
Element rechts neben dem Pull-Down Menü eingeben. 
Um eine unbekannte COMport Nummer 
herauszufinden, kann man im Windows Geräte-
Manager nachsehen: Auf das Windows-Symbol in der 
Startleiste klicken, Dev eingeben oder im Suchfeld auf 
der Taskleiste Geräte-Manager eingeben und dann 

diesen öffnen.

Darin können Einträge wie "USB Serial Port" GSVs mit USB sein oder "BX-8 
Communication" ein GSV-8. "Seriell-über-Bluetooth Verbindung" o.ä. ist der COMport 
eines Bluetooth Gerätes. Dazu muss dieses aber bereits gekoppelt sein. Taucht kein 
Seriell-über BT Eintrag im Gerätemanager auf, muss man das Gerät koppeln. Dazu 
muss die Stromversorgung angeschlossen sein und es muss in der Nähe sein, 
außerdem benötigt der PC einen Bluetooth Adapter. Dann kann man vorgehen wie 
hier beschrieben, dabei oben die Windows-Version auswählen und vorgehen wie 
unter "So koppeln Sie ein [...] anderes Gerät" beschrieben. Falls das nicht klappt oder 
der GSV nicht gefunden wird: Unter Windows 11 muss die Geräteerkennung auf 
Erweitert gestellt werden. Dazu wählt man "Weitere Geräte anzeigen" in den Bluetooth
Einstellungen. Die zugewiesene COMport Nummer sieht man auch unter "Weitere 
Bluetooth Optionen", darin ist "Ausgehend" der richtige Port.

• Die Baudrate (Bitrate). Bei den meisten seriellen Ports muss sie richtig ausgewählt 
werden sein, s.S. 104

Wenn das Öffnen des Gerätes fehl schlägt, erscheint oft eine Fehlermeldung. Hier die 
Aufschlüsselung der häufigsten Meldungen:

• Error 2 occurred ... oder:
Error 536870914 occurred at ... Possible reason(s): OS reported Error 2: Port or file not found. 
Windows gibt diese Fehlermeldung zurück (File not found), meistens ist dann die 
COMport-Nummer falsch s.o.
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• Error 5 occurred ... oder:
Error 536870917: Windows gibt diese Fehlermeldung zurück (Access denied), 
meistens ist dann der COMport bereits durch ein anderes Programm geöffnet.

• Error 121 occurred ... Windows gibt diese Fehlermeldung zurück. Wenn es sich um ein 
Bluetooth Gerät handelt, könnte die Batterie schwach oder nicht angeschlossen sein. 
Es können mit einem BT-COMport auch Fehlermeldungen mit gleichem Text aber 
anderen Fehlernummern <2000 auftraten.

• Error 805306456 occurred ... Possible reason(s): MEGSV86xx.DLL: Command response 
from device timed out. Die GSV-6/-8 API gibt  diese Fehlermeldung zurück. Oder:
MEGSV4.dll Error: No answer from GSV Oder:
Error 805306612 ... Possible reason(s): MEGSV.DLL: Com port could be opened, but no 
GSV answered. Die GSV-2/-3 API gibt  diese Fehlermeldung zurück.
Der COMport konnte zwar geöffnet werden, aber kein GSV antwortete. Mögliche 
Ursachen:

◦ Der GSV wird nicht richtig mit Strom versorgt

◦ Ein USB-Umsetzerkabel (wenn verwendet) ist defekt oder UART- bzw. GSV-seitig 
falsch angeschlossen

◦ Ein RS232 Kabel (wenn verwendet) ist defekt oder falsch angeschlossen

◦ Die Baudrate ist falsch, siehe oben und S. 104

◦ Die Baudrate stimmt zwar, wird aber vom USB-Umsetzer (wenn verwendet) oder 
anderen Schnittstellenwandlern oder -umsetzern nicht unterstützt oder diese sind
nicht dementsprechend konfiguriert (z.B. Moxa f. Ethernet).

◦ Es ist ein anderes GSV-Modell an dem COMport angeschlossen als unter Device 
Type eingestellt oder ein ganz anderes oder gar kein Gerät ist angeschlossen

◦ GSV-8 über UART: Die verwendete UART-Schnittstelle ist im GSV-8 ausgeschaltet, 
s. S. 104

2. Es kommen keine Messwerte

Dieses Problem triff auch dann auf, wenn bei mehreren eingebundenen GSVs nur einer keine
Messwerte sendet. GSVmulti erwartet eine Messdatenstrom von allen geöffneten GSVs. 
Häufig wird dann timeout in der Messwertanzeige der Configuration Karteikarte angezeigt. 
Mögliche Ursachen:

• Das Gerät ist als Synchronisations-Slave konfuguriert, s. S. 14. Wenn der GSV als 
Einzelgerät ohne Master betrieben werden soll, sollte keiner der Digital-IOs als Sync-
Slave konfiguriert sein; diesen ggf. auf GPinput zu setzen, s. S. 119
Wenn es zusammen mit einem Master betrieben werden soll, muss dieser richtig 
konfiguriert und mit dem Slave mit einer Sync-Leitung verbunden werden.

• Die permanente Messdatenübertragung ist abgeschaltet, s. S. 107

• Die eingestellte Messdatenrate ist zu hoch, s. S. 17

ME-Meßsysteme GmbH
Eduard-Maurer-Str. 9 Tel.: +49 3302 89824 10 Mail: vertrieb@me-systeme.de

144 16761 Hennigsdorf Fax: +49 3302 89824 69 Web: www.me-systeme.de



• Die Kommunikation ist zwischenzeitlich unterbrochen worden. Tipps dazu auf S. 118.
Ursache kann z.B. ein abgezogenes Schnittstellenkabel oder eine schlechte BT-
Funkverbindung sein.

3. Die Messwerte laufen in der grafischen Darstellung langsam und ruckartig

Dies ist in der Regel nur ein Darstellungsproblem, d.h. bei einer Aufnahme gehen nur in 
extremen Fällen Daten verloren und auch die Zeitstempel sind i.d.R. korrekt. Mögliche 
Ursachen:

• Die Messdatenrate ist ungewöhnlich niedrig eingestellt (z.B. < 1/s), s. S. 17. Beim 
GSV-2 oder GSV-3 könnte der Langsame Modus eingestellt sein. Zum Ändern einfach
die Messdatenrate erhöhen.

• Treibereinstellung ungünstig. Beim folgenden GSVs mit USB: GSV-2TSD-DI, GSV-
3USB, GSV-4USB oder GSV-6Dev kann man die Wartezeit des Puffers des FTDI-
Schnittsttstellentreibers verkürzen. Dazu öffnet man den Geräte-Manager (siehe 1.) 
und klickt dem zugehörigen COMport Eintrag mit der rechten Maustaste an und 
wählt "Eigenschaften", dann Anschlusseinstellungen und klickt "Erweitert". Dann setzt 
man im folgenden Dialog die Wartezeit auf 1ms, alles mit OK bestätigen und ggf. PC 
Neustarten.

• Der PC ist sehr ausgelastet. Um zu ergründen, welches Programm den PC langsam 
macht, kann man die Tasten Strg und Alt zugleich gedrückt halten und dann Entf 
drücken und dann den Windows Task-Manager wählen. Darin die Karteikarte 
Prozesse öffnen und nach CPU sortieren, so dass der oberste die höchste CPU-Last 
anzeigt. Überlegen Sie, ob dieser Prozess geschlossen werden darf. Wenn es 
GSVmultichannel ist, das die hohe CPU-Last benötigt und vielleicht auch sehr viel 
Arbeitsspeicher, so kann das bei vielen Messkanälen und hohen Messdatenraten 
normal sein. Insbesondere MathChannels können viel Leistung benötigen (je nach 
Rechenaufwand). Was hierbei helfen kann:

◦ Das Öffnen der Karteikarte Graph Display vermeiden, vor allem, wenn mehr als 3 
Kanäle offen sind. Die vielen Einzelgrafen hierin benötigen mehr Leistung als der 
Recorder Yt. Am wenigsten Leistung benötigt die Configuration Karteikarte.

◦ Während der Messung kein Fenster in der Größe ändern. Die Fensterskalierung 
benötigt Leistung, die zwar verzögert und niedrig priorisiert ist, aber dennoch dem
Mess-Task kurzzeitig Leistung nimmt.
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◦ Bei MathScript: Wenn möglich, die Komplexität des Skriptes verringern, z.B. 
Konstanten zusammenfassen und die Anzahl der Operationen verringern. Der 
MathScript Parser führt keine Optimierungen durch.

◦ Nicht benötigte Kanäle entfernen (Remove Channel) oder verstecken, s. S. 16

◦ Messdatenrate verringern, s. S. 17

4. Bei Verwendung mehrerer GSVs laufen die Messwerte zeitlich auseinander.

Lösung: Die Messdatenrate aller Geräte möglichst gleich einstellen und wenn möglich, die 
Master-Slave Synchronisierung verwenden, s. S. 14

5. Aus einem grafischen Diagramm werden Daten gelöscht

Der Recorder Yt speichert eine Historie, d.h. "hinter" dem linken Rand sind noch Messdaten 
im Grafen gespeichert. Dieser hat eine konstante Tiefe von Datenpaketen. Ist Autoscale X 
gewählt, kann es passieren, dass nach einer gewissen Zeit Daten herausfallen; ähnliches 
kann auch im Recorder XY bei hohen Messdatenfrequenzen oder sehr langer 
Aufzeichnungszeit geschehen. Folgendes kann Abhilfe bringen:

• Vergrößern des Erfassungsintervalls, s. S. 31

• Aufnehmen der Messwerte (Start Recording) und nachträgliche Auswertung statt 
Live-Auswertung

• Im Recorder XY: Verwendung der Trigger-Funktion, wenn möglich, s. S. 56

6. Der Versuch, eine Konfigurationseinstellung im GSV zu ändern schlägt fehl

Wenn man beim Versuch, eine Geräteeinstellung zu ändern (gelbes Bedienelement) eine  
Fehlermeldung erhält oder beim abermaligen Lesen der Wert nicht wie erwartet angezeigt 
wird, sondern unverändert ist, kann das verschiedene Ursachen haben. Beim GSV-6 und 
GSV-8 wird dann meistens eine der folgenden Fehlermeldungen angezeigt; die 
beschriebenen Ursachen und Lösungen können aber auch für den GSV-2 und den GSV-3 
zutreffend sein:

• Error 939524213 occurred ... Possible reason(s): Device: Access from this port denied 
(other port seems to have write access): Eine andere Schnittstelle hat das 
Schreibrecht und diejenige, mit der das Gerät gerade geöffnet wurde, darf keine 
Betriebsparameter verändern. Diese andere Schnittstelle kann eine weitere serielle 
sein (z.B. UART bei GSV-8) oder CANopen bei GSV-2 und GSV-8-CAN oder GSV-8 
EtherCAT. Bei CANopen kann man als Abhilfe das CAN-Interface abschalten (s. S.
107 oder mit einem CANopen Master-Programm das Gerät in den Stopped-State 
versetzen. Bei EtherCAT kann man den GSV-8 mit abgezogener EtherCAT 
Schnittstelle neu starten oder es in den INIT-State versetzen; in beiden Fällen muss 
die grüne LED am Gerät aus sein.

• Error 939524209 occurred ... Possible reason(s): Device: Access denied, because write 
functions are blocked: Der generelle Schreibschutz ist aktiviert. Dieser Zustand kann 
auch beim GSV-2 und GSV-3 aktiviert sein, s. S. 27
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• Error 939524183 ... Possible reason(s): Device: Parameter too big in relation to other 
parameters / Settings: Der Parameter ist zu groß, ggf. in Relation mit anderen 
Parametern. Häufig beim Setzen der Messdatenrate.

• Error 939524180 ... Possible reason(s): Device: Parameter absolutely too big: Der 
Parameter ist absolut zu groß.

• Error 939524181 ... Possible reason(s): Device: Parameter absolutely too small: Der 
Parameter ist absolut zu klein.

• Error 939524188 ... Possible reason(s): Device: Parameter improper with respect to 
device settings: Der Parameter ist aufgrund anderer Geräteeinstellungen ungeeignet.

7. Die Messwerte liegen nicht im erwarteten Bereich

Wenn ein Messwert bei einer bekannten Testlast auf dem Sensor eine deutliche Abweichung
hat oder bei Nulllast nicht Null anzeigt, kann es viele Ursachen haben. 

Zunächst sollte man bei Null Last Set Zero oder Set All Zero ausführen (s. S. 89) und dann 
eine Testlast aufbringen. Weicht das Ergebnis deutlich vom erwarteten Wert ab, kann man 
folgendes prüfen: 

- Ist bei Mehrachsensensoren die richtige Kalibriermatrix konfiguriert? s. S. 39

- Ist ein allgemeiner Sensor richtig konfiguriert? s. S. 8

- Ist der Messwert in Sättigung, d.h. wird er auch bei Vergrößerung der Last nicht höher, 
dann ist möglicherweise der Eingangsmessbereich zu klein gewählt, s. S. 7. In diesem Fall 
sieht man bei Verwendung von GSV-6 oder GSV-8 typischerweise eine Fehlermeldung 
Sensor Fault! die am oberen Rand erscheint. 

Klickt man sie an, wird ein Sättigungsfehler Input raw measuring value saturated

angezeigt, z.B. 

8. Die Messwerte sind instabil

Es gibt langsame Instabilität, die man als Drift bezeichnet. Die Messwerte wandern dann 
typischerweise in eine Richtung. Die häufigste Ursache sind Temperaturänderungen, auch 
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driften Messverstärker und Sensor nach dem Einschalten. Deshalb sollte nach dem 
Einschalten etwa 20 Minuten bis eine Stunde lang abgewartet werden, bis Sensor und 
Messverstärker ihre Betriebstemperatur erreicht haben.

Bei Temperaturdrift des Sensors und Verwendung des GSV-2 kann u.U. die 
Driftkompensation verwendet werden, s. S. 137.

Schnelle Instabilität hat seine Ursache meistens im Rauschen des Verstärkers oder in 
Störungen, und zwar elektrischen EM Störungen oder ungewollten mechanischen 
Vibrationen. Abhilfe kann z.B. bessere Schirmung der Leitungen schaffen, bessere 
Stromversorgung oder niedrigere Messdatenrate, s. S. 17.

9. Probleme bei der Datenauswertung mit TDMS Dateien

Wenn Informationen über die Gewinnung der Messdaten unbekannt sind, etwa die 
Anzeigeskalierung oder die Messdatenrate, so kann man diese finden, indem man im File 
Monitor in die Karteikarte Properties wechselt. Dabei markiert man links in der Baumansicht 
die Gruppe Measuring Values oder den Kanal. In Anhang B auf S. 150 sind die Properties 
aufgelistet.

Wenn eine TDMS Datei nicht geöffnet werden kann, dabei eine Fehlermeldung erscheint 
oder die Messdaten unvollständig sind oder zu sein scheinen, können die auf S. 140 
beschriebenen Reparaturwerkzeuge helfen.
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Anhang A: Hotkeys
Wenn GSVmulti den Tastaturfokus hat, kann man mit folgenden Tastaturkombinationen Funktionen 
auslösen:

Tastatur-
kombination

Pfad der Menüleiste Bedeutung

Strg o File->Open Session Session öffnen

Strg s File->Save Session Session speichern

Strg t File->Open File Monitor File Monitor öffnen

F1 File->Start Recording Yt Aufnahme starten mit Recorder Yt

F2 File->Start Recording XY Aufnahme starten mit Recorder XY

F3 File->Stop Recording Aufnahme beenden

Strg q File->Quit Programm schließen

Strg n View->Configuration Zu Configuration Karteikarte wechseln

Strg y View-> Yt Recorder Zu Recorder Yt Karteikarte wechseln

Strg x View-> XY Recorder Zu Recorder XY Karteikarte wechseln

Strg d View->Value Display Zu Value Display Karteikarte wechseln

Strg + View->Add Graph Window... Neues grafisches Fenster Öffnen

F4 Action->Start Measuring Yt Messung im Zeitdiagramm starten

F5 Action->Start Measuring XY Messung im XY-Diagramm starten

F6 Action->Stop Measuring Messung stoppen

F8 Action->Enable Trigger Paste Getriggertes Einfügen in anderes Programm 
aktivieren

F9 Action->Disable Trigger Paste Getriggertes Einfügen in anderes Programm 
deaktivieren

F10 Action->Enable / Disable value Paste 
by F-Key

Einfügen in anderes Programm aktivieren / 
deaktivieren

F11 Action->Append values to clipboard Messwerte an Zwischenablage anhängen

F12 Action->Copy values to clipboard Messwerte in Zwischenablage einfügen

Strg a Action->Set All Zero Alle Kanäle Null setzen

Strg l Device->Load Settings... Geräteeinstellungen laden

Strg e Device->Save Settings... Geräteeinstellungen speichern

Strg f Device->Frequency... Messdatenrate ändern

Strg Bild↑ Channel->Next Angezeigten Kanal erhöhen

Strg Bild↓ Channel->Previous Angezeigten Kanal verringern

Strg z Channel->Zero Angezeigten Kanal Null setzen

Leertaste - Einzelnen Messwert von Gerät abholen 
(Kommando GetValue senden)
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Anhang B: TDMS Properties

Mit den aufgenommenen TDMS Dateien werden Eigenschaften (Properties) gespeichert, die 
man im File Monitor anzeigen lassen kann. Hier eine Liste aller  Properties.

Name Beschreibung / Inhalt Daten-
typ

Bedingung/Sensor-/
Dateityp

1. Auf Gruppenebene, d.h. in Measuring values

File Type "Standard" / "Raw data" String Alle

Diagram Type "Yt"/"XY" Diagrammtyp String Alle

Program Version GSVmulti Version, mit der diese Datei erstellt 
wurde

String Alle

Start Mode Methode des Starts der Messung String Alle

Finish Mode Methode des Starts der Messung String Alle

Decimation Info über eine Software-Dezimation String Alle

AnnotationNum Anzahl der Notizen Int Nur wenn vorhanden

AnnotName<0..N> Notiztext String Nur wenn vorhanden

AnnotVals<0..N> Programminterne Kodierung weiterer Notiz-Infos String Nur wenn vorhanden

2. Auf Kanalebene

Final Time Beendigungszeit Zeit-
Stempel

Alle, aber nur im 1. Kanal 
vorhanden

dt mode Methode der Zeitstempel-Berechnung für 
wf_increment
"tf": Start-, Beendigungszeit und Wertanzahl
"1/f0" Geräte-Messdatenrate
"user": Benutzerdefiniertes Zeitinkrement

String Alle, aber nur im 1. Kanal 
vorhanden

ToffsetUTC Zeitzone: Offset zur UTC, in Stunden Double Alle, aber nur im 1. Kanal 
vorhanden

ChannelType Typ des Messeingangs:
"analog": Analogeingang
"counter": Counter/Frequenz
"Latitude","Longitude": GPS/GNSS Geokoordinaten
"Altitude" GNSS Höhe des geoids in m
"Speed"  GNSS Geschwindigkeit in km/h
"UTC time" UTC Zeit von GNSS/GPS
"Math" Berechneter MathChannel (MathScript)

String Alle

NI_ChannelName Kanalname String Alle

NI_DataType Encoded data type of content (=10) Int Alle

NI_ChannelLength Gesamtanzahl der Messwerte pro Kanal Int Alle

NI_UnitDescription Einheit String Alle

wf_start_time Startzeit Zeit-
Stempel

Alle
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Name Beschreibung / Inhalt Daten-
typ

Bedingung/Sensor-/
Dateityp

wf_increment Zeitinkrement in Sekunden Double Alle

wf_samples Anzahl Messwerte im letzten Datenpaket Int Alle

wf_start_offset Startoffset, immer =0 Double Alle

InputNo Eingangskanal des Messverstärkers Int Alle

Serialnumber Seriennummer des Messverstärkers bzw. 
MathScript Nr.

Int Alle

DevComNo COMport- oder Gerätenummer Int Alle

Color RGB Wert der Kanalfarbe Int Alle

DeviceType Modellname des Messverstärkers String Alle

Frequency Eingestellte Messdatenrate des Messverstärkers Double Alle

Scaling User-Scaling oder bei Hardware-berechneten 
Mehrachsensensoren. Messbereich

Double Alle

name Kanalname (Unique identifier!) String Alle

unit_string Einheit String Alle

Axis Plotachsenzuordnung "X"/"Y" String nur XY

PysicalName Default name, e.g. "Com1_1 String Raw-Datei

SensorIndex Index des Mehrachsensensors im Sensor-Array Int Raw-Datei

Emodul Elestizitätsmodul Double Rosetten-Messung

Poissons Querkontraktionszahl Double Rosetten-Messung

GageFactor K-Faktor der DMS Double Rosetten-Messung

InSens Eingangsempfindlichkeit des Messevrstärkers Double Rosetten-Messung

SpecialSensor "Multi-dimensional/Six-Axis/RosetteStress" String Raw-Datei

CalculationInput Multi-dimensional: "Component1-6" Int Raw-Datei

SensorTypeNo Typ des Mehrachsensensors / der Berechnung Int Mehrachsensensor (SW)

SensorSerNo Sensor-Seriennummer Int Mehrachsensensor (SW)

GeoOffsetX Geometrischer Abstand in m, X-Richtung Double Mehrachsensensor (SW)

GeoOffsetY Geometrischer Abstand in m, Y-Richtung Double Mehrachsensensor (SW)

GeoOffsetZ Geometrischer Abstand in m, Z-Richtung Double Mehrachsensensor (SW)

SensorPath Dateipfad der Sensor-Kalöibrierdaten String Mehrachsensensor (SW)

MadeFromChan Bei Zusatzdatei Max/Min/Mittelwert: Quellkanal Int Max/Min/Mean Kanal

MscriptPath Pfad zu MathScript, das diesen Kanal erzeugte String Math channels

InType Eingangstyp  (Geräteabhängiger Enumerator) Int Alle

InRange Analoger Eingangsbereich Int Alle
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Name Beschreibung / Inhalt Daten-
typ

Bedingung/Sensor-/
Dateityp

HW-Sync Hardware-Synchronization:"Master"/"Slave" String Wenn HW-Sync 
verwendet

Änderungsnachweis

Version Status Bearbeiter

00.02.0
1

24.11.2023 initiiert HK, SW

v2.1 06.03.2024 kleine Korrekturen SW

v2.3 19.08.2024 Matrizen laden für K6D und K3D Sensoren, Formatierung SW, HK
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